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Client Application
You are reading DX8100 Series digital video recorder (DVR) documentation. The information in this manual describes how to configure and use 
the DX8100 system in your security application. 

For a brief description of the DX8100 server and client applications, refer to Welcome to DX8100 Client Application.

Welcome to DX8100 Client Application
Welcome to the DX8100 Series. DX8100 features multi-event recording; continuous motion detection, alarm, ATM/POS; and scheduled 
recording. The DX8100 is a high-performance, PC-based, easy-to-operate DVR and client application system. Models range from an 8-channel, 
single 250 GB hard disk drive (HDD) unit to a 32-channel unit with up to 3 TB of storage.

DX8100 software runs on two platforms:

• The DX8100 DVR server software runs on the DX8100 Series DVR. 

• The DX8100 Client Application software runs on a personal computer (PC) and allows you to log on and operate the DX8100 DVR server 
system from your local PC. 

Fully implemented networking capabilities allow remote administration, playback, and export using the accompanying client application. Live 
viewing is supported on a variety of client platforms, including Internet browsers and pocket PC-compatible hand-held devices. Versatile high-
speed search operations include time and date, event list, thumbnail, and intelligent pixel searching. Extensive scheduling features allow 
customizing of weekday, weekend, and special event recording.

The DX8100 provides a graphical user interface (GUI), allowing you quick and efficient access to all setup and operations functions. Scheduled or 
manual backup can be performed using a number of optical, external, and mapped network drive options.

An online Help system allows you quick access to information about how to configure and operate the DX8100 server and DX8100 client 
application. 

The DX8100 also supports the following PC-based applications:

• DX8100 Client Emergency Agent

• DX8100 Viewer

• DX8100 Mobile Client

• DX8100 Web Client

DX8100 CLIENT EMERGENCY AGENT
The DX8100 Client Emergency Agent works with networked DX8000 Series DVRs to alert users when one or more particular channels detect a 
motion and/or alarm event. The Emergency Agent runs on a networked client PC. 

DX8100 VIEWER
The DX8100 Viewer is capable of playing back a variety of video, still image, and audio media formats. It is designed to recognize and verify the 
digital watermark that is embedded in DX8000 Series DVR native video. Watermarking is used to authenticate the originality of a video file and 
to alert users of possible image tampering. The viewer application runs automatically each time a CD or DVD created by the DX8100’s export 
feature is inserted into a Windows-based PC. The software can also be installed on a PC and opened independently when necessary.

DX8100 MOBILE CLIENT
The DX8100 Mobile Client allows you to view live video remotely from multiple cameras and sites. Networking capabilities include local 
connection using wire-bound or wireless local area network (LAN) technologies or remote connection using the Internet. The DX8100 Mobile 
Client software runs on a standard pocket PC-based personal digital assistant (PDA), and it can display a single channel of real-time video from 
any camera attached to any DX8100 DVR on the network. Features include hierarchical organization of multiple sites, built-in security through 
password protection, and an adjustable viewing area, including full-screen view.
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DX8100 WEB CLIENT
The DX8100 Web Client allows you to view live video and operate pan, tilt, and zoom (PTZ) features of cameras attached to DX8100 DVRs. Using 
a standard Web browser, you can remotely monitor up to 16 cameras from up to five DX8100 DVR servers simultaneously. Each DX8100 DVR can 
support up to 100 Web clients either internally within an organization or externally through the Internet.

NEW DX8100 FEATURES
The DX8100 version 1.1 release includes the following new features:

• Windows® XP embedded

• MUX card output

• Customized setting for data retention time

• 2 Built-in audio channels

• Optional layer 2 multicasting

• Interoperable with DX8000 DVRs

• 16-Channel expansion box option

• Maximum increased storage capacity of 3 TB

• External storage raid option with DX9200HDDI

• Increased frame rate for 2CIF and 4CIF recording

• Standard analog output

• NTP time server compatible

• Standard DVD-R burner writes to CD-R and DVD-R media

• Up to 704 x 480 recording resolution (4CIF)

• Up to 32 camera inputs and outputs with auto termination
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Getting Started with DX8100 Client Software
This section describes the system requirements, software installation, and working with security. The following topics are included:

• Description of DX8100 Client Software

• Recommended System Requirements 

• Windows XP Display Properties Configuration Requirements

• Installing the Client Application

• Enabling IPSec Security Services 

• Disabling IPSec Security Services 

DESCRIPTION OF DX8100 CLIENT SOFTWARE
The DX8100 Client application allows operators and DVRs to be geographically dispersed. One PC client application can connect with up to 100 
DVR servers simultaneously. Up to one hundred DX8100 server sites can be added to the Connection List. For more information on the connection 
list, refer to Connecting to the DX8100 DVR Server Sites on page 22. 

The Client application facilitates 

• Remote viewing of live and playback video

• Index, thumbnail, POS, and pixel searching

• Exporting to a variety of media and formats

• Printing still images from video 

• Limited remote control and administration 

RECOMMENDED SYSTEM REQUIREMENTS
Minimum recommended system requirements for the DX8100 Client, Emergency Agent, and DX8100 Viewer software applications include

• Processor: Intel® Pentium® III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB of video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX® 8.1 or later hardware 
acceleration

• 500 MB of free disk space

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows 2000 (SP4) or Windows XP only

WINDOWS XP DISPLAY PROPERTIES CONFIGURATION REQUIREMENTS
Pelco recommends that the fade effect and shadow option for menus and tooltips be deselected. Any time these display effects are active, the 
CPU usage increases and impacts system performance. 
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INSTALLING THE CLIENT APPLICATION
To install the Client application:

1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8100 Resource CD into the DVD drive of your PC and wait for the DX8100 Resource CD screen to appear.

Figure 1.  DX8100 Resource CD Screen

4. Click Software. The Software menu is displayed.

Figure 2.  Resource CD Installation Options

5. Click Client. The DX8100 Security Setup dialog box opens.

Figure 3.  DX8100 Security Setup Dialog Box
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6. Verify that the Install IPSec Configurations check box is selected.

NOTE: IPSec is a standard security protocol used by the DX8100 Series DVR and its clients to communicate safely over a network. 
Although IPSec security can be disabled at any time, it must be enabled to communicate with a DX8100 server.

7. Click Next. The DX8100 Client Setup dialog box opens.

Figure 4.  DX8100 Client Setup Dialog Box

8. Click Next. The Software License Agreement dialog box opens.

Figure 5.   Client Software License Agreement Dialog Box

9. Read the license agreement and then select “I accept this License Agreement.”
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10. Click Next. The Select Installation Folder dialog box opens.

Figure 6.   Client Select Installation Folder Dialog Box

11.  Click Next to accept the default installation folder. 

Figure 7.   Client Installation Finalization Dialog Box

12. Click Finish to complete the installation process.
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SETTING UP SECURITY SERVICES
To communicate with a networked DX8100 Series DVR, IPSec security must be enabled on your computer. Disabling IPSec security services may 
hamper your PC’s ability to communicate with DX8100 servers. Consult your system administrator before disabling IPSec security.

This section describes how to setup IPSec security services and includes the following topics:

• Enabling IPSec Security Services

• Disabling IPSec Security Services

ENABLING IPSEC SECURITY SERVICES

To see the Manage IPSec Settings menu option from the Start menu, the Start menu has to be changed to Classic View.

To enable IPSec security services:

1.  Do one of the following:

• Verify that the Start menu is in Classic View.

• Set the Start menu to Classic View.

2. Go to Start > Manage IPSec Settings. The DX8100 IPSec Policy dialog box opens.

Figure 8.  Enabling IPSec Security for the Client Application

3. Select the Enable DX8100 IPSec Policy check box (if it is not already selected.)

4. (If applicable) Set the Start menu to its previous view.

DISABLING IPSEC SECURITY SERVICES

To see the Manage IPSec Settings menu option from the Start menu, the Start menu has to be changed to Classic View.

To disable IPSec security services:

1.  Do one of the following:

• Verify that the Start menu is in Classic View.

• Set the Start menu to Classic View.

2. Go to Start > Manage IPSec Settings. The DX8100 IPSec Policy dialog box opens.

Figure 9.  Enabling IPSec Security for the Client Application

3. Deselect the Enable DX8100 IPSec Policy check box.

NOTE: Disabling IPSec security services may hamper your PC’s ability to communicate with DX8100 servers. Consult your system 
administrator before disabling IPSec security.

4. (If applicable) Set the Start menu to its previous view.
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STARTING THE DX8100 CLIENT APPLICATION
This section describes how to start the DX8100 Client application and includes the following topics:

• Before You Start DX8100 Client Software 

• Starting DX8100 Client Software 

• Automatic System Upgrade 

BEFORE YOU START DX8100 CLIENT SOFTWARE

Ensure that the following requirements have been met before starting the DX8100 Client application:

1. Make sure there is at least one active DX8100 Series DVR available on your network and your computer is set up to access it. Consult your 
network administrator for more information.

2. Make sure you have a valid, active account on the DX8100 DVR server you want to access. Consult your system administrator if you have 
not been assigned a DX8100 user name and password.

3. Make sure IPSec security services are installed and enabled on your PC. For more information, refer to Installing the Client Application and 
Enabling IPSec Security Services.

STARTING DX8100 CLIENT SOFTWARE

To avoid potential problems and conflicts within your computer’s video subsystem, run only one Client application at a time.

To start the DX8100 Client application:

• Double-click the DX8100 Client icon on your desktop.

The following figure is the DX8100 Client icon that is placed on the desktop.
.

Figure 10.  DX8100 Client Icon on Desktop

AUTOMATIC SYSTEM UPGRADE

Each time the Client application starts, the system will check the network to see if there is a newer version of the software available for upgrade. 
If a new version is found, an error message is displayed, (refer to Figure 11). When this error message appears, click Yes, the DX8100 Client 
software will automatically download the upgrade files, install them, and restart your computer.

 

Figure 11.   Client Upgrade Notice

To check the current version of software:

• Choose Help > About.
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Logging In to the Client Application
The default password for the DX8100 Client application is “000000.” You should change the client password immediately after logging in to the 
software for the first time. Follow the instructions below to change the DX8100 Client application login password.

To log in to the DX8100 Client:

1. Start the DXDX8100 Client application. The DX8100 Client Password dialog box opens.

Figure 12.  DX8100 Client Password Dialog Box

2. Enter a valid password in the “Input password” text box. 

3. Click OK. The DX8100 Client application starts.

Pelco recommends that you change the DX8100 Client application default password after you first log in to the DX8100 Client application. 
For information on changing the default password, refer to Changing the DX8100 Client Application Login Password.

CHANGING THE DX8100 CLIENT APPLICATION LOGIN PASSWORD
To change the DX8100 Client password:

1. Wait while the software loads and the DX8100 Client application window opens.

2. From the DX8100 menu bar, choose File > Client Password. The DX8100 Client Password Setup dialog box opens.

3. Enter the old password in the “Old password” text box.

4. Enter a new password in the “New password” text box.

5. Re-enter the new password in the “Confirm” text box.

6. Click OK.

Remember the new client password or write it down and store it in a secure location.

ENABLING DIRECTDRAW VIDEO HARDWARE ACCELERATION
If your computer’s video hardware supports Microsoft DirectDraw® extensions, you can enable DirectDraw to enhance video performance. 
Enabling DirectDraw improves performance by delegating graphics acceleration duties to your PC’s video hardware instead of your computer’s 
main processor.

To enable DirectDraw hardware acceleration:

• Choose View > DirectX Draw.

WARNING: Do not enable DirectDraw on the Client application unless you are certain that your hardware supports DirectDraw hardware 
acceleration. Check the documentation that came with your PC and your graphics card before enabling DirectDraw. Although some VGA 
cards support DirectDraw, not all are compatible with the DX8100 Client application. Check the Pelco Web site for a complete list of 
compatible VGA cards.
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Connecting to DX8100 DVR Server Sites
This section describes how to connect to DX8100 DVR server sites and includes the following topics:

• Adding a DX8100 DVR Server to the Connection List 

• Deleting a DX8100 DVR Server

• Editing DX8100 Server Information from Connection List

• Working with Remote Sites

ADDING A DX8100 DVR SERVER TO THE CONNECTION LIST
The DX8100 Client application allows operators and DVRs to be geographically dispersed. Up to five DVR servers can be actively viewed from a 
single PC client. Up to one hundred DX8100 server sites can be added to the Connection List. 

The Client application facilitates the following:

• Auto Connection to servers at login

• Remote viewing of live and playback video

• Index, thumbnail, POS, and pixel searching

• Exporting to a variety of media and formats

• Printing still images from video 

• Limited remote control and administration 

This section describes how to add a DX8100 server to the connection list and includes the following topics:

• Adding a Site with a Known IP Address

• Adding a Site with an Unknown IP Address

ADDING A SITE WITH A KNOWN IP ADDRESS

To add a site to the Connection List when the IP address is known:

1. On the DX8100 toolbar, click . The Connection List dialog box opens.

2. Click Add. The Server Information dialog box opens.

3. Enter the name of the DX8100 Series DVR you wish to connect to.

4. Enter the IP address of the DVR.

5. If necessary, and after you have read the following information, enter a new base port number (9002 is the default). 

• Consult your network administrator before assigning or changing port numbers. 
• Make sure that the ports are not blocked internally but are protected from external threats by a firewall. Client and server ports must 

be identical.

6. If necessary enter a software upgrade port number (9003 is the default).
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7. Click OK. The site appears in the Connection List.

Figure 13.  Server Information Dialog Box

ADDING A SITE WITH AN UNKNOWN IP ADDRESS

This section describes how to add a site with an unknown IP address. To be successful, the following stipulations must be satisfied:

• Each DVR must be attached to the same subnet.

• The first three octets of the IP address of the subnet must be known.

• The range of addresses used in the last octet of the subnet must be known.

NOTE: The DX8100 scan process running on the PC takes much longer than the scan process does running on the DX8100 server. 

To add a remote DVR site to the Connection List when you do not know the IP address of the site:

1. On the DX8100 toolbar, click . The Connection List dialog box opens.

2. Click DX8100 Scan. The DX8100 Scan dialog box opens.

3. Enter an IP address range to search for DVR sites.

a. Enter the first three octets of the IP range you wish to search; for example, 10.10.1.

b. Enter the beginning value for the search range in the fourth octet; for example, 001.

c. Enter the final value for the search range in the text box provided; for example, 254. Each octet of the IP address must be an integer 
between 1 and 255.

4. Click Find.

5. Select one or more DX8100 servers to add to the site tree.

6. Click Add. The site appears in the Connection List.
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7. Click OK when you return to the Connection List dialog box.

Figure 14.  DX8100 Scan Dialog Box

DELETING A DX8100 DVR SERVER
The DX8100 Client allows you to delete a DX8100 DVR server from the connection list.

To delete a DX8100 server from the connection list:

1. On the DX8100 toolbar, click . The Connection List dialog box opens.

2. Select the DX8100 Series DVR you wish to delete.

3. Click Delete. The site disappears from the Connection List.

4. Click OK.

EDITING DX8100 SERVER INFORMATION FROM CONNECTION LIST
The DX8100 Client allows you to edit a DX8100 server’s information from within the Connection List dialog box.

To edit a DX8100 server’s information:

1. On the DX8100 toolbar, click . The Connection List dialog box opens.

2. Select the DX8100 Series DVR you wish to edit.

3. Click Edit. The Server Information dialog box opens.

4. Enter a new name for the server.

5. Enter a new IP address for the server.

6. If necessary, and after you have read the following information, enter a new base port number (9002 is the default). 

• Consult your network administrator before assigning or changing port numbers. 
• Make sure that the ports are not blocked internally, but are protected from external threats by a firewall. Client and server ports must 

be identical.

7. If necessary enter a software upgrade port number (9003 is the default).

8. Click OK. The site appears in the Connection List.
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9. Click OK when you return to the Connection List dialog box.

Figure 15.  Editing Server Information

WORKING WITH REMOTE SITES
This section describes how to connect to and log in to a remote DX8100 server site. This section includes the following topics:

• Connecting to a Remote Site 

• Automatically Connecting to a Remote Site

• Logging In to a Remote Site

• Logging Out of a Remote Site 

• Disconnecting from a Remote Site

CONNECTING TO A REMOTE SITE

You can view live and playback video and listen to live and playback audio from multiple DX8100 DVR servers simultaneously. The Client 
application can connect to remote sites automatically. 

To connect to an active DX8100 server on the network:

1. Right-click the remote site name from the Site tree. The Remote Site Connect shortcut menu is displayed.

2. Select Connect from the shortcut menu.

AUTOMATICALLY CONNECTING TO A REMOTE SITE

To automatically connect to a remote site:

1. Start the DX8100 Client application. The DX8100 Client Password dialog box opens.

Figure 16.  DX8100 Client Password Dialog Box

2. Click the Auto Connection check box.

3. Enter a valid password in the “Input password” text box.

4. Click OK. The DX8100 Client application starts and will automatically connect to the remote DX8100 servers on the network.
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LOGGING IN TO A REMOTE SITE

After a connection to a remote site has been established, you must log in with a valid user name and password to access the features of the 
DX8100 Series DVR. 

The DX8100 comes equipped with the built-in user account, “Guest.” Each time the unit is turned on, the Guest account is automatically 
activated. In addition to the Guest account, there are four other user access levels, or groups, that can be configured on the DX8100. The Guest 
user is granted only limited access to the system. The other four access levels range from the Administrator group, with the most rights and 
privileges, to the Restricted group, with the least rights and privileges. For more information on the rights and permissions of the user group to 
which you have been assigned, refer to Definition of User Access Levels. 

To operate and configure all but the most basic features of the DX8100, you must be assigned a user account other than Guest. If you have not 
been assigned a user account, contact your system administrator before proceeding.

To log in to a remote site:

1. Select a remote DX8100 Series DVR site from the Site tree.

2. From the DX8100 menu bar, choose File > User Log-in.

You can also log in to a remote site by right-clicking its site name and then selecting User Log-In from the shortcut menu.

3. Enter a valid user name in the User Name field and a valid password in the Password field.

4. Click OK.

LOGGING OUT OF A REMOTE SITE

You can only log out of one server at a time. If you are logged in to multiple servers, you must log out of each server individually. Logging out of 
a remote DVR does not disconnect you from that system. Logging out will return you to the Guest account. To disconnect from a remote server, 
refer to Disconnecting from a Remote Site.

To log out of a remote DVR site:

1. Select the remote server from the Site tree.

2. From the DX8100 menu bar, choose File > User Log-Out.

You can also log out of a remote DVR by right-clicking its site name from the Site tree, and then selecting User Log-Out from the 
quick-menu.

DISCONNECTING FROM A REMOTE SITE

To terminate a connection with a remote DX8100 server:

1. Right-click the name of the remote site from the Site tree.

2. Select Disconnect from the quick-menu.

EXITING THE DX8100 CLIENT APPLICATION
To exit the DX8100 Client application and return to the Windows operating system:

• From the DX8100 Client menu bar, choose File > Exit.
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Understanding the DX8100 Application Window
This section describes the DX8100 application window and its operation. The application window is the central control center where you can 
access to the DX8100 features and functions.

• View both live and recorded video

• Exit to the Windows environment

• Access DX8100 setup features

• Control camera PTZ functions

• Select cameras for viewing and recording

• Specify playback date and time

• Access playback controls

This section includes the following topics:

• Description of the DX8100 Main Window

• Understanding View Panes and Panels

• Working with the Site tree

DESCRIPTION OF THE DX8100 MAIN WINDOW
The application window is displayed after the DX8100 starts. The main window provides access to both live and recorded video. The DX8100 
displays an hour glass when a task requires a longer time to complete.

This section describes the DX8100 main window and includes the following topics:

• DX8100 Menu Bar 

• DX8100 Toolbar

• Displaying the DX8100 Window from a Page

• Description of Operating Modes 

• Understanding View Panes and Panels
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The following figure shows the parts of the DX8100 main window.

Figure 17.  DX8100 Client Application Main Window
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The following table describes the parts of the DX8100 application window.

DX8100 MENU BAR

This section describes the DX8100 menu bar commands and includes the following topics:

• File Menu

• Edit Menu

• View Menu

• Export Menu 

• Favorite Menu

• Help Menu

Table A.  Parts of the DX8100 Application Window

Item Part Description

Title Bar Displays the DX8100 application title.

Menu Bar Provides access to drop-down menus.

Toolbar Provides access to display, setup, export, and search tools.

Site Tree Displays top-down, hierarchical management of DX8100 resources, such as servers, cameras, alarms, and 
relays.

View Panels Display live and playback video from attached cameras. A view panel consists of view panes.

• View pane: A view pane is a division of a view panel. Each view pane contains only a single camera 
channel. Up to 36 view panes can fit in a single view panel.

• View panel: A view panel is made up of the entire DX8100 viewing area. View panels are divided into 
multiple panes. A panel can display from one to 36 individual cameras.

For additional information about view panels and panes, refer to Understanding View Panes and Panels.

PTZ Control Panel Allows users with access rights to operate camera lens control features and to program PTZ presets, 
patterns, auxiliary outputs, and tours. 

Index View Panel Allows users with access rights to search motion and alarm events within a 24-hour period specified in the 
playback timeline. By default, this panel is not displayed.

Playback Timeline Displays a 24-hour timeline marked with color-coded video events. Allows users with Standard User access 
rights to select a date and time for playback. 

Playback Control 
Panel 

Provides buttons for users with access rights to control video playback. Includes forward and reverse 
playback and still image. It also provides controls for playback speed and volume. 

PTZ OSD Menu or
Digital Zoom 
Control 

This control provides two functions depending on whether the DX8100 is operating in Live view or playback 
mode:

• Live view mode: Provides whether the DX8100 is operating in Live view or playback mode: users with 
access rights to operate PTZ OSD features. For information on using the PTZ OSD menu controls, refer to 
Using the PTZ OSD Menu Control.

• Playback mode: Provides users with access rights to operate digital zoom features. 

Status Bar Displays the current date and time, recorder processing status, disk status indicator, user name (of the 
current logged in user), and total amount of recorded video. 

NOTE: As the storage array of the DX8100 fills beyond its capacity, video is deleted in a first-in, first-out 
(FIFO) fashion. The disk status indicator on the status bar shows the amount of disk space used by recorded 
video. The red indicator marks the current recording position of the disk array, blue indicators mark parts of 
the array that are storing previously recorded video, and clear indicates that no video has been recorded in 
that area of the array.
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File Menu

The following table describes the DX8100 File menu commands.

Edit Menu

The following table describes the DX8100 Edit menu commands.

Table B.  File Menu Commands

Command Description

Client Password Opens the DX8100 Client Password Setup dialog box for changing the client log-on password.

User Log-in Opens the User Log-In dialog box for entering the user name and password to log in to the DX8100.

User Log-out Immediately logs the current user out of the DX8100. The system returns to the default mode.

Software Upgrade Opens the Select Upgrade Package dialog box for selecting the source from which to access files to upgrade 
the DX8100 software. This command is available only when you log in to the DX81000 as Administrator. 

Backup Search Opens the Backup data list dialog box for searching archived backed up data.

End Backup Search Ends the Backup Search mode and returns the DX8100 to the normal DVR Search mode.

Multiple Configuration Upload Opens the Multiconfiguration Upload dialog, displaying a list of DX8100 sites and groups. Use this dialog box 
to select specific DX8100 sites, to configure the file to upload to those sites, and to initiate the upload 
process.

Exit Exits the DX8100 client application.

Table C.  Edit Menu Commands

Command Description

Export Setup Opens the DX8100 Setup File Export dialog box for exporting the DX8100 system configuration settings to a 
specific file name and location. The Export feature also allows you to export the DX8100 settings to a 
specified location for later retrieval. For more information, refer to Using the Edit Menu to Perform an Export. 

Import Setup Opens the DX8100 Setup File Import dialog box for importing a DX8100 system configuration file. For more 
information, refer to Using the Edit Menu to Perform an Export.
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View Menu

The following table describes the DX8100 View menu commands.

Table D.  View Menu Commands

Command Description

OSD Opens a submenu with the following choices:

• Site name: A global setting that, when selected, displays a site’s name in the respective view pane.

• Camera name: A global setting that, when selected, displays a camera’s name in the respective view pane.

• Video recording: A global setting that, when selected, displays an icon in the upper right corner of the pane 
and enables video recording for the cameras assigned to a view pane. 

• Audio recording: A global setting that, when selected, enables audio recording for the cameras assigned to a 
view pane. The DX8100 compresses audio data to save space. In this case, recorded audio may not be of the 
same quality as live audio.

• PTZ: A global setting that, when selected, enables PTZ capability for the cameras assigned to a view pane.

• Instant recording: A global setting that, when selected, enables instant recording capability for the cameras 
assigned to a view pane.

• POS: A global setting that, when selected, enables POS video recording for the cameras assigned to a view 
pane.

• Select All: Selects all of the OSD options.

• Background Color: Opens a submenu with the following choices:

– Set Color: Opens the Colors palette for selecting or creating a background color.
– Disable Background: Disables a background color from being shown.

Resolution Opens a submenu with the following choices:

• 1024 x 768

• 1280 x 1024

Cycle Views Setup Dwell time: Opens a submenu of dwell times with the following choices:

• 2 Sec.

• 5 Sec.

• 10 Sec.

• 30 Sec.

• 60 Sec.

Index View Opens the Event Index pane.

Display Deinterlaced Image Selects the deinterlace mode for enhancing the display of video images. 

DirectX Draw Improves performance by delegating graphics acceleration duties to your PC’s video hardware instead of your 
computer’s main processor.

Language Opens a submenu with the following choices:

• English (default)

• French

• German

• Italian

• Polish

• Portuguese

• Russian

• Spanish
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Export Menu

The following table describes the DX8100 Export menu commands.

Favorite Menu

The following table describes the DX8100 Favorite menu commands.

Help Menu

The following table describes the DX8100 Help menu commands.

DX8100 TOOLBAR

This section describes the DX8100 toolbar. The following table describes the DX8100 toolbar buttons.

Table E.  Export Menu Commands

Command Description

Interrupt Export Immediately concludes an export process. If the Interrupt Export command is executed before the scheduled 
backup time, the system will save the backed up data until the time the Interrupt Export command is 
executed. 

Cancel Export Immediately cancels the export process and no backed data is retained.

Table F.  Favorite Menu Commands

Command Description

Add to Favorites Opens the Add to Favorites dialog box, where you can create and store a favorite to a specified folder.

Organize Favorites Opens the Organize Favorites dialog box, where you can do the following:

• Create a new folder.

• Rename the folders.

• Move favorites to a specific folder.

• Delete a favorite or favorite folder.

Table G.  DX8100 Help Menu Commands

Command Description

DX8100 Help Opens the DX8100 Help system.

About Provides model and version information for the DX8100 application.

Table H.  DX8100 Toolbar Buttons

Button Name Description

Live Enters the display mode and opens the DX8100 main window, where live and playback video is displayed:

• Live mode: Allows all users to view live video.

• Playback mode: Allows users with playback access rights (Standard User by default) and higher to play 
back recorded video.

Search Enters the search mode and opens the Search window, providing access to search features. Users with 
Standard User access and higher are allowed to search video data using specific criteria.

Setup Enters the setup mode and opens the Setup dialog box to the Camera page (default view), and allows access 
to the other pages. Users with Power User access and higher are allowed to set up the features and options 
for the DVR.
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DISPLAYING THE DX8100 WINDOW FROM A PAGE

To display the DX8100 main window from a Setup dialog page:

• On the DX8100 toolbar, click Live.

Export Enters the export mode, where you configure the export options and parameters.

Print Enters the print mode, where you print the selected video image.

Single Division Displays one camera.

4 Division Displays four cameras simultaneously (quad display).

9 Division Displays nine cameras simultaneously.

16 Division Displays 16 cameras simultaneously.

25 Division Displays 25 images. Each DVR accommodates up to 32 cameras. You can display images from the local and 
remote DX8100 DVRs. Use the expansion unit to increase DX8108 from 8 to 24 camera inputs or the DX8116 
from 16 to 32 camera inputs. 

36 Division Displays 36 images. Each DVR accommodates up to 32 cameras. You can display images from the local and 
remote DX8100 DVRs.

6, 10, 13 Division Displays images as follows: 

• 6 Division (1+5): One larger and five smaller images

• 10 Division (2+8): Two larger and eight smaller images

• 13 Division (1+12: One larger and 12 smaller images

Cycle Views Turns window cycling on and off. Automatically cycles through each view panel ensuring all cameras get 
displayed. Group permission to change the dwell time is assigned by the Administrator to the following 
groups: Restricted User Group, Standard User Group, and Power User Group. For information on cycle views 
setup, refer to Automatically Cycling Through View Panels.

Full Screen Selects a full screen view. The application window is expanded to occupy the entire monitor screen. Click the 
right mouse button to exit full-screen view. The full screen view is not available in the Thumbnail, POS, and 
Pixel search mode.

Connection List Opens the Connection List dialog box for adding sites to the Site tree.

Table H.  DX8100 Toolbar Buttons (Continued)

Button Name Description
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DESCRIPTION OF OPERATING MODES

The DX8100 Series DVR has four primary operating modes: Live, Playback, Search, and Setup. Each operating mode is accessed by clicking its 
corresponding button on the toolbar. 

The following table describes the DX8100 operating modes.
 

DISPLAYING VIDEO IN FULL SCREEN VIEW

The DX8100 allows full screen viewing of video data in the live, playback, and index search mode, providing more screen area to display video. 

Displaying Live Video in Full Screen View

To display live video in full window view:

1. Select the live video mode. For information about working in the playback mode, refer to Working in Live View Mode.

2. Select a window division.

3. On the DX8100 toolbar, click . Live video is displayed in full screen view.

To display the DX8100 main window from the full screen view:

• Right click in the DX8100 window.

Displaying Playback Video in Full Screen View

To display playback video in full screen view:

1. Select the playback mode. For information about working in the playback mode, refer to Working in Playback Mode.

2. Select a window division.

3. On the DX8100 toolbar, click . Playback video is displayed in full screen view.

To display the DX8100 main window from the full screen view:

• Right click in the DX8100 window.

Displaying Index Search Video in Full Screen View

To display index search video in full screen view:

1. Select the index search mode. For information about working in the index search mode, refer to Working in Playback Mode.

2. Click  to begin viewing video.

3. On the DX8100 toolbar, click . Index search video is displayed in full screen view.

Table I.  Operating Modes

Icon Mode Description

Live Enters the display mode and opens the DX8100 main window, where live and playback video is displayed:

• Live mode: Allows all users to view live video.

• Playback mode: Allows users with playback access rights to play back recorded video.

Search Enters the search mode and opens the Search window, providing access to search features. Allows users with 
playback access rights to search video data using specific criteria.

Setup Enters the setup mode and opens the Setup dialog box to the Camera setup page (default view), and allows 
access to the other setup pages. Users with Power User access and higher are allowed to set up the features 
and options for the DVR.
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To display the DX8100 main window from the full screen view:

• Right click in the DX8100 window.

UNDERSTANDING VIEW PANES AND PANELS
This section describes the DX8100 viewing area. The viewing area is organized into panes and panels, much like a window contains panes. 
Video from each camera is displayed in its own viewing pane. 

This section includes the following topics:

• Working with View Panes and Panels 

• Configuring View Panels 

• Navigating View Panels 

WORKING WITH VIEW PANES AND PANELS

The DX8100 displays video from each camera in its own viewing pane. 

• View pane: A view pane is a division of a view panel. Each view pane contains only a single camera channel. Up to 36 view panes can fit 
in a single view panel.

• View panel: A view panel is made up of the entire DX8100 viewing area. View panels are divided into multiple panes. Each panel can 
display from one to 36 individual cameras.

The following figure illustrates how the DX8100 viewing area is structured.

Figure 18.  View Panes and Panel for 4-Division Display

The following table describes the view pane and panel as shown in the figure above.

Table J.  View Panes Panel

Item Description

Shows a view pane for a four division display.

Shows the view panel, which contains view panes.
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CONFIGURING VIEW PANELS

The DX8100 can display up to 36 cameras simultaneously in a single panel.

To select a view panel division:

1. On the DX8100 toolbar, click .

2. On the DX8100 toolbar, click a view panel division button. 

For information on the view division buttons, refer to DX8100 Toolbar.

NAVIGATING VIEW PANELS

This section describes how to move between the DX8100 view panes and panels. This section includes the following topics:

• Navigating Between View Panels 

• Expanding and Collapsing View Panes 

• Manually Cycling Through Hidden View Panels 

• Automatically Cycling Through View Panels

Navigating Between View Panels

The DX8100 allows you to monitor up to 36 channels: each channel is assigned to one pane within the view panel. If the 36-division display 
format is selected, all 36 panes occupy one panel. However, for single, 4-division, 9-division, 16-division, and 25-division display formats, the 
DX8100 displays the panes in multiple panels. In this case, to view all of the panes, you must cycle through multiple panels to display hidden 
panels. 

• Channel: As pertains to video, one DX8100 camera port (input). The term channel is sometimes used interchangeably with camera.

• Camera: One external video device, such as a Spectra III™, that provides input video to the DX8100 DVR.

For example, if you select the single-division display format, one channel (video pane) fills the entire panel. 

• The pane and panel represent the same amount of viewing area. 

• In this case, there will be an additional 31 hidden panels (one pane equals one panel) through which to cycle. 

Similarly, if you select the 4-division display format:

• Four panes (one camera/channel per pane) are displayed in the panel.

• In this case, 7 hidden panels (four cameras/channels per panel, or 4 x 7 = 28 panels), remain to be displayed. 

The following figure shows how the DX8100 cycles through view panels, depending on the display format.

Figure 19.  Example of Single, 4, 9, and 16 Division View Panels
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The following table describes how the DX8100 view panes and panels are organized.

Pressing one of the view panel division buttons sets the number of visible channels displayed in the panel. The following figure illustrates the 
view panel identifier.

Figure 20.  View Panel Identifier

The following table describes how the DX8100 view panes and panels shown in Figure 20 are organized.

Expanding and Collapsing View Panes

To expand a view pane to fill the entire panel:

• Double-click a view pane.

The view fills the entire view panel. 

To collapse a view pane:

• Double-click the expanded view pane.

The view pane returns to its default size.

Manually Cycling Through Hidden View Panels

To manually cycle through hidden view panels:

Table K.  How View Panels are Organized

Display Type Grouping Number of 
View Panes

Number of 
View Panels

Single 1/32 1 32

4 Division 1/8 4 8

9 Division 1/4 9 4

16 Division 1/2 16 2

25 Division 1/2 25 2

36 Division 1/1 36 1

6, 10, 13 Division:

• 1+5 Division

• 2+8 Division

• 1+12 Division

1/6

1/4

1/4

6

10

13

6

4

4

Table L.  View Panes and Panel

Item Description

Indicates the panel number being viewed. 

Indicates the total number of panel pages available.

� �
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• On the DX8100 toolbar, click one of the panel division buttons.

The view sequences through the view panels.

For example, when you repeatedly click a 4 Division display format , the DX8100 cycles through each of the eight available view panels. 

Automatically Cycling Through View Panels

The DX8100 provides an automatic cycle feature that (when selected) automatically cycles through each view panel, ensuring all cameras get 
displayed. Group permission to change the dwell time is assigned by the Administrator to the following groups: Restricted User Group, Standard 
User Group, and Power User Group. 

This section describes how to configure the DX8100 to automatically cycle through camera views and includes the following sections:

• Starting an Automatic Cycle View Mode

• Stopping an Automatic Cycle View Sequence

• Selecting User Groups to Set the Cycle View Dwell Time

• Selecting the Cycle View Dwell Time

Starting an Automatic Cycle View Mode

To start the automatic cycle view mode:

• On the DX8100 toolbar, click Cycle Views. 

The Cycle Views icon turns blue, indicating that the DX8100 is in the automatic cycle view mode. The system will cycle through each panel, 
displaying each panel for the configured cycle view dwell time. 

For example, if you click , the automatic cycle view process starts.

Stopping an Automatic Cycle View Sequence

To stop the automatic cycle view mode:

• On the DX8100 toolbar, click Cycle Views. 

The DX8100 stops the automatic cycle view mode.

Selecting User Groups to Set the Cycle View Dwell Time

The DX8100 allows the Administrator to control which user group can change the cycle view dwell time. In this case, anyone that belongs to a 
selected user group can change the cycle view dwell time. 

To select a user group to have permission to change the cycle view dwell time:

1. On the DX8100 toolbar, click .

2. From the DX8100 menu bar, choose View > Cycle Views Setup > Dwell time change.

3. From the Dwell time change submenu, choose a user group.

Selecting the Cycle View Dwell Time

To configure the cycle period:

1. On the DX8100 toolbar, click .

2. From the DX8100 menu bar, choose View > Cycle Views Setup > Dwell time.

3. From the Dwell time submenu, choose a time period.
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WORKING WITH THE SITE TREE
The site tree provides access to DX8100 resources, such as cameras, alarm inputs, and relay outputs. Objects can be selected by clicking the left 
mouse button once, and then linked by dragging and dropping the icon into a view pane or another site tree item. The site tree information 
reflects the current DX8100 server configuration.

The following figure shows the site tree.

Figure 21.  Site Tree Parts

The following table describes the site tree parts.

Table M.  Site Tree Parts

Item Part Description

Name Site: Expands and collapses the DX8100 site. Right-clicking the site name opens a shortcut menu that 
provides the following commands:

• User Log-In: opens the User Log-In dialog box, where you enter your user name and password to log into 
the DX8100 site.

• User Log-Out: Logs you out of the DX8100 site.

• Connect

• Disconnect

Camera: Expands and collapses the Camera tree.

Channel information: Displays icons that represent the configuration of the camera:

• Recording mode

• Recording resolution

• Recording frame rate

• Recording image quality

Alarm: Expands and collapses the Alarm tree.

ATM/POS: Expands and collapses the ATM/POS tree.
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This section describes how to work with the Site tree and includes the following topics:

• Assigning Cameras to View Panes

• Setting Up Links

• Removing Links

ASSIGNING CAMERAS TO VIEW PANES

The DX8100 provides view panes that are organized into view panels. The DX8100 includes 36 view panels that can display cameras from up to 
five connected DVR sites. For information on view panels, refer to Working with View Panes and Panels.

The DX8100 Series DVR supports triplex operation. Triplex operation means that the DX8100 will continuously record, even while users view 
simultaneous live and playback video or modify the system setup.

To assign a single camera to a view pane:

1. On the DX8100 toolbar, click .

2. In the Site tree, click the plus sign (+) next to to expand the tree (if necessary).

3. Do one of the following:

• To assign a single camera to a view pane, drag the camera from the Site tree onto a view pane. 

• To assign all cameras from a single site to the view panes, drag  onto a single view pane. (The default arrangement of cameras 

is Camera1, Camera2, Camera3; from left to right, top to bottom.)

4. Repeat the process in step 3 for up to 36 cameras and up to five DVR sites.

SETTING UP LINKS

The DX8100 allows you to set up links in various configurations:

• You can link multiple alarms and relays to a single camera. 

• You can link a single alarm or relay to multiple cameras. 

• You can link alarms and relays to cameras by dragging them onto individual camera view panes.

• You can also manually turn a relay on and off from the Site tree.

This section describes how to set up links and includes the following sections:

• Manually Turning On and Off a Relay

• Linking Alarm Inputs to a Camera

• Linking a Relay Output to a Camera

• Linking Relay Outputs to Alarm Inputs

Relay: Expands and collapses the Relay tree. Right-clicking a relay opens a shortcut menu that provides the 
following commands:

• ON: Allows you to turn on the relay.

• OFF: Allows you to turn off the relay.

Remote site: Expands and collapses the remote DX8100 site. Right-clicking the remote site name opens a 
shortcut menu that provides the following commands: 

• User Log-In: Opens the User Log-In dialog box, where you enter your user name and password to log into 
the remote DX8100 site.

• User Log-Out: Logs you out of the remote DX8100 site.

• Connect: Allows you to connect to the remote site.

• Disconnect: Allows you to disconnect from the remote site.

Table M.  Site Tree Parts (Continued)

Item Part Description
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Manually Turning On and Off a Relay

To manually turn on and off a relay:

1. Right click a relay. The shortcut menu opens.

2. Click ON to turn on the relay; click OFF to turn off the relay.

Linking Alarm Inputs to a Camera

The DX8100 allows you to link alarm inputs to a camera.

• You can link multiple alarm inputs to a single camera. 

• You can also link a single alarm input to multiple cameras. 

The DX8100 allows you to link alarms to cameras by dragging them onto individual camera view panes or onto cameras listed in the Site tree.

To link an alarm input to a camera:

1. On the DX8100 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera to which you want to link alarms.

3. Click the plus sign (+) next to the  to see the list of alarm inputs.

4. Drag an alarm input onto a camera pane or a camera listed in the Site tree.

Linking a Relay Output to a Camera

The DX8100 allows you to link relays to a camera.

• You can link multiple relays a single camera. 

• You can also link a single relay to multiple cameras. 

The DX8100 allows you to link relays to cameras by dragging them onto individual camera view panes or onto cameras listed in the Site tree.

To link a relay output to a camera:

1. On the DX8100 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera to which you want to link relays.

3. Click the plus sign (+) next to  to see the list of relay outputs.

4. Drag a relay onto a camera pane or a camera listed in the Site tree. 

Linking Relay Outputs to Alarm Inputs
To link a relay output to an alarm input: 

1. On the DX8100 toolbar, click . 

2. In the Site tree, click the plus sign (+) next to  to expand the Alarm tree if needed.

Relays can also be linked to cameras and alarms on the Link settings page. For more information, refer to Configuring Basic Relay and 
Alarm Settings.

3. Click the plus sign (+) next to  to expand the Relay tree if needed.

4. Drag a relay output onto an alarm input in the Site tree.
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REMOVING LINKS

This section describes how to remove links and includes the following sections:

• Removing a Linked Alarm Input from a Camera

• Removing a Linked Relay Output from a Camera

• Removing a Linked Relay Output from an Alarm Input

Removing a Linked Alarm Input from a Camera
To remove an alarm link from a camera:

1. On the DX8100 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera from which you want to remove an alarm input.

3. Left click and drag the alarm outside the Site tree panel, and then release the mouse button. 

4. Repeat the above process for each alarm you want to remove.

Removing a Linked Relay Output from a Camera
To remove a relay link from a camera:

1. On the DX8100 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the camera from which you want to remove the relay output.

3. Left click and drag the relay outside the Site tree panel to the DX8100 toolbar or panel (above or below the Site tree panel), and then 
release the mouse button. 

4. Repeat the above process for each relay you want to remove.

Removing a Linked Relay Output from an Alarm Input
To unlink a relay from an alarm:

1. On the DX8100 toolbar, click .

2. In the Site tree, click the plus sign (+) next to the alarm input from which you want to remove the relay output.

3. Left click and drag the relay outside the Site tree panel, and then release the mouse button.

4. Repeat the above process for each relay you want to remove.
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Working in Live View Mode
This section describes how to use the DX8100 to view and record live video. All users can view live video from the main window. Users with PTZ 
access rights (Standard User by default) and higher can operate the on-screen PTZ controls. Live video can also be displayed in full screen view. 
For information about displaying playback video in full screen view, refer to Displaying Live Video in Full Screen View.

The DX8100 displays live video based on one of the following scenarios:

• Capture card displays live video: The capture card is used to display live video on the main VGA monitor. For each channel, live video is 
displayed on the VGA monitor at the maximum recording rate. For example, channel 1 is set to 2CIF recording resolution and the actual 
record rate is 1 image per second (ips). In this case, live video for channel 1 is displayed at 15 ips. Additionally, the capture card provides a 
BNC analog output of the live video image. The analog image is the same as the image displayed on the VGA monitor. The DX8100 External 
Monitor option allows you to configure how analog video is displayed on an external monitor connected to the capture card. For information 
about the External Monitor feature, refer to External Monitor Setup.

• MUX card displays real-time video: If the DX8100 is equipped with the MUX option, real-time video from the MUX card(s) is displayed 
on the main VGA monitor at 30 ips. Real-time video is displayed for all the channels regardless of the recording resolution. 
– Additionally, the MUX Card provides a BNC analog output of the real-time video image. The analog image is the same as the image 

displayed on the VGA monitor. The analog output does not contain any display icons, labels, or text, but video is displayed on the analog 
monitor in the same division mode as is displayed on the VGA monitor. 

– One operational difference is that the MUX stops the display of real-time video if the search mode is active for one channel. In this 
case, the capture card(s) are used to display the video. 

When installing the MUX card option, ensure that the MUX Card matches the capture card channel capacity as follows:

• If an 8-channel capture card is installed, the DX8108-MUX option is required. The DX8124 model DVR has two capture cards installed: an 
8-channel and a 16-channel capture card. In this case, the DX8108-MUX and DX8116-MUX option are required.

• If a 16-channel capture card is installed, the DX8116-MUX option is required. The DX8132 model DVR has two 16-channel capture cards 
installed. In this case, two DX8116-MUX options are required.

To view live video in the DX8100 main window:

• On the DX8100 toolbar, click Live.

This section includes the following topics:

• Assigning and Removing Cameras from View Panes

• Live View On-Screen Display (OSD) 

• Customizing the On-Screen Display (OSD) 

ASSIGNING AND REMOVING CAMERAS FROM VIEW PANES
The DX8100 allows you to quickly move cameras to and remove cameras from a view pane.

To assign a camera to the view pane:

1. Drag a camera from the Site tree onto a view pane. 

2. Repeat the process in step 1 for up to 36 cameras and up to five different DX8100 sites.

To remove a camera from a view pane:

• Right click in the view pane and drag the camera to the Site tree pane.

For information about the DX8100 view pane and panels, refer to the following topics:

• Working with View Panes and Panels 

• Configuring View Panels 

• Navigating View Panels
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SETTING UP FAVORITES
The DX8100 Favorites menu allows you to organize and save camera views. For example, you might want to display camera views that show the 
delivery gate entrance for buildings 1, 4, 7, and 12 during the hours of 06:00 to 07:30 and another camera view that displays the front lobby of 
buildings 1 through 16 at 08:00. 

This section describes the following topics:

• Adding a Camera View to Favorites 

• Organizing Favorites in Folders 

ADDING A CAMERA VIEW TO FAVORITES

You can create multiple camera views to monitor various site locations. For example, you could create a folder named Day Shift for displaying 
camera views during normal working hours and Night Shift for displaying various camera views after work and during the night hours. For 
information about organizing favorites into folders, refer to Organizing Favorites in Folders.

To add a camera view to favorites:

1. From the DX8100 menu bar, click Favorite > Add to Favorites. 

The Add to Favorites dialog box opens.

Figure 22.  Add to Favorites Dialog Box

2. Enter the camera view name in the Name text box.

3. Click OK. The camera view is added to the favorites, and the Add to Favorites dialog box closes.

4. To view the new entry, from the DX8100 menu bar, click Favorites. The new entry appears in the Favorites list.

Figure 23.  Favorites Menu List
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ORGANIZING FAVORITES IN FOLDERS

As your list of favorites grows, you can keep them organized by creating folders. You can organize your camera views by site name, user name, 
and so forth. For example, you could create a folder named Day Shift for displaying camera views for the day shift.

Creating a Favorites Folder

To create a favorites folder:

1. From the DX8100 menu bar, click Favorite > Organize Favorites. 

The Organize Favorites dialog box opens.

Figure 24.  Organize Favorites Dialog Box

2. Click Create Folder. A new folder is added to the favorites area.

3. To name the folder, do one of the following:

a. If the new folder name is already selected, type the name of the folder.

or

b. If the new folder name is not selected:

(1) Click the new folder.

(2) Type the name of the folder.

The new folder is listed in the Favorites area of the Organize Favorites dialog box and in the Favorites menu.

Organizing Favorites in Folders

To organize existing favorites into folders:

1. Create a favorites folder. 

For information about creating a favorites folder, refer to Creating a Favorites Folder.
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2. From the DX8100 menu bar, click Favorite > Organize Favorites. 

The Organize Favorites dialog box opens. A list of the current favorites and folders is displayed in the favorites area.

Figure 25.  Organize Favorites Dialog Box and List of Favorites/Folders

3. In the favorites area, click a favorite.

4. Click Move to Folder.

The Move to Folder dialog box opens.

Figure 26.  Move to Folders Dialog Box

5. Select a destination folder.

6. Click OK.

The favorite is moved under the destination folder.
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LIVE VIEW ON-SCREEN DISPLAY (OSD)
The DX8100’s OSD consists of camera and site information that is superimposed on each view pane. Each display item in the OSD can be 
customized for both live and playback viewing.

The following figure shows the Live View OSD pane.

Figure 27.  Live View OSD Pane

The following table describes the parts of the Live View OSD pane.

Table N.  Parts of the Live View OSD Pane

Item Part Description

PTZ Indicates that the PTZ control is enabled.

Indicates that audio recording is enabled. The DX8100 compresses audio data to save space. In this 
case, recorded audio may not be of the same quality as live audio.

REC Indicates camera recording mode and status. A blinking REC indicator signifies event recording.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates ATM/POS recording.

• Purple indicates video loss recording.

• Black on white background indicates instant recording.

Site Designator Lists the number and name of the current site.

Camera Designator Lists the number and name of the current camera.

On-Screen PTZ 
Control 

Facilitates mouse control of PTZ functions. Refer to Operating the On-Screen PTZ Controls. 

Instant Recording Starts/stops instant recording if enabled.

�
�

� �
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CUSTOMIZING THE ON-SCREEN DISPLAY (OSD)
Users with Guest User access and higher can add and delete on-screen display items. 

To customize the on-screen display:

1. From the DX8100 menu bar, choose View > OSD and then select the items you want to add to or delete from the OSD. Items include

• Site Name
• Camera Name
• Video Recording
• Audio Recording
• PTZ
• Instant Recording
• POS
• Select All (displays all items in each pane)
• Background Color

Figure 28.   Client OSD Menu Options

2. Do one of the following:

• From the DX8100 menu bar, choose View > OSD > Background Color > Set Color to add a contrasting background field behind each 
OSD display item.

• From the DX8100 menu bar, choose View > OSD > Background Color > Disable Background to remove background field.

INSTANT RECORDING
This section describes the instant recording mode. Users with Power User access and higher can configure the DX8100 for recording video both 
instantly and in accordance with a preset schedule. The Instant Recording mode is enabled from the Schedule page. Instant recording is 
activated from the main window by double-clicking the Instant Recording icon. 

If the DVR is not in the normal recording mode, you can use the instant recording mode to manually start and stop a video recording session 
instantly. For information about adding the Instant Recording icon to the OSD, refer to Adding Instant Recording to OSD.

This section includes the following topics:

• Enabling and Disabling Instant Recording 

• Adding Instant Recording to OSD 

• Starting and Stopping Instant Recording

ENABLING AND DISABLING INSTANT RECORDING

This section describes how to enable and disable the instant recording mode and includes the following topics:

• Enabling Instant Recording 

• Disabling Instant Recording

For more information on instant recording, refer to Instant Recording.
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Enabling Instant Recording

To enable the Instant Recording mode: 

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Enable.

Disabling Instant Recording

To disable the Instant Recording mode: 

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . 

3. In the Camera Settings Panel, from the Instant Recording drop-down box, select Disable.

ADDING INSTANT RECORDING TO OSD

To add the Instant Recording icon to the OSD:

• From the DX8100 menu bar, choose View > OSD > Instant Recording.

The Instant Record icon is displayed in the lower-right corner of the view pane.

STARTING AND STOPPING INSTANT RECORDING

The Instant Recording mode must first be enabled from the Schedule page and the Instant Recording icon must be visible in the lower-right 
corner of the view pane. For more information on DX8100 instant recording, refer to Instant Recording. For information on OSD, refer to Live View 
On-Screen Display (OSD).

The following figure shows the Record and Instant Record icons.

Figure 29.  Activating Instant Recording

�

�
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The following table describes the recording indicators.

This section describes how to start and stop instant recording and includes the following topics:

• Starting Instant Recording

• Stopping Instant Recording

Starting Instant Recording

To start instant recording:

• Double-click the Instant Recording icon located in the lower-right corner of the view pane.
– The Instant Recording icon changes from silver to blue, indicating that instant recording is activated.
– If video recording is enabled, verify that REC is black and highlighted white. If video recording is not enabled, REC is not displayed or 

will show another recording mode color. 

Stopping Instant Recording

To deactivate instant recording:

• In the view pane, double-click the Instant Recording icon.

The instant recording icon changes from blue to silver, indicating that instant recording is de-activated.

OPERATING THE ON-SCREEN PTZ CONTROLS
Users with PTZ access rights (Standard User by default) and higher can operate PTZ lens functions of cameras that support such features. PTZ 
functions can be controlled on the screen in Live mode using the mouse. 

PTZ control is available for cameras that support PTZ functions using Pelco’s P, D, or Coaxitron® protocols. It is also available for supported third-
party dome cameras. For more information about configuring PTZ ports, refer to Setting Up COM1 Port Properties in the DX8100 server Help 
system or the Operation and Programming manual.

In addition, the PTZ option must be enabled and a protocol must be assigned to the camera channel. For more information, refer to Camera Setup 
in the DX8100 server Help system or the Operation and Programming manual.

This section describes how to use the PTZ controls and includes the following topics:

• Operating the PTZ Controls 

• Adjusting the Camera Lens 

• Adjusting the Camera Zoom 

• Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions

Table O.  Recording Indicators

Item Icon Description

REC Indicates camera recording mode and status. A blinking REC indicator signifies event recording.

• Green indicates normal recording.

• Blue indicates motion recording.

• Red indicates alarm recording.

• Yellow indicates ATM/POS recording.

• Purple indicates video loss recording.

• Black on white background indicates instant recording.

Instant Recording Starts/stops instant recording if enabled. Changes from silver to blue to indicate that instant recording 
is activated.
52 Client Application C2631M-A (6/07)



OPERATING THE PTZ CONTROLS

To operate the on-screen PTZ controls:

1. On the DX8100 toolbar, click .

2. Select a PTZ-enabled camera from the Site tree.

3. Place the mouse pointer in the middle of the camera’s view pane. The mouse pointer will change to a black cross when on-screen PTZ 
control is available.

Figure 30.  On-Screen PTZ Control

4. Click and hold the left mouse button, and then drag the mouse pointer in the direction you want to move the camera. The display changes 
to an arrow, indicating the direction of the mouse.

Figure 31.  On-Screen PTZ Movement

5. Release the mouse button when you have repositioned the camera to the desired location.

�
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ADJUSTING THE CAMERA LENS

To adjust camera lens features:

• Click the plus (+) or minus (-) button next to the zoom, focus, and iris function on the keypad.

Figure 32.  PTZ Keypad with Camera Lens Controls
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ADJUSTING THE CAMERA ZOOM

To adjust camera zoom using the mouse:

• Rotate the mouse wheel forward to zoom in and backward to zoom out.

The following figure shows how to operate the mouse to zoom in and out. You can also use keyboard shortcuts to operate the lens features of 
cameras such as Pelco’s Spectra III. For more information about using keyboard shortcuts, refer to Using PC Keyboard Shortcuts to Operate PTZ 
and Lens Functions.

Figure 33.  Mouse Wheel Zoom
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USING PC KEYBOARD SHORTCUTS TO OPERATE PTZ AND LENS FUNCTIONS

Users with PTZ access rights (Standard User by default) and higher can use a PC keyboard to operate PTZ and lens functions of cameras that 
support such features. PTZ and lens functions can be controlled in Live mode using the keyboard. 

The following table describes the keyboard buttons that you use to control PTZ and lens functions. 

To use the keyboard (+) and (-) keys to control camera pan/tilt speed:

1. On the DX8100 toolbar, click .

2. Select a PTZ-enabled camera from the Site tree.

3. Click the mouse pointer in the camera’s view panel.

4. Press and hold the up/down and left/right arrows to pan/tilt the camera.

5. Press the plus (+) key once or more times to increase the pan/tilt speed. Press the minus (-) key once or more times to decrease the pan/tilt 
speed. 

Table P.  Standard PC Keyboard Functions for Controlling PTZ and Lens Functions

Key Description

Insert and Delete These keys provide the following functionality:

• On-screen display, preset and pattern modes: Insert increases focus and Delete decreases focus, performing 
the same actions as the focus control on the PTZ keypad. 

• Remote camera programming mode: Insert and Delete perform the same actions as the PTZ keypad focus (+) and 
(-) buttons, navigating up and down through the camera menu choices.

Home and End These keys provide the following functionality:

• On-screen display, preset and pattern modes: The Home key opens the iris and the End key closes the iris, 
performing the same actions as the PTZ keypad iris (+) and (-) buttons. 

• Remote camera programming mode: The Home key selects an option from the camera’s on-screen menu. The End 
key cancels an option or exit a menu. These keys perform the same actions as the PTZ keypad iris (+) and (-) buttons.

Page Up and Page Down These keys provide the same functionality in the on-screen display and the preset and pattern modes as the PTZ keypad 
zoom (+) and (-) buttons. Page Up zooms in; Page Down zooms out.

Up and Down Arrows These keys provide the following functionality:

• On-screen display, preset and pattern modes: The up arrow key raises the camera and the down arrow key 
lowers the camera. The keys perform the same actions as the mouse to move the camera. 

• Remote camera programming mode: The arrow keys navigate up and down the camera menu choices. The keys 
perform the same actions as the PTZ keypad focus (+) and (-) buttons.

Left and Right Arrows These keys provide the same actions as the mouse for moving the camera. The left arrow key pans the camera to the left 
and the right arrow key pans the camera to the right.

+ and - These keys perform similar actions as using the mouse to change the speed of camera movement. When pressed once, 
the plus (+) key increases the camera's pan/tilt speed; when pressed once, the minus (-) key decreases the pan/tilt 
speed. Each time the plus (+) key is pressed the pan/tilt speed is increased toward maximum speed; each time the minus 
(-) key is pressed, the pan/tilt speed is decreased toward minimum speed. 
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PTZ PRESETS
A preset is a user-defined camera position using PTZ and focus commands the (camera’s auto focus option must be turned off). Only cameras 
that support positioning and programming using D, P, Coaxitron, or supported third-party protocols can use this feature. The DX8100 Series DVR 
can address up to 150 PTZ presets (1-150). Preset 95 is reserved for remote camera setup, and preset 99 is reserved for camera autoscan mode.

From the DX8100 menu bar, choose View > Extended View.The following PTZ operating guidelines must be observed:

• To program or clear presets, preset tours, and patterns, the  icon must be engaged.

• To activate presets, tours, and patterns, the  icon must be disengaged.

This section describes how to program, activate, and clear presets and includes the following topics:

• Programming a Preset 

• Activating a Preset 

• Clearing a Preset 

PROGRAMMING A PRESET

This section describes how to program a preset. The following PTZ operating guidelines apply:

• Clicking the  icon places DX8100 in PTZ programming mode. 

• While in PTZ programming mode, multiple presets can be programmed until the  icon is pressed again.

To program a PTZ preset:

1. On the DX8100 toolbar, click .

2. Drag a camera from the Site tree onto a view panel.

3. Click .

4. Using the on-screen PTZ controls and PTZ keypad, move the camera to the desired position and adjust the zoom setting.

Figure 34.  Creating a Preset

EXIT
C2631M-A (6/07) Client Application 57



5. Using the PTZ keypad, select a number for the new preset (for example, select 1).

6. Click  to store the preset in the selected memory location.

7. Repeat steps 4-6 for each preset you want to program.

8. Click  again to exit programming mode.

Figure 35.  Programming a Preset

ACTIVATING A PRESET

Double- and triple-digit presets can be set or activated by pressing the first digit and then the second digit sequentially. For example, preset 20 
can be selected by clicking the number 2 and then the 0 (zero) on the PTZ keypad.

To activate a preset:

1. On the DX8100 keypad, click a preset number (1-150) on the keypad.

2. Click  to activate preset. The camera repositions to the new preset.

Figure 36.  Activating a Preset
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CLEARING A PRESET

To clear a preset:

1. On the DX8100 keypad, click  to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click  to exit programming mode.

Figure 37.  Clearing a Preset

PTZ PATTERNS
A pattern is a user-defined, viewable camera path with a definite beginning and end. Patterns are made up of a sequence of standard pan, tilt 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra® dome, that is connected to the DX8100. 
The Spectra III supports one pattern and the Spectra III SE supports up to four unique PTZ patterns. Depending on the type and configuration of 
the PTZ device, the DX8100 can address up to four unique PTZ patterns. Once defined, a pattern can be activated with a series of on-screen 
commands. A pattern will run continuously until it is deactivated. 

Only PTZ-enabled cameras that support pattern programming through D, P, Coaxitron, or supported third-party protocols can use this feature.

This section describes how to program, activate, and clear patterns, and access the programming features of remote cameras. This section 
includes the following topics:

• Programming a Pattern 

• Activating a Pattern

• Clearing a Pattern 

• Accessing Programming Features of Remote Cameras

PROGRAMMING A PATTERN

This section describes how to program a pattern. Certain PTZ devices, such as Pelco’s Spectra series domes, will display an on-screen message 
stating the amount of remaining memory available for pattern programming.

Start Programming a Pattern

To program a pattern:

1. On the DX8100 toolbar, click .

2. Drag a camera from the Site tree onto a view panel.

3. On the DX8100 keypad, click  to enter programming mode.

4. Using the PTZ keypad, select a number for the pattern (1-4).

5. Click .

�
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6. Move the camera through a series of movements using the on-screen PTZ and focus controls.

Figure 38.  Programming a Pattern

Stop Programming a Pattern

To stop programming a pattern:

1. On the DX8100 keypad, click .

2. Click .

ACTIVATING A PATTERN

When activated, a pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

To activate a pattern:

1. On the DX8100 keypad, click a pattern number (1-4) on the keypad.

2. Click .

Figure 39.  Activating a Pattern

CLEARING A PATTERN

To clear a pattern:

1. On the DX8100 keypad, click  to enter programming mode.

2. Select a pattern number (1-4) on the keypad.

3. Click .

4. Click .

5. Click  again.

�
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6. Click  again to exit programming mode.

Figure 40.  Clearing a Pattern

ACCESSING PROGRAMMING FEATURES OF REMOTE CAMERAS

You can use the PTZ function to program features of remote cameras, such as Pelco’s Spectra or Esprit®. Only cameras that support remote 
programming through D, P, Coaxitron, or supported third-party protocols can use this feature. 

The DX8100 allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls. For information on using the PTZ OSD Menu controls, refer to Using the PTZ OSD Menu Control.

• Keypad controls. For information on using the keypad controls, refer to Accessing a Remote Camera Programming Menu.

• Keyboard keys. For information on using the keyboard keys, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions.

DX8100This section describes how to access the programming features of remote cameras and includes the following topics:

• Using the PTZ OSD Menu Control 

• Accessing a Remote Camera Programming Menu 

Using the PTZ OSD Menu Control

The DX8100 allows you to navigate the menu system of remote cameras using the PTZ OSD Menu control. The PTZ OSD Menu control is 
available when the DX8100 is in Live View mode. DX8100Alternative methods to navigate the remote camera menu system are as follows:

• Keypad controls. For information on using the keypad controls, refer to Accessing a Remote Camera Programming Menu.

• Keyboard keys. For information on using the keyboard keys, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions.

The following figure shows the PTZ OSD Menu control.

Figure 41.  PTZ OSD Menu
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The following table describes the parts of the PTZ OSD Menu control.

Accessing a Remote Camera Programming Menu

The DX8100 allows you to navigate the remote camera menu system using any of the following:

• PTZ OSD Menu controls. For information on using the PTZ OSD Menu controls, refer to Using the PTZ OSD Menu Control.

• Keypad controls. For information on using the keypad controls, refer to Accessing a Remote Camera Programming Menu.

• Keyboard keys. For information on using the keyboard keys, refer to Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions.

The following procedure instructs you to use the PTZ OSD Menu control to navigate the remote camera programming menu.

To access a programming menu for a remote camera:

1. On the DX8100 toolbar, click . 

2. Drag a remote camera from the Site tree onto a view panel.

For certain camera models, you can also select preset number 95 from the keypad to access remote setup mode.

3. To access remote camera setup mode, do one of the following:

• On the DX8100 keypad, click  from the keypad.

• Click , 9, 5, and  from the PTZ keypad.

Figure 42.  PTZ Control Panel

4. To navigate up and down through camera menu choices, do one of the following:

• Use the PTZ OSD Menu controls. 
• Use the on-screen PTZ controls or the focus (+) and focus (-) buttons. 

5. To select an option from the camera’s on-screen menu, do one of the following:

• On the PTZ OSD Menu, click Enter.
• On the keypad, click the iris (+) button.

Table Q.  Parts of the PTZ OSD Menu Control

Item Part Description

Enter Provides the following actions:

• Accepts the selected remote camera OSD menu choice.

• Accesses menu option parameters. For example, point the cursor at the Language option and click 
Enter accesses the list of available languages. 

Exit N/A

Up and Down 
Buttons

Navigate up and down the remote camera OSD menu, or cycle through a list of options or parameters.

Left and Right 
Buttons

Perform no activity.
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6. Click the iris (-) button to cancel an option or select the Exit command.

You can also use the on-screen PTZ controls with your mouse to navigate through camera menus. Click and drag the mouse up or down to 
move between menu options.

7. Click the iris (+) button to select the option, or to exit a menu when the cursor is pionted at the Exit command.

Figure 43.  Camera Setup Menu
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SENDING AUXILIARY COMMANDS TO A DEVICE
The DX8100 auxiliary feature allows you to control external equipment connected to the auxiliary outputs of Spectra domes or Esprit positioning 
systems. The auxiliary function is implemented through the D protocol and P protocol. In this case, the attached camera and DX8100 must be 
configured to communicate using one of these protocols. 

The Aux key selects the auxiliary mode. Buttons 1-4 select which of the camera’s auxiliary outputs to operate. Buttons 1-4 operate as a toggle 
(on/off) each time they are clicked. 

For example, an Esprit equipped with a wiper uses Aux 1 to control the wiper. In this case, pressing Aux and then 1 sends a command to the 
Esprit to operate the wiper. You must configure the camera to establish how the camera responds to an auxiliary command. For detailed 
information about how a specific Spectra or Esprit camera system interprets auxiliary commands, refer to the documentation that accompanies 
your Spectra or Esprit camera system. 

To send an auxiliary command:

1. On the DX8100 keypad, click  to enter the programming mode. 

2. Select the camera in the DX8100 view panel to which you want to send the auxiliary command.

3. Click the Aux button. Keypad buttons 1-4 are available.

Figure 44.  Auxiliary (Aux) Button

The following figure shows that keypad buttons 1-4 are available.

Figure 45.  Keypad Buttons 1–4 are Available

4. Click a keypad button (1-4). The auxiliary function, assigned by camera for the selected button, is executed.

�

�
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CONFIGURING PRESET TOURS
A preset tour allows a camera to move through a programmed sequence of PTZ presets. The DX8100 Series DVR can store up to four preset 
tours. While four tours can be programmed, only one tour can be activated at a time. A preset tour will operate continuously until another PTZ 
control action is performed. At least one PTZ preset must be set in order to create a preset tour.

This section describes how to configure preset tours and includes the following topics:

• Programming a Preset Tour 

• Activating a Preset Tour 

• Deactivating a Preset Tour

PROGRAMMING A PRESET TOUR

This section describes how to program a preset tour and includes the following topics:

• Accessing a Preset Tour Group

• Adding Presets to a Tour

• Deleting Presets from a Tour 

Accessing a Preset Tour Group

To access the “Preset tour group” dialog box:

1. On the DX8100 toolbar, click . 

2. On the DX8100 keypad, click  and then  on the PTZ keypad. The “Preset tour group” dialog box opens.

3. Select the preset tour (1-4) that you want to program from the drop-down box.

4. Do one of the following:

• To add presets to a tour, refer to Adding Presets to a Tour.
• To delete presets from a tour, refer to Deleting Presets from a Tour.

Figure 46.  Preset Tour Dialog Box

�
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Adding Presets to a Tour

To add presets to a tour:

1. Access the “Preset tour group” dialog box. For information on accessing the “Preset tour group” dialog box, refer to Accessing a Preset Tour 
Group.

2. Click the check box beside one of the presets you want to add to the tour.

3. Double-click in the Dwell Time field of a preset, and then increase or decrease the time (in seconds) at which the camera will remain during 
that sequence of the tour. 

4. Repeat steps 1 and 2 for each additional preset you want to add to the tour.

5. Click Add to Group.

6. Click Save.

7. Click Exit to return to the main screen.

Figure 47.  Adding Preset to Tour
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Deleting Presets from a Tour

To delete presets from a tour:

1. Access the “Preset tour group” dialog box. For information on accessing the “Preset tour group” dialog box, refer to Accessing a Preset Tour 
Group.

2. Click the check box beside one or more presets you want to delete from the preset tour group.

3. Click Delete.

4. Click Save.

5. Click Exit to return to the main screen.

Figure 48.  Deleting Preset from Tour
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ACTIVATING A PRESET TOUR

This section describes how to activate a preset tour. You can save a preset tour for later use without engaging the tour by not performing step 5. 
Then, continue on to step 6 without clicking Apply.

To activate a preset tour: 

1. On the DX8100 toolbar, click . 

2. Click  and then  to bring up the "Preset preset tour group" dialog box.

3. From the drop-down box, select the preset tour (1-4) you want to activate.

4. Click Save. 

5. Click Apply. 

6. Click Exit to return to the main screen.

7. Click  on the PTZ keypad to exit programming mode.

8. Click  on the PTZ keypad to activate the tour.

Figure 49.  Activating a Preset Tour

To reactivate the last preset tour you configured:

•  On the keypad, click Preset.

DEACTIVATING A PRESET TOUR

To deactivate a preset tour, do one of the following:

• Use the mouse to move the on-screen PTZ control.

• Activate a PTZ preset.

�
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Working in Playback Mode
Recorded video can be played back one channel at a time on the DX8100. Like live video, recorded video is viewed from the camera view panels 
on the main screen. Refer to Understanding View Panes and Panels for information on view panels. Only users with playback access rights 
(Standard User by default) and higher are allowed to view recorded video. Playback video can also be displayed in full screen view. For 
information about displaying playback video in full screen view, refer to Displaying Playback Video in Full Screen View.

This section describes how to use the Playback mode and includes the following topics:

• Accessing Playback Mode 

• Assigning Cameras to View Panels 

• Playback On-Screen Display (OSD) 

• Playback Controls 

• Playback Timeline 

• Playing Back Video by Time

• Playing Back Video by Event

• Operating Playback Digital Zoom

• Viewing Video in the Deinterlaced Mode

• Viewing Live and Playback Video Simultaneously

ACCESSING PLAYBACK MODE
To access the Playback mode:

• On the DX8100 toolbar, click Live.

ASSIGNING CAMERAS TO VIEW PANELS
To assign a camera to a view panel:

1. Drag a camera from the Site tree onto a camera view pane.

2. Repeat this process for up to 36 cameras.

PLAYBACK ON-SCREEN DISPLAY (OSD)
The on-screen display for playback is identical to live view, with the exception of a date/time field in place of the PTZ designator. 

Figure 50.  Playback OSD
C2631M-A (6/07) Client Application 69



PLAYBACK CONTROLS
Use the playback controls to start playback, control direction, and adjust speed. Click  at any time to return to live view. 

The following figure shows the DX8100 playback controls.

Figure 51.  Playback Controls

The following table describes the parts of the payback controls.

Table R.  Parts of the Playback Controls

Item Part Description

Frame-By-Frame 
Reverse

Each frame is displayed in the reverse direction with each click of the Frame-by-Frame Reverse 
button.

Frame-By-Frame 
Forward

Each frame is displayed in the forward direction with each click of the Frame-by-Frame Forward 
button.

Fast Forward to End Advances the bookmark to the end of the latest recorded video. 

Play Forward Initiates normal playback of recorded video in the forward direction.

Stop Stops playback control activity and returns to the Live View mode.

Pause Pauses video playback in the forward or reverse direction.

Play Reverse Initiates normal playback of recorded video in the reverse direction.

Rewind to Beginning Returns the bookmark to the start of the earliest recorded video. 
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The following figure shows the DX8100 playback speed and volume controls.

Figure 52.  Playback Speed and Volume Controls

The following table describes the parts of the playback speed and volume controls.

Table S.  Parts of the Playback Speed and Volume Controls

Item Part Description

Normal Playback speed is at normal rate.

Faster Playback speed is increased to a faster rate.

Slower Playback speed is reduced to a slower rate.

Louder Volume is increased to a higher level or decreased to a lower level.

Mute Volume is silenced.

�
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PLAYBACK TIMELINE
The playback timeline is used to select a day and time to begin playback. The timeline includes a horizontal slider that can be moved to select 
playback time over a 24-hour period. Time periods containing recorded video are represented as color-coded segments of the timeline. The 
following figure illustrates the timeline color-coding scheme.

 

Figure 53.  Playback Timeline

The following table describes the parts of the playback timeline control.

Table T.  Parts of the Playback Timeline Control

Item Part Item Part

Currently displayed view panel Selected second

Total number of view windows Increase timeline detail

Site number Decrease timeline detail

Camera number Alarm recording

Camera name Normal recording

Selected date Motion detection recording

Selected hour Timeline slider

Selected minute Instant recording

00   01   02    03   04   05    06   07   08    09   10   11   12    13   14   15   16    17   18    19   20   21   22   23

Panel:      1/8 S03  C09 [Camera 9] 11-27-2003 05 00 56
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PLAYING BACK VIDEO BY TIME
This section describes how to play back video by time. The time is displayed in 24-hour clock format. You can select the time by moving the slider 
along the timeline.

This section includes the following topics:

• Starting Playback from a Specific Point in Time

• Understanding Instant Playback

STARTING PLAYBACK FROM A SPECIFIC POINT IN TIME

To start video playback from a particular point in time:

1. On the DX8100 toolbar, click . 

2. Select a camera in the Site tree. You can also select the camera from a view pane if the camera appears in the panel.

3. In the Timeline section, do the following:

a. In the Date Selection drop-down box, select the day you want playback to begin.

b. Use the spinner buttons to select the time.

4. Click  to begin viewing. 

Figure 54.  Date Selection Drop-Down Box

UNDERSTANDING INSTANT PLAYBACK

The DX8100’s ability to perform instant playback of video is limited by a one-minute delay interval. The DX8100 has a built-in latency of 
approximately one minute between the time that video is captured and when it is written to the hard disk. This delay exists to ensure that video 
is accurately stored and the DVR’s database is updated correctly.

The delay interval is not affected if the DX8100 is in the alarm or motion record mode. In this case, the pre-alarm or pre-motion time period does 
not become a factor in determining the delay interval.

To initiate an instant playback:

• On the playback control, click Instant Playback. The timeline is zoomed to the last two or three minutes of data. 

The user has the ability to view video that is just recorded. This video image resides in memory and has not yet been stored on the hard drive. 
The color of the timeline will be green. This is because the system cannot tell what the data characteristic is while the data resides in memory

For example, if this data is recorded from a camera configured to monitor motion and there is no motion activity, the data will not be stored on 
the hard disk drive. 
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PLAYING BACK VIDEO BY EVENT
Users with playback access rights (Standard User by default) and higher can search video by events, such as motion detection or alarm 
activation. A sensor event is identical to an alarm event.

To play back video recorded during an alarm or motion event:

1. On the DX8100 toolbar, click . 

2. From the DX8100 menu bar, choose View > Index View. The Event Type drop-down box is displayed. 

Figure 55.  Event Type Drop-down Box

3. Select a camera by clicking it in the Site tree.

4. In the Date Section drop-down box above the playback timeline, select the day that you want events to be displayed. 

5. In the Event Type drop-down box, select the event type you want to view. Options are as follows:

• All
• None
• Motion
• Alarm in
• ATM/POS
• Video Loss

6. Select an event from the listing.

7. On the playback control, click  to begin viewing. 

OPERATING PLAYBACK DIGITAL ZOOM
Video playback can be zoomed (using a control keypad or the mouse) when the DX8100 is in the Playback or Search mode. In Playback mode, the 
on-screen PTZ feature is replaced with the mouse-activated digital zoom. Playback digital zoom is also available in Search mode. For information 
on the Playback mode, refer to Working in Playback Mode. For information on the Search mode, refer to Working in Search Mode.

This section describes how to operate playback digital zoom and includes the following topics:

• Zoom Using the Digital Zoom Control 

• Zoom Using the Mouse

• Panning a Zoomed Image

• Working in Playback Mode

• Working in Search Mode
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ZOOM USING THE DIGITAL ZOOM CONTROL

The digital zoom feature is accessible when the DX8100 is in the Playback or Search mode. For information on the Playback mode, refer to 
Working in Playback Mode. For information on the Search mode, refer to Working in Search Mode.

To zoom using the digital zoom control: 

1. To place the DX8100 in the Playback or Search mode, do one of the following:

• On the DX8100 toolbar, click Live. 
• On the DX8100 toolbar, click Search.

2. Click  to start video playback.

3. Use the Digital Zoom control to zoom and pan video playback.

Figure 56.  Playback Digital Zoom Control

The following table describes the parts of the Digital Zoom control. 

ZOOM USING THE MOUSE

The DX8100 allows you to use the mouse to drag a selection region (rectangle) around a specific area of a pane, and to zoom the selection in and 
out. A small rectangle about 0.25 inches (6.4 mm) square provides a x6 zoom factor. As the selection area increases in size, the zoom in/out 
factor decreases: x5, x4, x3, x2, and x1.

• If you use the mouse to select an area about 0.25 inches (6.4 mm) in size, the zoom feature performs as follows: 
– If zooming in, the zoom factor is at x6. The selected viewing area is zoomed to the largest size.
– If zooming out, the zoom factor is at x6. The selected viewing area is zoomed to the original size.

• If you use the mouse to select the entire pane, the zoom feature performs as follows: 
– If zooming in, the zoom factor is at x1. In this case, the selected viewing area is slightly enlarged. You will have to perform many zoom 

in operations to arrive at the largest zoom size.

Table U.  Parts of the Digital Zoom Control 

Item Part Description

Zoom In Allows you to magnify the entire pane. Click the Zoom In button to magnify to the next preset magnification 
level (x1-6). 

Zoom Out Allows you to reduce to the previous preset magnification. Click the Zoom Out button to reduce to the 
previous magnification level.

Pan Left Allows you to move the magnified playback image to the left.

Pan Right Allows you to move the magnified playback image to the right.

Pan Up Allows you to move the magnified playback image up.

Pan Down Allows you to move the magnified playback image down.

Zoom Restore Allows you to return the zoomed image to the original size.
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– If zooming out, the zoom factor is at x1. In this case, the selected viewing area is slightly reduced. You will have to perform many zoom 
out operations to arrive at the original size.

• You can also use the hand tool and the mouse wheel to zoom in and out.

The zoom factor is displayed in the upper-right corner of the pane. The effective zoom in factor is displayed after the zoom operation is 
performed. The effective zoom out factor is not displayed.

To zoom using the mouse:

1. To place the DX8100 in the Playback or Search mode, do one of the following:

• On the DX8100 toolbar, click Live. 
• On the DX8100 toolbar, click Search.

2. Click  to start video playback.

3. Do the following:

a. To zoom in, click and drag the mouse diagonally to your right in a downward direction.
.

Figure 57.  Zoom In Using Mouse

b. To zoom out, click and drag the mouse diagonally to your left in an upward direction. 

Figure 58.  Zoom Out Using Mouse
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PANNING A ZOOMED IMAGE

This section describes how to use the hand tool and mouse wheel to zoom in and out.

To pan a zoomed portion of video within the view panel: 

1. To place the DX8100 in the Playback or Search mode do one and of the following:

• On the DX8100 toolbar, click Live. 
• On the DX8100 toolbar, click Search.

2. Right-click in the view panel. The mouse pointer now resembles a hand.

3. Click the left mouse button, and drag the mouse in the direction you want to move the video image. 

4. Right-click again to return to zoom mode.
 

Figure 59.  Panning Zoomed Video with the Mouse
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Working in Search Mode
The DX8100 Series DVR supports four video search methods: index, thumbnail, POS, and pixel. For information about the user access level 
required to search video data, refer to Definition of User Access Levels. 

To enter the Search mode:

• On the DX8100 toolbar, click Search.

This section describes how to use the Search mode and includes the following topics:

• Search Window 

• Displaying a Deinterlaced Image in the Search Mode 

• Reusing the Search Time Range

• Index Video Search 

• Thumbnail Video Search 

• POS Search

• Pixel Video Search 

• Working with Special View and Search Methods

SEARCH WINDOW
The search window facilitates access to the search capabilities of the DX8100. Available search methods include index, thumbnail, POS, and 
pixel. Each search method allows users with playback access rights (Standard User by default) and higher to locate video data instantly using 
criteria such as time of day or changes in window pixels.

As in Playback mode, digital zoom, export, and print features are available in Search mode. For more information, refer to Operating Playback 
Digital Zoom, Exporting Video, and Printing Images. 

The following figure shows the parts of the DX8100 window in Search mode.

Figure 60.  DX8100 Client Search Mode Window
78 Client Application C2631M-A (6/07)



The following table describes the parts of the DX8100 window in the Search mode.

DISPLAYING A DEINTERLACED IMAGE IN THE SEARCH MODE
If you are searching for an image that is recorded at 4CIF at a low frame rate per second, the viewed image might move or tear. The View menu’s 
Deinterlaced Image option is used to enhance the image during a search activity. 

To search video using the deinterlaced option:

1. On the menu bar, click View > Display deinterlaced image.

2. On the DX8100 toolbar, click . The DX8100 is placed in the Search mode.

REUSING THE SEARCH TIME RANGE
The DX8100 allows sharing of time range search settings between the Thumbnail and Pixel search mode. If you initiate a Thumbnail search, you 
can select a preview clip and initiate a Pixel search. The Pixel search mode is based on the same time criteria as the preview Thumbnail clip.

INDEX VIDEO SEARCH
Index search allows a user to search video by events, such as motion detection or alarm activation. Events are listed chronologically and by type. 
To ensure thhe proper camera channel is selected, check the camera information box above the playback timeline or verify that the desired view 
panel is framed with a thin red outline. Index video can also be displayed in full screen view. For information about displaying playback video in 
full screen view, refer to Displaying Index Search Video in Full Screen View.

Table V.  Parts of the DX8100 Window in Search Mode

Item Part Description

Index Search Allows users to search motion and alarm events listed in the event index panel. 

Thumbnail Search Allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a 
series of thumbnail images. Each thumbnail represents the first image recorded during a specified period of 
time. Thumbnails can be expanded and collapsed to represent hourly, 10-minute, and 1-minute intervals.

POS Search Allows users to search ATM/POS transaction text data. 

Pixel Search Allows users to search any 24-hour period of recorded video automatically for changes in screen pixels. 

View Window Displays search video, image thumbnails, and pixel grid.

Site Tree Facilitates top-down, hierarchical management of DX8100 resources such as servers, cameras, alarms, and 
relays.

Event Index Panel Lists motion and alarm events over the 24-hour time period specified in the playback timeline. 

Select All Check Box Enables playback for all visible view panels when selected. If this check box is deselected, only the 
selected channel will play. This control is only available while using Index Search.

Playback Timeline Displays a 24-hour timeline marked with color-coded video events. Allows user to select a date and time 
for playback. 

Playback Control 
Panel

Provides buttons to control video playback. Includes forward and reverse playback and still image. Also 
provides controls for playback speed and volume.

Playback Zoom 
Control Provides access to digital zoom features during playback.

Search Control Provides access to the index, thumbnail, POS, and pixel search controls.
C2631M-A (6/07) Client Application 79



To search video by motion or alarm events:

1. On the DX8100 toolbar, click .

2. On the DX8100 Search control, click .

3. On the DX8100 toolbar, click a view panel division button. 

4. From the Site tree, drag the camera channel you want to search onto one of the view panels. 

5. Click the view panel of the channel you want to search. 

6. From the drop-down box on the playback timeline, select the day you want playback to begin.

7. Select the event type you want to view from the event type drop-down box. 

Only events recorded for the selected camera are listed in the index. A sensor event is identical to an alarm event. Options are as follows:

• All
• None
• Motion
• Alarm in
• ATM/POS
• Video Loss

8. Select an event from the index.

9. Verify that the “Select all” check box is selected. Deselecting the “Select all” check box will disable playback for all view panels except the 
channel being searched.

The DX8100 allows you to view playback on multiple cameras in addition to the camera being searched. This feature is valuable if you want 
to examine a variety of views recorded at the time a certain event was detected.

10. Click  to begin viewing. 

Figure 61.  DX8100 Client Index Search Screen
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THUMBNAIL VIDEO SEARCH
Thumbnail search allows users to visually search video that has been recorded over a 24-hour period. Video is presented as a series of thumbnail 
images. Each thumbnail represents the first image recorded during a specified period of time. Thumbnails can be expanded and collapsed to 
represent hourly, 10-minute, and 1-minute intervals.

The DX8100 allows sharing of time range search settings between the Thumbnail and Pixel search mode. In this case, if you initiate a Thumbnail 
search, you can select a preview clip and initiate a Pixel search. The Pixel search mode is based on the same time criteria as the preview 
Thumbnail clip.

To visually search video using thumbnail images:

1. On the DX8100 toolbar, click . 

2. On the DX8100 Search control, click .

3. Select a camera from the Site tree.

4. From the drop-down box, select the date on which you want to begin your search.

5. Click the thumbnail for the hour you want to begin searching.

6. Click  to change the thumbnail time range to shorter intervals, or click  to change the thumbnail time range to longer intervals.

• Click  to change from 1-hour intervals to 10-minute intervals.

• Click  again to change from 10-minute intervals to 1-minute intervals.

• Click  once to change from 1-minute intervals to 10-minute intervals.

• Click  again to change from 10-minute intervals to 1-hour intervals.

7. Click the thumbnail of the interval you want to search.

8. Click  to view video.

Double-clicking a thumbnail image will enlarge the image and begin playback.

9. Click  to return to thumbnail images.
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Figure 62.  DX8100 Client Thumbnail Search Screen 

POS SEARCH
The DX8100 allows a user to search any 24-hour period of recorded POS video and data. To record ATM/POS video and data, the ATM/POS 
devices and DX8100 must first be connected and configured as follows:

• Physically connect the ATM/POS devices to the DX8100.

• Set up camera-to-ATM/POS device linking. 

• Configure the DX8100 ATM/POS settings for each attached ATM/POS device.

• Start an ATM/POS transmittal and verify that the DX8100 is receiving the ATM/POS video and data.

For information about setting up the DX8100 for ATM/POS applications, refer to the following sections in the DX8100 Operations and 
Programming manual:

• Linking Relay Outputs to ATM/POS Events 

• Linking Cameras to Record in Response to ATM/POS Events 

• Linking Presets and Patterns to ATM/POS Events 

• Setting Up ATM/POS Device Communication Ports

• Setting UP ATM/POS Device Properties 

This section describes how to use the POS search feature and includes the following topics:

• Understanding the POS Search View

• Searching and Displaying POS Data by Device Name 

• Searching by POS Transaction Number 

• Searching for All Transactions with Exceptions

• Searching for Transactions That Satisfy Specific Exceptions 

• Searching for Transactions by Line Item 

• Searching for Transactions by Action Code

	

�

� �

�
�
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UNDERSTANDING THE POS SEARCH VIEW

To enter the POS Search mode:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

The following figure shows the parts of the POS search view. 

Figure 63.  POS Search View
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The following table describes the parts of the POS search view.

Table W.  Parts of the POS Search View

Item Part Description

Date Date range for which to search the video and data. 

Time Time range based on a 24-hour time period for searching POS events.

Transaction 
Information

Allows POS search by transaction information options as follows:

• Device name: The ATM/POS device linked to a specific camera. In this case, selecting a camera linked 
to an ATM/POS device automatically inserts the name of the ATM/POS device in the Device Name box. 

• Transaction Number: A number assigned by the ATM/POS device that is printed on the sales are 
transaction receipt.

Data Information Allows POS search by data information options as follows:

• Transaction with Exception Only: Finds all transactions for which an exception is defined.

• Line Item: Allows you to search POS data by a specific transaction line item, based on the following 
guidelines: 

– Line item entries are not case sensitive. Enter lower or uppercase characters. 
– Specify the asterisk (*) wildcard. 
– Search by a single word or multiple words appearing in a transaction line. 
– Type the first few characters of the first word appearing in the transaction and the wildcard. For 

example, type sma* for a line item containing the entry “small orange juice.” The search returns all 
transactions that contain the word “small.”

– Type the first few characters of the second word in a transaction and the wildcard. For example, type 
ora* for a line item containing the entry “small orange juice.” The search returns all transactions that 
contain the word “orange.”

– Search by abbreviation. For example type 6-pk, for a line item containing the entry “Soda 6-pk.” The 
search returns all transactions that contain the abbreviation “6-pk.”

• Action Code: A two-letter abbreviation designating a specific action code. For information about 
action codes, refer to the Setting Up ATM/POS Device Properties section in the Operations and 
Programming manual.

• Exception Code: A predefined transaction filter used to detect a specific data structure within the 
ATM/POS transaction data. For information about exceptions, refer to the Setting Up ATM/POS 
Exceptions section in the Operations and Programming manual.

Start and Stop Start: Initiates a search event.

Stop: Ends a search event.

POS Search Table Lists the data discovered in response to the POS options selected for the transaction and data information.

• Channel number: From 1–16.

• Device name: By default, ATM/POS01 to ATM/POS16. The device name can be changed.

• Transaction number: Number assigned by the ATM/POS device to the transaction data.

• Date/Time: Date and time transaction is recorded.

• Exception: Yes if an exception filter is active for the transaction data has an exception. No if the 
transaction does not have an exception filter.

The transaction and data information are based on the ATM/POS configuration settings derived from the 
following:

• Data format 

• ATM/POS exceptions 

• Exception action codes

For information about setting up ATM/POS transaction and data options, refer to the Setting Up ATM/POS 
Device Properties section in the Operations and Programming manual.

Data Window Area where recorded transaction data is displayed.
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SEARCHING AND DISPLAYING POS DATA BY DEVICE NAME

You can perform a general search for POS transaction data record for a particular ATM/POS device and its associated camera. Use the date and 
time and ATM/POS device name as the search criteria. The search results contain all POS transactions recorded for that device according to the 
specified date and time.

Searching POS Data by Device Name

To search POS transaction data by ATM/POS device name:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed. 

3. To select a channel, in the DX8100 Site tree, click a camera that is linked to an ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this case, 
the Device Name text box is deselected.

4. Select the date and time for the POS search event as follows:

a. Select the Start date.

b. Select the End date.

c. Select the End time.

d. Select the Start time.

5. In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

6. Verify that the ATM/POS device name displayed in the Device Name text box is the correct device for the search.

Data Overlay Box The function is not supported at this time.

Video Window Area where live and playback (recorded) video is viewed. Playback video is started at the date and time 
specified for the respective transaction data as shown in the POS Search table. The DX8100 playback 
controls are used to view playback video.

Table W.  Parts of the POS Search View (Continued)

Item Part Description
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7. Click Start Search. The POS Search Table is populated with POS transaction data.

Figure 64.  POS Transaction Search by Device Name

Displaying POS Data Discovered by Device Name

To display a POS transaction and its associated video:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. Perform a POS search by device name. For information about performing a search by ATM/POS device name, refer to Searching POS Data 
by Device Name. 

4. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

5. On the playback control, click Play. The video recorded for the selected POS transaction is played back and is displayed in the Video 
window.

�
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6. Use the playback control to stop or pause playback, reverse playback, and so forth.

Figure 65.  Display a POS Transaction Search by Device Name

SEARCHING BY POS TRANSACTION NUMBER

The DX8100 allows you to search for a POS event by transaction number. You must specify the channel, date, and a time window in which the 
transaction is recorded. 

To search for a POS event by transaction number:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a device name, do one of the following:

• In the DX8100 Site tree, click a camera that is linked to an ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range you want to search for the transaction number.

5. In the Transaction Information section, click the check box to select Transaction Number. The Transaction Number text box is available.

6. In the Transaction Number text box, type the transaction number.

7. Click Start Search. If the channel, date, time, and transaction number are valid, the POS transaction is displayed in the POS Search Table.

8. In the POS Search Table, click a transaction entry. The transaction data is displayed in the Data window.

�
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9. On the playback controls, click Forward Playback. The video recorded for the transaction is displayed in the Video window.

Figure 66.  Searching an POS Event by Transaction Number

SEARCHING FOR ALL TRANSACTIONS WITH EXCEPTIONS

The DX8100 allows you to search for transactions that meet conditions defined by one or more exceptions. In this case, you must configure your 
search criteria based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transactions were recorded.

To use an exception to search transaction data, the exception must be created before recording the transaction data. If the transaction data is 
recorded before the exception filter is defined, the exception filter will not find the data structure within the transaction data.

To search for only POS events by transaction with exception:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, click the check box to select Transaction with Exception Only. The Exception Code check box is available. 

6. Click Start Search. If the device name/channel, date, and time are valid, and if transactions with exceptions were recorded during the time 
range, the transactions are displayed in the POS Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.
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8. On the playback controls, click Forward Playback. The video recorded for the transaction is displayed in the Video window.

Figure 67.  Searching for Transaction with Exception Only Events

SEARCHING FOR TRANSACTIONS THAT SATISFY SPECIFIC EXCEPTIONS

The DX8100 allows you to search for and display ATM/POS transactions that meet conditions as defined by one or more exceptions. You can use 
specific exception codes to define the search criteria. To use an exception to search transaction data, the exception must be created before 
recording the transaction data. If the transaction data is recorded before the exception filter is defined, the exception filter will not find the data 
structure within the transaction data.

The search criteria is based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transactions were recorded.

• Exception code: The predefined transaction filter used to detect a specific data structure within the ATM/POS transaction data.

To search for transactions that meet specific exceptions:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed.

3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Transaction with Exception Only. The Exception Code check box is available. 

b. Click the check box to select Exception Code. The Exception Code text box is available.

c. Type the exception code in the text box.

�

�

�

3b
C2631M-A (6/07) Client Application 89



6. Click Start Search. If the device name/channel, date, and time are valid, and if transactions with exceptions were recorded during the time 
range, the transactions are displayed in the POS Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

Figure 68.  Transactions that Satisfy Specific Exception Filters

SEARCHING FOR TRANSACTIONS BY LINE ITEM

The DX8100 allows you to search for and display ATM/POS transactions that contain a unique line item. Use the asterisk (*) as a wildcard 
character to substitute for zero or more characters. 

The search criteria is based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transaction(s) were recorded.

• Line item: The line item has the following guidelines:
– Line item entries are not case sensitive. Enter lower- or uppercase characters. 
– Specify the asterisk (*) wildcard. 
– Search by a single word or multiple words appearing in a transaction line. 
– Enter the first few characters of the first word appearing in the transaction and the wildcard. For example, type sma* for a line item 

containing the entry “small orange juice.” The search returns all transactions that contain the word “small.”
– Enter the first few characters of the second word in a transaction and the wildcard. For example, type ora* for a line item containing 

the entry “small orange juice.” The search returns all transactions that contain the word “orange.”
– Search by abbreviation. For example, type 6-pk for a line item containing the entry “Soda 6-pk.” The search returns all transactions that 

contain the abbreviation “6-pk.”

To search for transactions that contain a unique line item:

1. On the DX8100 toolbar, click .

2. On the Search control, click .The POS search view is displayed.
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3. To select a ATM/POS device, do one of the following:

• In the DX8100 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

• Do the following:
(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Line Item. The Line Item text box is available. 

b. Type the name of the line item in the text box.

6. Click Start Search. If the device name/channel, date, and time are valid, transactions containing the line item are displayed in the POS 
Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.
 

Figure 69.  Transactions that Contain a Unique Line Item

SEARCHING FOR TRANSACTIONS BY ACTION CODE

The DX8100 allows you to search for and display ATM/POS transactions by action code. To use an action code to search transaction data, the 
action code must be created before recording the transaction data. If the transaction data is recorded before the action code is defined, the 
action code will not find the data structure within the transaction data.

The search criteria is based on the following: 

• Channel: The camera that captured the video and is linked to the ATM/POS device that produced the transaction data. 

• Date/time: The date and time window within which the transaction(s) were recorded.

• Action code: The special two-character filter that defines a specific transaction event.

To search for transactions by action code:

1. On the DX8100 toolbar, click .

2. On the Search control, click . The POS search view is displayed.
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3. To select a ATM/POS device, do one of the following:

a. In the DX8100 Site tree, click a camera that is linked to the ATM/POS device.

By default, the name of the ATM/POS device linked to the selected camera/channel is displayed in the Device Name text box. In this 
case, the Device Name text box is deselected.

or

b. Do the following:

(1) In the Transaction Information section, click the check box to select Device Name. The Device Name text box is available.

(2) Type the ATM/POS device name in the Device Name text box.

4. Set the date and time range for the search.

5. In the Data Information section, do the following:

a. Click the check box to select Action Code. The Action Code drop-down box is available. 

b. In the Action Code drop-down box, select an action code. For information about action codes, refer to the Using Action Codes section 
in the Operations and Programming manual.

6. Click Start Search. If the device name/channel, date, and time are valid, transactions containing the line item are displayed in the POS 
Search Table.

7. In the POS Search Table, click a transaction. The transaction data is displayed in the Data window.

Figure 70.  Searching Transactions by Action Code

PIXEL VIDEO SEARCH
The DX8100 allows a user to automatically search any 24-hour period of recorded video for changes in screen pixels. This feature can be 
configured to identify motion events even when motion detection has not been enabled on a camera.

The DX8100 allows sharing of time range search settings between the Thumbnail and Pixel search mode. If you initiate a Thumbnail search, you 
can select a preview clip and initiate a Pixel search. The Pixel search mode is based on the same time criteria as the preview Thumbnail clip.

This section describes how to search video by changes in screen pixels and includes the following topics:

• Searching Video Based on Changes in Screen Pixels

• Viewing a Video Thumbnail

�

�

�

3b

5a5a

5b5b
92 Client Application C2631M-A (6/07)



SEARCHING VIDEO BASED ON CHANGES IN SCREEN PIXELS

DX8100 pixel video search is accomplished in two steps:

• Searching recorded video for changes in screen pixels. 

After the search has been completed, the DX8100 displays a series of thumbnails below the search grid. Each thumbnail contains the first 
image of recorded video for the specified date and time range period. 

NOTE:  A pixel search might not detect obvious movement. 

• Viewing the thumbnails. 

For information on how to view the video thumbnail, refer to Viewing a Video Thumbnail.

To search video by analyzing changes in screen pixels:

1. On the DX8100 toolbar, click .

2. On the Search control, click .

3. Select a camera from the Site tree.

4. From the drop-down box, select the date on which you want to begin your search.

5. Select the start and end times to define your search range.

6. Using your mouse, highlight the areas on the grid that you want to search for pixel changes.

• Hold down the left mouse button and drag to select areas.
• Hold down the right mouse button and drag to clear areas.

7. Adjust the pixel sensitivity threshold. Moving the slider to the left decreases sensitivity and moving it to the right increases sensitivity.

8. Click Start. Wait for the progress line on the status bar to return to Ready.

9. Use the  icon to show and hide the pixel grid for a clearer view in the search screen.

Figure 71.  Pixel Search Screen
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VIEWING A VIDEO THUMBNAIL

After the search has been completed, a series of thumbnails appear on the screen below the search grid. Each thumbnail contains the first image 
of recorded video for the listed time period.

• Double-clicking a thumbnail will cause it to begin playing.

• Click  and  to move backward and forward through thumbnails. 

To view a video thumbnail:

1. Click a thumbnail. The thumbnail’s search parameters (date and time) are displayed below the search grid. The thumbnail’s search start 
time is a few seconds ahead of the search start time you entered.

Figure 72.  Thumbnail Images Marking Pixel Changes

2. To locate playback at the start of the first image, click . The video scene is played back and displayed in reverse. 

3. Click  to pause the video playback when the beginning of the first recorded is reached.

4. Click . Playback starts and the video scene is displayed.

5. Click  to remove the thumbnail results.

WORKING WITH SPECIAL VIEW AND SEARCH METHODS
The DX8100 allows you to do the following:

• View video in the deinterlaced mode.

• View live and playback video simultaneously.

• View, search, export, and print backed up video. 

This section describes how to use special view and search methods and includes the following topics:

• Viewing Video in the Deinterlaced Mode 

• Viewing Live and Playback Video Simultaneously 

• Viewing and Searching backed up Video 




94 Client Application C2631M-A (6/07)



VIEWING VIDEO IN THE DEINTERLACED MODE

Images recorded at 4CIF at a low frame rate per second might move or tear. In this case, you can use the View menu’s Deinterlaced Image option 
to enhance the displayed image. In the deinterlaced mode, the DX8100 converts the recorded image and displays it at 2CIF resolution. The 
process removes one of the 4CIF interlaced fields (even or odd) from the 4CIF recorded image to arrive at 2CIF resolution for the displayed image. 
The original image is retained at the recorded 4CIF resolution. 

For exported images, the DX8100 provides a global option for enabling a deinterlacing filter. In this case, the selected channel’s image is 
exported at 2CIF resolution. This setting is effective for all channels and cannot be set for individual channels. For more information about 
enabling the denaturalizing filter, refer to Enabling the Deinterlacing Filter.

To view video using the deinterlaced option:

1. Click  to start video playback.

2. On the menu bar, click View > Display deinterlaced image.

VIEWING LIVE AND PLAYBACK VIDEO SIMULTANEOUSLY

The DX8100 allows simultaneous viewing of live and playback video from a single camera source.

To view live and playback video from the same camera:

1. On the DX8100 toolbar, click . 

2. Drag a camera from the Site tree to a view panel.

3. Click  to begin playback.

4. Drag the same camera from the Site tree onto a different view panel while video is playing.
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Exporting Video
Power Users and Administrators can export sections of prerecorded video to a local hard disk drive or other device attached to a client PC. 
The following instructions demonstrate how to export video. 

• You must put the recorder in Playback or Search mode to export video. You cannot access Export in Live mode.

• To export video or still images to a CD-R/RW or DVD-R/RW, you must have Nero Express CD burning software version 6.3.1.25 installed on 
your client PC. If you do not have this version of Nero Express, you can download an update or demo version at www.nero.com.

This section describes how to export video and includes the following topics:

• Exporting Bookmarked Video Regions 

• Inserting and Removing a USB Flash Drive

• Enabling the Deinterlacing Filter

• Mapping and Disconnecting a Network Drive 

• Performing the Export

• Stopping an Export While in Process 

EXPORTING BOOKMARKED VIDEO REGIONS
You can bookmark multiple regions of video along the timeline for export. Bookmarked regions are designated with start point and end point 
bookmarks. Multiple regions can be bookmarked along a single 24-hour timeline, but only a single channel can be exported at a time. 
Bookmarked regions are listed in the Export Video dialog box at the time of export. 

The following figure shows the DX8100 bookmark controls.

Figure 73.  Bookmark Controls

The following table describes the bookmark controls.

CREATING BOOKMARKS

To select a region to export:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Select a camera from the Site tree.

4. Locate the timeline slider at the beginning of the range you want to bookmark. 

You can use the drop-down box and spinner buttons above the timeline to locate a bookmark.

Table X.  Bookmark Controls

Button Command Description

Add Bookmark Does the following:

• Adds a red bookmark flag to mark the beginning of a start point.

• Adds a gray bar to indicate the range between the start point and end point.

Remove Bookmark Removes the selected bookmark.

Remove All 
Bookmarks

Removes all bookmarks.
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5. Click . A red bookmark flag appears on the timeline.
 

Figure 74.  Setting a Starting Bookmark

6. Locate the timeline slider at the end of the range you want to bookmark.

7. Click . The bookmark flag and the region between bookmarks turn gray.

Exporting a bookmarked region of video requires start and end bookmarks. If only one bookmark is set, video will not be marked for export.

8. Repeat steps 4-7 for each additional region you want to bookmark for that camera.

9. Click  if you are in Live mode, or proceed to step 8 if you are in Search mode.

10. Click  and follow the directions in Performing the Export.

CLEARING BOOKMARKS

This section describes how to clear bookmarks and includes the following topics:

• Clearing a Single Bookmark

• Clearing All Bookmarks

Clearing a Single Bookmark

To clear a single bookmark:

1. Select a bookmark flag from the timeline. The bookmark flag should change to a light green color.

2. Click  to remove the selected bookmark.

Figure 75.  Removing a Single Bookmark

Clearing All Bookmarks

To clear all bookmarks:

• Click Remove All Bookmarks.

� �
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BOOKMARKING AND EXPORTING MULTIPLE CHANNELS

The DX8100 allows you to bookmark a video region for one camera and apply that book marked time window to multiple channels. This feature is 
used in conjunction with the export feature. For example, if you want to export video recorded between 9:00 a.m. and 9:05 a.m. for multiple 
cameras, you set the bookmarks for camera 1 at 9:00 a.m. and 9:05 a.m. During the export process you can associate that same bookmarked time 
window with multiple cameras.

To book mark data and export video for multiple channels:

1. Make sure the DVR is in Search mode by clicking . 

2. Select a camera from the Site tree.

3. Locate the timeline slider at the beginning of the range you want to bookmark. 

You can use the drop-down box and spinner buttons above the timeline to locate a bookmark.

4. To create book marks, do the following:

a. Click . A red bookmark flag appears on the timeline.

b. Locate the timeline slider at the end of the range you want to bookmark.

c. Click . The bookmark flag and the region between bookmarks turn gray.

Exporting a bookmarked region of video requires start and end bookmarks. If only one bookmark is set, video will not be marked for 
export.

d. Repeat steps 3 and 4 for each additional region you want to bookmark for that camera.

Figure 76.  Book Marking Multiple Time Regions

5. Click . The Export Video dialog box opens.

6. Do the following:

a. Right click the time range you want to assign to multiple channels. The Duplicate Bookmark submenu is displayed.

Figure 77.  Selecting a Time Range for Duplication
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b. Click Duplicate Bookmark. The Select Channel dialog box opens.

Figure 78.  Select Channel Dialog Box

c. Click the check box for each channel to which you want to assign the book mark region.

d. Click OK. The time range for each selected channel is displayed in the Time Range table. 

7. Do the following:

a. In the Device panel, click the check box of the desired export device. 

b. Click the check box for each time range you want to export.

8. Click Export.

Figure 79.  Selecting the Export Device and Time Ranges

INSERTING AND REMOVING A USB FLASH DRIVE
The DX8100 supports both USB 1.1 and USB 2.0 flash drives. To ensure data is not lost or corrupted when exporting data to a USB flash drive, 
follow the steps listed in Removing a USB Flash Drive.

This section describes how to insert and remove a USB device and includes the following topics:

• Installing a USB Flash Drive

• Removing a USB Flash Drive

INSTALLING A USB FLASH DRIVE

This section describes how to install a USB flash drive. To install a USB flash drive into the PC:

1. Insert the USB drive into the PC’s USB 2.0 port. 

2. Wait five seconds while the PC recognizes and automatically installs the device.
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REMOVING A USB FLASH DRIVE

You can remove a USB device within the DX8100 environment. In this case, you do not have to exit to the Windows environment.

To remove the USB flash drive from the PC, follow the Windows instructions applicable for your machine. For example, for Windows XP:

1. Click the Safely Remove Hardware icon in the task bar. The system displays a message to safely remove the USB device. 

2. Click the Safely remove USB Mass Storage Device, Drive(G:) box. The system displays a confirmation message. 

3. Remove the USB flash drive. 

ENABLING THE DEINTERLACING FILTER
Images recorded at 4CIF at a low frame rate per second might move or tear. The DX8100 provides a global option for enabling deinterlacing 
filtering to enhance the exported image for 4CIF recorded channels. In this case, the exported image is converted to 2CIF resolution. This setting 
is effective for all channels, and cannot be set for enabling individual channels. For more information about viewing video in the deinterlaced 
mode, refer to Viewing Video in the Deinterlaced Mode.

To enable the deinterlacing filter:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. From the Export Format area, select the “Enable deinterlacing filter” check box.
. 

Figure 80.  Enabling the Deinterfacing Filter from the Export Video Dialog Box

MAPPING AND DISCONNECTING A NETWORK DRIVE
You can export sections of prerecorded video to a network drive. The DX8100 allows you to map to or disconnect from a network drive. In this 
case, you must use the IP address of the target drive. The DX8100 allows you to use the host name of the target device. To do so, you must 
enable NetBIOS option in the Windows environment. You need to know what letters are already assigned to drives and the path to the folder you 
want to map.

This section describes how to map to and disconnect from a network drive, including the following topics:

• Mapping a Network Drive

• Disconnecting a Network Drive 

MAPPING A NETWORK DRIVE

To map a network drive: 

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode. Click . The Export Video dialog box opens.

3. Click Map NetDrv. The Map Network Drive dialog box opens asking for a drive letter and path.

4. In the Drive drop-down box, select a drive letter that is not being used.

5. Type the path in the Folder drop-down box. (For example, type \\IP_address_of_server\folder_name.)

WARNING: Improperly removing a USB drive can cause data to be lost or corrupted.
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6. (Optional) Click the “Reconnect at logon” box if you do not want the mapped drive to remain connected each time you logon. 

7. Click Finish. The newly mapped drive is added as a remote drive and is displayed in the Device area. The mapped drive can now be 
accessed just like a local drive.

Figure 81.  Export Video Dialog Box

DISCONNECTING A NETWORK DRIVE

To disconnect a network drive:

1. On the DX8100 toolbar, click . The DX8100 is in the Search mode.

2. Click . The Export Video dialog box opens.

3. Click Disconnect NetDrv. The Disconnect Network Drive dialog box opens.

4. Select the network drive that you want to disconnect.

5. Click OK. The drive is disconnected and removed from the Export Video dialog box Device area.
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PERFORMING THE EXPORT
This section describes how to export data and includes the following topics:

• Starting an Export Process

• Changing a Bookmarked Time Range

• Assigning a Custom Export Video File Name

• Selecting the Export Format

• Exporting a Sequence of Still Images

• Finalizing an Export Process

• Stopping an Export While in Process

• Working with DX8100 backed up Video

STARTING AN EXPORT PROCESS

To start the export process:

1. Make sure the DVR is in Playback or Search mode by clicking  or . 

2. Click  if you are in Live mode, or proceed to step 3 if you are in Search mode.

3. Click . The Export Video dialog box opens.

4. Click the plus (+) sign next to a drive in the Device list. Available devices are indicated by a check box to the left of the device name.

5. Select the check box of the desired device. If you choose a remote device, select the drive and folder path where you would like to store the 
exported file. You can also click the Browse button to access the file system for the appropriate folder. 

If your DX8100 is connected to a network that supports shared folders and drives, you can map a network drive from within the Export Video 
dialog box. For more information, refer to Mapping and Disconnecting a Network Drive.

The following table shows a listing of available devices.

6. Select the check box of the video time range you want to export. You can export multiple time ranges simultaneously. For more information, 
refer to Changing a Bookmarked Time Range.

7. Click in the File Name box, and then type the file name for each selected video time range. You can accept the default file name assigned 
to the time range. For more information, refer to Assigning a Custom Export Video File Name.

8. Select the export format. For more information, refer to Selecting the Export Format.

Table Y.  Available Backup Space

Type Description

Optical drives The DX8100 supports the following drives:

• CD-R

• DVD-R

Hard disk drives The hard disk drive can be any of the following:

• Local drives

• Remote drives

Removable drives USB flash drives
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9. Click Export. 

Figure 82.  Exporting Selected Video

CHANGING A BOOKMARKED TIME RANGE

To change a bookmarked time range or create a new time range to be exported:

1. Select the desired row in the Time Range table.

2. Double-click the Start Day field, and then use the spinner buttons to set the start date for the export.

The start days and times cannot be set later than end days and times.

3. Double-click the Start Time field, and then use the spinner buttons to set the start time for the export.

4. Double-click the End Day field, and then use the spinner buttons to set the end date for the export.

5. Double-click the End Time field, and then use the spinner buttons to set the end time for the export.
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6. Select the check box next to each time range you would like to export.

Figure 83.  Export Time Range

ASSIGNING A CUSTOM EXPORT VIDEO FILE NAME

By default, the DX8100 assigns a file name to each time range. When the video channel selected is exported, the file is assigned the name 
appearing in the Name column.

 

Figure 84.  Default File Names

The default filename is constructed from the information displayed in the Start Day, Start Time, End Day, and End Time columns. 

To assign a custom file name for a time range:

1. Verify that the check box of the row you want to rename is selected.

2. Enter a file name for the file you want to export. (Export file names follow standard Windows file-naming conventions.)

�� � � �
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3. Click Apply. The Apply button updates the Name field.

Figure 85.  Renaming Export Time Ranges

SELECTING THE EXPORT FORMAT

The DX8100 allows you to select the export format. The following table shows the available export formats.

• Native format: When exporting video in the native format, the DX8100 embeds a digital watermark in the video stream for the purpose of 
authentication. Watermarking ensures that an image has not been edited or damaged after it has been recorded. The watermark is an 
encrypted, digital signature embedded in the video stream during the compression stage, protecting the video from the moment of creation. 
The DX8100 Viewer software is capable of reading a DX8100 watermark and verifying the originality of the video.

• AVI or ASF format: Video exported in AVI or ASF format can be viewed using standard viewer software such as Windows Media Player. 
When exporting video in the native format to a CD or DVD device, the DX8100 will automatically include the DX8100 Viewer application 
along with the video. This viewer is designed to play a variety of still image, video, and audio media formats, including the native DX8100 
format. The DX8100 Viewer application will automatically run each time a CD or DVD created by the DX8100’s export feature is inserted 
into a Windows-based PC. To ensure that the viewer software runs automatically after the disk has been inserted, verify that the auto-run 
feature of your PC’s optical drive has not been disabled.

To select the export format:

• From the Export Video dialog box, select the radio button of the file format you want to export. 

Table Z.  Export Formats

Format Description

AVI Saves video sequence as a standard Windows video format.

ASF Saves video sequence as a standard Windows media file.

Native Saves video sequence using Pelco’s engineered compression format. Native format provides increased compression and smaller 
file sizes.

BMP Saves a still image file in standard Windows bitmap format. Only the first frame of the video sequence is saved.

JPEG Saves a still image file in JPEG format. Only the first frame of the video sequence is saved.

TIF Saves a still image file in TIF format. Only the first frame of the video sequence is saved
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EXPORTING A SEQUENCE OF STILL IMAGES

Still image formats export the first frame of a bookmarked region, and then a single frame for each time interval until the number of images 
specified has been exported. For example, consider exporting a six-hour bookmarked region of video with an image count of 100 and a time 
interval of 3 seconds. The resulting export will include the first frame of the bookmarked region followed by 99 additional images taken at three 
second intervals. The first exported image will be the first frame of the bookmarked region and the last image will be the frame taken at 
300 seconds into the bookmarked region.

To export a sequence of still images:

1. Select a still image format. Options are BMP, JPEG, and TIF.

2. Select the number of images (1-999) you want to save in the sequence.

3. Select the time interval between each saved image in the sequence. Options are as follows:

• Continuous
• 0.5 seconds
• 1 second
• 2 second
• 3 second
• 4 seconds
• 5 seconds

Figure 86.  Still Image Export Formats

FINALIZING AN EXPORT PROCESS

This section describes how to finalize an export process. The following guidelines are applicable:

• Audio export is available only with DX8100 native, AVI, and ASF video formats.

• Real Time setting applies only to DX8100 native, AVI, and ASF video formats.

• When the Real Time check box is selected, the DX8100 will export video so it can be played back in real time (30 fps) for the same length of 
time as the original recording. For example, if video was recorded at 1 fps, this means the DX8100 will insert 29 null frames for every 
one frame of actual video. Thus, one minute of video recorded at 1 fps (60 frames total) will play back for one minute at 30 frames per 
second (60 frames of actual video interspersed with 1,740 null frames). If the Real Time check box is not selected, one minute of video 
recorded at 1 fps will play back in two seconds in real time. Figure 87 illustrates the two video streams: 1) one padded with null frames to 
match the actual time duration and 2) another stream without null frames.

�
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Figure 87.  Real Time Versus Non-Real Time Export

To finalize the export process:

1. Make sure that the export media selected is inserted in the drive unit that the drive is ready. 

2. In the Time Range table, click selection box for each backed-up video time range you want to export.

3. In the Export Format section, do the following:

a. Click the Audio Record check box to include recorded audio.

b. Click the Real Time check box to export video using standard clock time. 

4. Click Export to export video data.

STOPPING AN EXPORT WHILE IN PROCESS

Once an export operation has begun, a user can easily stop it by interrupting or canceling the operation from the Export menu on the main or 
search screens. Interrupting an export simply stops the progress of the export while keeping all current video information intact. Canceling an 
export will delete any video data exported during the operation, as well as end the export itself.

This section describes how to stop an export process and includes the following topics:

• Retaining Video When Stopping an Export Process

• Deleting Video Data When Stopping an Export Process

Retaining Video When Stopping an Export Process

To halt an export that is in process while retaining current video data stored:

• From the DX8100 menu bar, choose Export > Interrupt Export.

Deleting Video Data When Stopping an Export Process

To halt an export that is in process and delete any current video data stored:

• From the DX8100 menu bar, choose Export > Cancel Export.

WORKING WITH DX8100 BACKED UP VIDEO

The DX8100 allows you to view, search, export, back up, and print backed up video. To do so, you must use the DX8100 Client application.

For more information about viewing backed up video, refer to Working With Backed Up Video On Client.
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Printing Images
The printing feature of the DX8100 produces a hard copy of the current on-screen image. A Windows-compatible printer must be installed to take 
advantage of the DX8100’s print feature. For information on installing a printer, refer to the installation manual that came with your unit.

The DVR must be placed in Playback or Search mode to use the print feature. Playback is paused once the print button is pressed. 

To print an image displayed in a pane:

1. Click  or .

2. Locate the video image you want to print. For more information on locating video, refer to Working in Playback Mode and Working in 
Search Mode.

3. Click .

4. Click  to freeze the image for printing.

5. Click .

6. Click OK.

PRINTING IMAGES IN THE DEINTERLACED MODE
If you are printing images recorded at 4CIF at a low frame rate per second, the viewed image might move or tear. The View menu’s Deinterlaced 
Image option is used to enhance the image for printing. 

To print an image using the deinterlaced option:

1. Click  or .

2. Locate the video image you want to print. Refer to Working in Playback Mode and Working in Search Mode for information on locating 
video.

3. Click .

4. Click  to freeze the image for printing.

5. Click  to print the image to a designated printer.
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Setting Up the DX8100
Only a single user with Administrator or Power User access is allowed to access a DX8100’s Setup mode at one time. When connected to a 
network supporting multiple DVRs and/or clients, users with Administrator access override and block Power Users. If two users with the same 
access level attempt to enter Setup mode simultaneously, the DX8100 will allow access to setup features on a first-come, first-served basis. 
Unavailable setup options will be grayed out.

This section describes the Setup Mode and includes the following topics:

• Accessing the Setup Mode

• Understanding the Setup Dialog Box

• Camera Setup

• Link Setup 

• Schedule Setup 

• Setting Up Network Properties 

• Data Backup Setup

• User Setup 

• Site Setup 

• System Setup 

• External Monitor Setup 

• Emergency Notification Setup 

• Emergency E-Mail Notification Setup 

ACCESSING THE SETUP MODE
The Setup Mode is accessed from the DX8100 toolbar by clicking the Setup icon. When clicked, the Setup icon opens the Setup dialog box in the 
DX8100 view panel. Major configuration categories are displayed on individual tabbed pages. Each configuration page contains all of the options 
and parameters for the respective functions, which allows you to customize how the DX8100 operates for your particular application. To access 
a setup page, click the icon displayed on the right side of the view panel.

The Setup dialog box allows Administrators and Power Users access to the DX8100’s setup functions. However, only Administrators can define 
user names and passwords for new users.

To access the Setup Mode:

• On the DX8100 toolbar, click Setup.

The Setup dialog box opens to the default Camera page.
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UNDERSTANDING THE SETUP DIALOG BOX
The Setup dialog box opens in the DX8100 view panel to the default Camera page. Excluding the video visible through the Camera page Motion 
Zone window, you cannot see video from any of the other setup pages. You must exit the Setup dialog box to access the DX8100 functions in the 
main window.

The following figure shows the parts of the Setup dialog box.

Figure 88.  Parts of the DX8100 Setup Dialog Box

The following table describes the parts of the Setup dialog box.

Table AA.  Parts of the DX8100 Setup Dialog Box

Item Button Part Description

Camera Click the Camera icon to configure cameras. Available options are PTZ functions, motion detection, 
picture adjustment, audio, and video loss detection settings.

 

Linking Click the Linking icon to configure relays and alarms, associate relays and alarms with cameras, link 
relays to alarms, and link cameras to other cameras.

Schedule Click the Schedule icon to build custom recording schedules, set image resolution, frame rate, and 
image quality, and configure relay settings. 

Network Click the Network icon to set up the network configuration and communication port settings.

Backup Click the Backup icon to configure and perform backups.

User Click the User icon to add, delete, or change user accounts.

Site Click the Site Setup icon to add, delete, and configure additional DX8100 Series DVRs.

System Click the System icon to set up additional system options.

Ext. Monitor Click the Ext. Monitor icon to configure an additional display monitor. (This icon appears only if the 
optional display card has been installed.)

Notification Click the Notification icon to configure emergency agent and e-mail notification options.
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CAMERA SETUP
Depending on your system’s current configuration, up to 32 video cameras can be connected to a single DX8100. The following section illustrates 
basic camera configuration. You must be logged in as an Administrator or Power User to configure cameras.

This section describes how to setup the camera and includes the following topics: 

• Basic Camera Setup 

• Motion Detection Setup 

• Audio Setup 

• Applying Settings to all Cameras 

BASIC CAMERA SETUP

To set up camera picture and PTZ options:

1. Do one of the following:

• On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

• If the Setup dialog box is already open, click . The Camera page is displayed.

2. In the Camera Properties section, do the following:

a. Select a camera from the drop-down box. (You can also select a camera from the Site tree by clicking on it.)

b. Select the Disable check box if you want to disable the camera.

c. Enter an optional new name for the camera. Camera names can be up to 32 characters long and can include spaces and special 
characters.

d. Set camera security level. The default security levels are as follows:

• None: The camera can be viewed by all users.
• Low: The camera can be viewed by all users except the Guest account.
• Medium: The camera can be viewed by users with Standard User access and higher.
• High: The camera can be viewed by users with Power User access and higher.

e. In the Protocol drop-down box, select the appropriate PTZ protocol for the camera, or select No PTZ if the selected camera does not 
support PTZ functions. Some of the supported protocol options are as follows:

• NO PTZ: Disables all PTZ functions for the current camera 

• PELCO-C: Coaxitron
• PELCO-D: Pelco engineered
• PELCO-P: Pelco engineered

• SAMSUNG™ (V2.0)

• PANASONIC®

• KALATEL™

• Honeywell™ (HSD251)

• American Dynamics™

• Philips® (TC8560, TC700 Series)

• LG® (v1.0)

You must configure one of the RS-422/RS-485 PTZ ports for Spectra for Coaxitron to function. For more information, refer to the 
DX8100 server Operations and Programming manual.

f. Do the following:

(1) In the PTZ Locking Auto-timeout drop-down box, select an appropriate timeout value. Timeout values can be set between five 
and 60 seconds. The default value is 10 seconds.

Because the DX8100 Series DVR is designed to operate in a networked environment, it is possible that multiple users may 
attempt to simultaneously control the PTZ features of a single camera. To minimize potential conflicts, only one user at a time is 
allowed to control the PTZ features of a camera. PTZ control is made available on a first-come, first-served basis. Once a user 
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gains control of a camera’s PTZ features, all other users are locked out. All other users must wait until the controls for that 
device have been left idle for the amount of time configured for that camera, as specified in the PTZ Locking Auto-timeout drop-
down box.

(2) To perform a PTZ test, click Pan-L (left), Pan-R (right), Tilt-U (up), and Tilt-D (down), to verify that the camera responds to PTZ 
commands.

g. Set the selected camera address as follows:

(1) In the Dip Switch Address drop-down box, select an address from the available addresses. If the selected camera’s protocol is 
set to NO PTZ or PELCO-C, the DIP Switch Address drop-down box is unavailable. In this case, the camera’s dip switch setting 
cannot be set using software. 

This option is available for cameras and protocols that support software-configurable addresses. Only one address can be 
assigned per camera. The DX8100 displays an error message if you attempt to assign the same address to different cameras. 

(2) To view the camera DIP switch address setting for all attached local cameras, click View. The DIP Switch Address View dialog 
box opens. The assigned DIP switch setting for all attached cameras is displayed.

3. In the Picture Adjustment section, adjust picture properties by moving sliders for Brightness, Contrast, Hue, and Saturation.

As you adjust the picture properties of a camera on the local DVR, changes will be reflected immediately in the view area near the top of 
the screen. Changes made to cameras at a remote site will not appear in the view area until you click Apply.

4. Click Default to return all picture property settings to the normal state.

You can click the Hide/Show button to clear the view area to get a better look at your picture property changes. Refer to step 2 in Motion 
Detection Setup.

5. Click Apply. 

Figure 89.  Camera Page
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MOTION DETECTION SETUP

Up to five motion detection profiles can be defined for each camera. When the DX8100 is set to record motion detection, any motion sensed in 
the selected zone will be recorded on that channel. Motion detection can also be used to trigger relays, PTZ presets, and the recording of 
multiple cameras. Refer to Schedule Setup and Link Setup for more information. 

To define motion detection profiles for the selected camera:

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

2. To set up the motion grid, do the following:

a. Select the motion zone (1-5) from the drop-down box.

b. Click the Hide/Show button to either hide or display the motion grid. 

c. Move the Number of Blocks slider to change the grid size of the motion overlay.

3. Define the area for motion detection as follows:

a. Click Clear All to remove the currently defined motion detection area.

b. Click Select All to enable motion detection for the entire viewable area.

c. Hold down the left mouse button and drag to select areas.

d. Hold down the right mouse button and drag to deselect areas.

4. In the Motion Detection section, move the Sensitivity slider to adjust motion sensitivity. Moving the slider to the left decreases the 
sensitivity; moving the slider to the right increases the sensitivity. The motion sensitivity window provides a visual indicator that helps you 
set the sensitivity to the correct level, so that erroneous motion events caused by wind or other disturbances are avoided.

• Figure 90 shows the position of the red sensitivity indicator at a low sensitivity setting. In this case, a large motion level is needed to 
cause the green motion indicator to exceed the red sensitivity indicator. 

Figure 90.  Low Sensitivity Level

• Figure 91 shows the position of the red sensitivity indicator at a high sensitivity setting. In this case, a low motion level will cause the 
green motion indicator to surpass the red sensitivity indicator.

Figure 91.  High Sensitivity Setting Level

• Figure 92 shows the position of the red sensitivity indicator at a medium 50% sensitivity setting (default). In this case, a motion event 
is large enough to cause the green motion indicator to surpassed the red sensitivity indicator.

Figure 92.  Adequate Sensitivity Level
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5. Click Apply.

Figure 93.  Camera Motion Detection Setup

AUDIO SETUP

The DX8100 supports two audio configurations: standard audio and optional expanded audio. Both of these configurations allow you to configure 
individual camera channels to listen to and record live audio. You can monitor live audio at a local server or listen to live audio from a remote 
DX8100 server or client system. You can play back audio recorded by a camera channel. 

• Standard audio input: The DX8100 provides two standard audio inputs: Line In (stereo), Mic In (mono), and one audio output. The standard 
audio inputs are available by default if the optional audio option card is not installed. If the optional audio card is installed, the standard 
audio inputs are disabled. 

The standard audio connections are described as follows:

– Line In (stereo): A 2-channel stereo input (left and right channel) allows you to connect up to two external audio sources. You can 
assign a specific camera to record video in association with each audio channel. For example, you can assign camera 2 to the left audio 
channel and camera 32 to the right audio channel. 

– Mic In: Accepts one audio input. You can assign one camera to record video in association with the audio input.
– Audio output: Allows you to connect an audio output device, such as an amplifier, to listen to recorded video and audio 

simultaneously.

• Optional expanded audio input: To use the DX8100 expanded audio feature, the optional DX8100-AUD audio card must be installed. You 
can determine if the audio card is installed by checking the Audio option status in the Channel Information section of the Camera page. The 
Audio status is one of the following:
– Not installed: If the optional audio card is not installed, the Advanced button in the Audio Settings area is available.
– Installed (enabled): If the optional audio card is installed, the Advanced button in the Audio Settings area is not available.

The DX8100 compresses audio data to save space. In this case, recorded audio that may not be of the same quality as live audio. Consult your 
Pelco sales representative for more information regarding the DX8100-AUD option.
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This sections describes how to setup the audio feature and is organized into the following sections:

• Setting Up the Standard Audio Options

• Setting Up the Expanded Audio Options

• Listening to Live Audio

Setting Up the Standard Audio Options

By default, the DX8100 supports two standard audio inputs if the expanded audio card is not installed. If the expanded audio card is installed, the 
two standard audio inputs are disabled.

To set up the standard audio options:

1. Connect the audio input source to the DX8100. For information about connecting an audio source to the DX8100, refer to the DX8100 
Installation manual.

2. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

3. In the Channel Information area, verify that expanded audio option is not installed. This is indicated by the label Audio: Not Installed.

Figure 94.  Audio Option Not Installed

4. In the Audio Settings area, click Advanced >>. The AUX Audio Settings dialog box opens.

5. In the AUX Audio Settings dialog box, do the following:

a. Click to deselect the Audio Disable check box.

b. In the Input Device drop-down box, select Mic (single channel only) or “Line in” (two standard channels).

c. Click the Left Channel check box and in the drop-down box, select an associated camera.

d. Click the Right Channel check box and in the drop-down box, select an associated camera.

e. (Optional) Left-click the Aux volume control and drag left to decrease the audio input level or to the right to increase the audio input 
level.

f. Click OK.

g. Click Apply.

Figure 95.  AUX Audio Settings Dialog Box
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Setting Up the Expanded Audio Options

To set up the expanded audio option:

1. Do the following:

a. Install the optional DX8108-AUD/DX8116-AUD audio card (if necessary). For information about installing the optional 
DX8108-AUD/DX8116-AUD audio card, refer to the DX8100 8/16 Channel Audio Card Installation manual (C2638M).

b. Connect an audio input device (microphone) to the numbered DX8108-AUD/DX8116-AUD audio card input for the camera channel 
being configured for live audio recording.

c. To hear live audio at the local server, connect head phones to the DX8100 audio output connector.

2. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page. 

3. Check the Channel Information section to verify that the audio option is installed and available. 

4. In the Camera Properties section, select the camera channel you want to configure for live audio recording. 

5. In the Audio Settings section, verify that the Audio Disable check box is not selected.

6. Click Apply.

7. Verify that you can hear sound from the DX8100 audio output.

LISTENING TO LIVE AUDIO 

The DX8100 audio feature allows you to listen to live audio at a local server or listen to live audio from a remote DX8100 server or client system. 
For information about setting up the DX8100 server to record and listen to live audio, refer to Audio Setup.

This section describes how to listen to live audio and includes the following topics: 

• Listening to Live Audio at a Local Server

• Listening to Live Audio from a Remote DX8100 System

Listening to Live Audio at a Local Server

To listen to live audio at the local server:

1. Connect head phones to the DX8100 audio output connector. For information about setting up the DX8100 server to record and listen to live 
audio, refer to Audio Setup

2. On the DX8100 toolbar, click Setup. The Setup dialog box opens to the Camera page. 

3. Check the Channel Information section to verify that the audio option is installed and available. 

4. In the Camera Properties section, select the camera channel that is configured for live audio recording. 

5. In the Audio Settings section, verify that the Audio Disable check box is not selected.

6. Click Apply.

7. Verify that you can hear sound from the DX8100 audio output.

8. On the DX8100 toolbar, click .

9. Drag a camera that is configured to record live audio from the Site tree onto a view pane. 

10. Verify that you can hear live audio.
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Listening to Live Audio from a Remote DX8100 System

To listen to live audio at a remote DX8100 server or client system:

1. On the DX8100 toolbar, click Setup. The Setup dialog box opens to the Camera page. 

2. Check the Channel Information section to verify that the audio option is installed and available. For information about setting up the 
DX8100 server to record and listen to live audio, refer to Audio Setup

3. In the Camera Properties section, select the camera channel that is configured for live audio recording. 

4. In the Audio Settings section, verify that the Audio Disable check box is not selected.

5. Click Apply.

6. Verify that you can hear live audio. 

7. On the DX8100 toolbar, click .

8. Drag a camera that is configured to record live audio from the Site tree onto a view pane. 

9. Verify that you can hear live audio.

CONFIGURING VIDEO LOSS DETECTION

You can configure the DX8100 to monitor each camera for the following events:

• Loss of synchronization: This event occurs if the data cable between the camera and DX8100 is disconnected (cable is cut or unplugged) 
or when the camera looses power.

• Low level of video: This event occurs if the DX8100 detects a low level of video signal from the camera:
– The available light source for the camera (indoor/outdoor lightly) is greatly diminished. 
– The DX8100 data cable is disconnected.

You can adjust the operation time from 0:00 to 23:59. For example, if the start time is 6:00 and the end time is 18:00, a low video level 
event from 18:01 to 5:59 will not be detected. The low video level detection time option is only available when the low level of video option 
is selected.

The DX8100 also stores a video incident as a video loss recovery event. The status provides the start and restore time for the video loss event.

The DX8100 allows you to select the loss of synchronization and low level of video option independently. 

• The PTZ camera and multiple relay output can be mapped to a video loss event. 

• Multiple cameras can be configured to record in response to a video loss event.

• The DX8100 can be configured to use emergency agent notification. In this case, the last available video image at the time the event 
occurred is sent to the designated remote client. If no image exist, then the system attaches a red colored pane to the e-mail. The red pane 
contains the text “Video Loss.” For information about setting up emergency notification, refer to Emergency Notification Setup.

• The DX8100 can be configured to send an e-mail notification in response to a video loss event. In this case, the last available video image 
at the time the event occurred is attached to the e-mail. If no image exist, then the system attaches a red colored pane to the e-mail. The 
red pane contains the text “Video Loss.” For information about setting up emergency notification, refer to Emergency E-Mail Notification 
Setup.

• The record icon turns purple indicating a video loss recording, regardless of the schedule. The video loss utility is constantly running in the 
background. If a schedule is not available, the record icon defaults to purple. If the DX8100 loses feed, video on that channel is recorded. 
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To set up video loss detection:

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

2. In the Video Loss Detection section, do one or both of the following:

• Click the “Loss of synchronization” check box.
• Click the “Low level of video” check box.
• In the Low Level of Video Detection Operation Time section, set the Start Time and the End Time.

3. Click Apply.

Figure 96.  Video Loss Detection

APPLYING SETTINGS TO ALL CAMERAS

If you want to keep the changes you made to options and parameters on the Camera page, you must click Apply. If you attempt to leave the 
Camera page, the system will display a message box, prompting you to apply, not apply, or cancel the changes.

To apply camera configuration options to all attached cameras:

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

2. Perform the camera configuration.

3. In the Apply to All Cameras section, select the check boxes for one or more of the settings you want to apply to all cameras: Protocol, 
Camera Security, Picture Adjustment, Motion Detection, Audio Settings, and Video Loss.

4. Click Apply to All Cameras.

5. Click Apply.

LINK SETUP
This section describes how to use the Link page to set up the following:

• Relay and alarm settings

• Event-relay link settings

• Event-recording link settings

• Event-PTZ link settings

This section includes the following topics:

• Configuring Basic Relay and Alarm Settings 

• Linking Relay Outputs to External Events 

• Linking PTZ Presets and Patterns to External Events 

• Linking Cameras to Record in Response to External Events 
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CONFIGURING BASIC RELAY AND ALARM SETTINGS

The DX8100 can support up to 32 alarm inputs and 24 relay outputs. Eight-channel DVRs include 8 alarm and 8 relay terminals, while sixteen-
channel DVRs include 16 of each. 

This section describes how to configure basic relay and alarm settings, including the following topics:

• Understanding How Relays and Alarms React to a Power Outage

• Configuring DX8100 Basic Relay and Alarm Settings 

• Configuring Basic Relay Operating Properties 

• Configuring Basic Alarm Input Operating Properties

Understanding How Relays and Alarms React to a Power Outage

The DX8100 server might experience an external AC power outage that impacts how the relay and alarm features function.

• Power outage: Relays configured as NO are closed if the DX8100 is server is shut down by a power outage, or the AC cord is unplugged. 

• Power button: Relays configured as NO are closed if the DX8100 power button is pressed and held down. 

In the scenarios above, a relay will remain closed as long as the DX8100 is powered down. In this case, alarms or sirens connected to the relays 
might produce a false alert. 

Configuring DX8100 Basic Relay and Alarm Settings

To access the Link page to program alarms and relays:

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera setup page.

2. Click . The Link page is displayed. 

Configuring Basic Relay Operating Properties

To configure basic relay operating properties:

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

2. Click  to display the Link page. 

3. In the Relay Settings section, do the following:

a. In the Relay Channel drop-down box, select the relay you want to configure.

b. In the Relay Name text box, enter an optional new name for the relay. Relay names can be up to 32 characters long and can include 
spaces and special characters.

You can also rename sites, cameras, alarms, and relays from the Site tree by slowly clicking twice on each object’s name.

c. In the Relay Type section, click the NO/NC button to toggle the default output type for each relay (NO, normally open or NC, normally 
closed).

4. Click Apply.

Figure 97.  Relay and Alarm Settings Page: Relay Settings Section
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Configuring Basic Alarm Input Operating Properties

Most applications will not require you to change relay and alarm settings from their default states.

To configure basic alarm input operating properties:

1. On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

2. Click  to display the Link page.

3. In the Alarm Settings section, do the following:

a. In the Alarm Channel drop-down box, select the Alarm you want to configure.

b. In the Alarm Name text box, enter an optional new name for alarm. Alarm names can be up to 32 characters long and can include 
spaces and special characters.

You can also rename sites, cameras, alarms, and relays from the Site tree by slowly clicking twice on each object’s name.

c. In the Alarm Type section, click the NO/NC button to toggle the default output type for each alarm (NO, normally open or NC, normally 
closed).

4. Click Apply.

Figure 98.  Relay and Alarm Settings Page: Alarm Settings Section

LINKING RELAY OUTPUTS TO EXTERNAL EVENTS

This section describes how to link relay outputs to external events, such as motion, alarm, ATM/POS, and video loss events. The following topics 
are included:

• Linking Relay Outputs to Motion Events 

• Linking Relay Outputs to Alarm Events

• Linking Relay Outputs to ATM/POS Events

• Linking Relay Outputs to Video Loss Events

To access the Event-Relay Link Settings page:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page opens to the Relay and Alarm Settings page.

3. Click the Event-Relay Link Settings tab.

Linking Relay Outputs to Motion Events

To set relay outputs to activate in response to motion detection events:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .
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3. Click the Event-Relay Link Settings tab.

4. In the Motion Detection Link Settings section, do the following:

a. Select a camera channel from the Camera Channel drop-down box.

b. Click the button for each relay you want to link to the selected camera.

You can also drag relays onto cameras in the Site tree while in Live mode (main screen).

5. Click Apply.

Figure 99.  Event-Relay Link Settings: Motion Detection Link Settings Section

Linking Relay Outputs to Alarm Events

To set relay outputs to activate in response to an alarm event:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.

4. In the Alarm Link Settings section, do the following:

a. Select an alarm channel from the Alarm Channel drop-down box.

b. Click the button for each relay you want to link to the selected alarm.

You can also drag relays onto alarms in the Site tree while in Live mode (main screen).

5. Click Apply.

Figure 100.  Event-Relay Link Settings: Alarm Link Settings Section

Linking Relay Outputs to ATM/POS Events

To set relay outputs to activate in response to an ATM/POS event:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.
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4. In the ATM/POS Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS Address drop-down box.

b. Click the button for each relay you want to link to the selected ATM/POS address.

You can also drag relays onto ATM/POS devices in the Site tree while in Live mode (main screen).

5. Click Apply.

Figure 101.  Event-Relay Link Settings: ATM/POS Link Settings Section

Linking Relay Outputs to Video Loss Events

To set relay outputs to activate in response to a video loss event:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click .

3. Click the Event-Relay Link Settings tab.

4. In the Video-Loss Link Settings section, do the following:

a. Select a camera from the Video-Loss Channel drop-down box.

b. Click the button for each relay you want to link to the selected Video-Loss Channel. 

5. Click Apply.

Figure 102.  Event-Relay Link Settings: Video-Loss Link Settings Section

LINKING CAMERAS TO RECORD IN RESPONSE TO EXTERNAL EVENTS

Multiple cameras can be configured to begin recording in response to detected motion, alarm, ATM/POS transaction, and video loss events. 
This section describes how to link cameras to record in response to these events and includes the following topics:

• Linking Cameras to Record in Response to Motion Events 

• Linking Cameras to Record in Response to Alarm Events

• Linking Cameras to Record in Response to ATM/POS Events

• Linking Cameras to Record in Response to Video Loss Events 
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Linking Cameras to Record in Response to Motion Events

To link multiple cameras to record in response to motion detection events:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Motion Record Link Settings section, do the following:

a. Select a camera from the Motion Source Camera drop-down box.

b. Click the button for each camera you want to begin recording when motion is detected by the source camera.

5. Click Apply.

Figure 103.  Event-Relay Link Settings: Video-Loss Link Settings Section

Linking Cameras to Record in Response to Alarm Events

To link multiple cameras to record in response to a single alarm input:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Alarm Record Link Settings section, do the following:

a. Select an Alarm channel from the Alarm Channel drop-down box.

b. Click the button for each camera you want to begin recording when the source alarm is triggered.

5. Click Apply.

Figure 104.  Event-Recording Link Settings: Alarm Record Link Settings Section

Linking Cameras to Record in Response to ATM/POS Events

To link multiple cameras to record in response to an ATM/POS event:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.
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3. Click the Event-Recording Link Settings tab.

4. In the ATM/POS Record Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS address drop-down box.

b. Click the button for each camera you want to begin recording in response to an ATM/POS event. 

5. Click Apply.

Figure 105.  Event-Recording Link Settings: ATM/POS Record Link Settings Section

Linking Cameras to Record in Response to Video Loss Events

To link multiple cameras to record in response to a video loss event:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-Recording Link Settings tab.

4. In the Video-Loss Record Link Settings section, do the following:

a. Select a camera from the Video-Loss Channel drop-down box.

b. Click the button for each camera you want to begin recording in response to a video loss event. 

5. Click Apply.

Figure 106.  Event-Recording Link Settings: Video-Loss Record Link Settings Section

LINKING PTZ PRESETS AND PATTERNS TO EXTERNAL EVENTS

The DX8100 can be configured in such a way that motion, alarms, ATM/POS transactions, and video loss events detected by one camera will 
result in the repositioning of another. Similarly, alarm inputs can be set to trigger camera-positioning presets. Only a single preset or pattern can 
be linked to a camera.

This section describes how to link PTZ presets and patterns to motion and alarm events, including the following topics:

• Linking PTZ Presets and Patterns to Motion Events

• Linking PTZ Presets and Patterns to Alarm Events 

• Linking Presets and Patterns to ATM/POS Events

• Linking Presets and Patterns to Video Loss Events 
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Linking PTZ Presets and Patterns to Motion Events

To link two cameras so that motion detected on one results in the repositioning of another:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Motion Detection Link Settings section, do the following:

a. Select a camera from the Camera Channel drop-down box. (This camera will be the motion source.)

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to motion detected by the source camera.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do one of the following: 

• To force the linked camera to move to a PTZ preset in response to motion detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150).

• To force a PTZ pattern to be activated in response to motion detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 107.  Event-PTZ Link Settings: Linking Presets and Patterns to Motion Events

Linking PTZ Presets and Patterns to Alarm Events

To link an alarm input to a camera so activation of the alarm results in a repositioning of that camera:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Alarm Record Link Settings section, do the following:

a. Select an alarm from the Alarm Channel drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to an alarm input detected by the source alarm.)
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5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do one of the following: 

• To force the linked camera to move to a PTZ preset in response to an alarm input detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150).

• To force a PTZ pattern to be activated in response to alarm input detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 108.  Event-PTZ Link Settings: Linking Presets and Patterns to Alarm Events

Linking Presets and Patterns to ATM/POS Events

To link an ATM/POS input to a camera so the detected ATM/POS event results in a repositioning of that camera:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the ATM/POS Link Settings section, do the following:

a. Select an ATM/POS address from the ATM/POS Address drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to an ATM/POS input detected by the source ATM/POS device.)

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do one of the following: 

• To force the linked camera to move to a PTZ preset in response to an ATM/POS input detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150).

• To force a PTZ pattern to be activated in response to ATM/POS input detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.
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6. Click Apply.

Figure 109.  Event-PTZ Link Settings: Linking Presets and Patterns to ATM/POS Events

Linking Presets and Patterns to Video Loss Events

To link a video loss event to a camera so the detected video loss event results in a repositioning of that camera:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Linking page is displayed.

3. Click the Event-PTZ Link Settings tab. 

4. In the Video-Loss Link Settings section, do the following:

a. Select a camera channel from the Video-Loss Channel drop-down box.

b. In the Linked PTZ Setting section, select a camera to be linked from the Linked Camera Channel drop-down box. (This camera will 
change PTZ position in response to a video loss event detected by the source camera.

5. To select a PTZ preset or pattern for the linked camera, in the Linked PTZ Setting section, do the one of the following: 

• To force the linked camera to move to a PTZ preset in response to a video loss event detected by the source camera:
(1) Click the Linked Camera Preset button to select this option.

(2) In the Preset drop-down box, select a PTZ preset (1-150) for the camera to move to.

• To force a PTZ pattern to be activated in response to video loss input detected by the source camera:
(1) Click the Linked Camera Pattern button to select this option.

(2) In the Pattern drop-down box, select a PTZ pattern (1-4) to be activated on the camera.

The selected camera must support PTZ functions, and at least one PTZ preset/pattern must be defined for this function to work.

6. Click Apply.

Figure 110.  Event-PTZ Link Settings: Linking Presets and Patterns to Video Loss Events
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SCHEDULE SETUP
The DX8100 provides extensive scheduling capabilities. Flexible recording schedules can be established for daily, weekday, weekend, or 
individual day recording. Recording time can be broken up into increments of one-half hour, and each increment can be scheduled to record 
continuously or in response to an alarm, motion, or ATM/POS event. Users with Power User access and higher can create recording schedules.

This section describes how to setup recording schedules and includes the following topics:

• Accessing the Schedule 

• Setting Up the Camera Recording Mode 

• Creating Yearly Recording Schedules 

• Creating Monthly or Multiple-Day Recording Schedules 

• Creating Single-Day Schedules

• Editing Schedules 

• Working with Custom Camera Settings 

• Configuring the Frame Rate 

• Setting Up Advanced Relay Output 

ACCESSING THE SCHEDULE

To access the scheduling features of the DX8100:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

The following figure shows the Schedule page.

Figure 111.  Schedule Page
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The following table describes the parts of the Schedule page.

SETTING UP THE CAMERA RECORDING MODE

The DX8100 allows you to schedule each camera to record in a single or multiple-event mode across a 24-hour timeline. Users with Power User 
access or higher can schedule video recording for one or more cameras. Use the Record Mode section near the bottom of the Schedule page to 
configure the recording mode for each camera. 

This section describes how to schedule a recording mode and includes the following topics:

• Scheduling a Record Mode

• Clearing a Scheduled Recording

Scheduling a Record Mode

The DX8100 allows you to schedule a camera for multiple event recording. In this case, pre-event (motion, alarm, or ATM/POS) recording is set at 
the frame rate of the active record mode when the alarm, motion, or ATM/POS event occurred. For example, if the DX8100 DVR is recording at 

Table AB.  Parts of the Schedule Page

Item Part Description

Schedule Type 
Drop-down Box

Selects the type of schedule. Options are as follows:

• All days; Seven days a week

• Weekdays; Monday through Friday, with the exception of any day assigned in Custom mode

• Weekends; Saturday and Sunday, with the exception of any day assigned in Custom mode

• Custom Mode; Any day, such as a holiday

Recording 
Schedule 
Profile 

Allows you to do the following:

• Select and apply an existing schedule profile.

• Create and save a new profile.

• Change an existing profile.

• Delete an existing profile. 

Calendar Displays current schedule profile in accordance with the schedule type selected (All Days, Weekdays, 
Weekends, or Custom Mode).

Start and End 
Date Markers

Sets the start and end dates for a custom schedule.

Record Mode Selects a recording mode to be applied to a camera. Options are as follows:

• Normal

• Motion 

• Alarm

• ATM/POS

Channel 
Scheduling 
Panel 

Allows the assignment of recording modes across individual camera channels over a 24-hour period.

Camera 
Settings Panel

Allows custom settings to be applied to individual cameras for each recording mode.

Apply Saves current schedule.

Frame Rate 
Configuration 

Allows configuration of channel resolution and frame rates.

Configure 
Relays Allows configuration of relays that have been linked to cameras and alarms. 

Instant 
Recording Enables or disables selection of instant recording from the View menu.
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1 ips in the Normal record mode when an alarm event occurs, video is recorded at 1 ips during the pre-event time period. After the pre-event time 
period expires, the recording rate switches to the frame rate configured for the event. 

To schedule a record mode for one or more channels:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the check box for the record mode you want to apply to a channel.

• Normal 
• Motion
• Alarm
• ATM/POS

The following table describes the record modes.

4. Click and drag the mouse to highlight the time periods and channels where you want the recording mode to apply.

Drag the mouse diagonally to highlight periods across multiple camera channels simultaneously.

5. Click Apply.

Figure 112.  Filling In Recording Blocks in a Schedule Grid

Clearing a Scheduled Recording

The DX8100 Schedule feature allows you to do the following:

• For one or multiple channels, clear the scheduled recording times for a specific record mode. You can select one channel or you can drag 
and select a group of channels. For example, you can select and drag the recording times for channel 1-32. However, the system does not 
allow you to select random channels from the list. For example, you are not allowed to select channel 1, 2, and 4 (excluding camera 3).

• For one or multiple channels, you can clear the scheduled recording times for all record modes simultaneously. 

• You can select and clear recording times periods in increments of 30 minutes to 24 hours.

This section describes how to clear a scheduled recording and includes the following sections:

• Clearing Recording Times for a Specific Record Mode

• Clearing Recording Times for All Record Modes

Table AC.  Record Modes

Mode Color Description

Normal Green Continuous recording. 

Motion Blue Recording is triggered during the selected time block if a motion event is detected in the camera’s predefined 
motion field. For information on motion detection, refer to Motion Detection Setup.

Alarm Red Recording is triggered during the selected time block when an alarm is activated. At least one alarm must be 
linked to the camera for this option to work. For information on alarms, refer to Linking Alarm Inputs to a 
Camera.

ATM/
POS

Yellow Recording is triggered during the selected time block if an ATM or POS event is detected in the camera’s 
predefined ATM/POS field. For information on ATM/POS detection, refer to Linking Cameras to Record in 
Response to ATM/POS Events.

�
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Clearing Recording Times for a Specific Record Mode

To clear the scheduled recording times for a specific record mode for one or more channels:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click a record mode check box to select the specific record mode.

4. Right-click and drag to highlight the time periods and channels for which you want to clear recording times.

5. Release the right mouse button. The highlighted recording times are cleared. 

6. Do one of the following:

• To accept the change, click Apply. The selected time period is deleted.
• To cancel the change, click Cancel. The deleted recording times are restored.

Figure 113.  Clearing Recording Times for a Specific Record Mode

Clearing Recording Times for All Record Modes

To clear the scheduled recording times for all record modes:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click a record mode check box to deselect the record mode. No record mode is selected.

4. Right-click and drag to highlight the time periods and channels for which you want to clear recording times.

5. Release the right mouse button. The highlighted recording times are cleared.

6. Do one of the following:

• To accept the change, click Apply. The selected time period is deleted.
• To cancel the change, click Cancel. The deleted recording times are restored.

Figure 114.  Clearing Recording Times for All Record Modes
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CREATING YEARLY RECORDING SCHEDULES

The DX8100 allows you create and save various recording schedules. This section describes how to create yearly recording schedules and 
includes the following sections:

• Creating a Yearly Recording Schedule 

• Scheduling Individual Days Using the Year View 

• Copying Schedule Attributes to a Different Day

Creating a Yearly Recording Schedule

Year View allows a user to customize recording schedules for individual days. Year View displays daily recording schedules in a calendar format. 
The calendar displays one year’s worth of daily recording schedules. The scheduling period begins in the current month.

• Days circled in red have been assigned weekday, weekend, or everyday recording schedules.

• Days circled in blue have been assigned a custom recording schedule.

• Days without circles denote that no recording has been scheduled for that day.

Scheduling Individual Days Using the Year View

To schedule individual days using the Year View:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Year View tab. The Year View page is displayed.

4. Click the day you want to schedule.

Figure 115.  Calendar Date Selection

5. Using your mouse, select the recording modes and times for each channel you want to schedule. For information on selecting a recording 
mode, refer to Setting Up the Camera Recording Mode.

6. Repeat steps 2 and 3 for each additional day you want to schedule.

7. Click Apply.

Copying Schedule Attributes to a Different Day

To copy the schedule attributes of one day and apply them to a different day:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Right-click the calendar day you want to copy.
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4. Select Copy from the quick-menu.

Figure 116.  Year View Calendar Quick-Menu

5. Right-click the day on the calendar you want to apply the copied schedule attributes.

6. Select Paste from the quick-menu.

7. Click Apply.

To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the quick-menu.

CREATING MONTHLY OR MULTIPLE-DAY RECORDING SCHEDULES

Unlike schedules set in the Year View, Month View schedules are recurrent. Schedules can be set for subsequent weekdays, weekends, 
everyday, or a single day. 

This section describes how to create a monthly or multiple-day schedule and includes the following topics:

• Creating Multiple-Day Schedules

• Creating Single-Day Schedules

Creating Multiple-Day Schedules

To create a recording schedule to recur indefinitely:

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. Select All days, Weekday, or Weekends from the drop-down box.

5. Click New. The New File Name dialog box opens.

6. In the New File Name text box, enter a new filename for the profile. 

The profile file name follows the standard Windows file-naming conventions.

7. Click OK.

8. Using your mouse, select the recording modes and times for each camera you want to schedule. For information on camera scheduling, 
refer to Setting Up the Camera Recording Mode.

9. Click Save.

10. Click Apply.
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11. Click the Apply button at the bottom of the Schedule page.

Figure 117.  Month View Page: Multi-Day Schedule

Creating Single-Day Schedules

This section describes how to create a single-day schedule and includes the following topics:

• Working with Single-Day Schedules 

• Copying and Applying Schedule Attributes

Working with Single-Day Schedules

Custom Mode schedules are defined for single days only. A custom-scheduled day can be set to recur on the same day of every month or the 
same day every year.

To set the DVR to record on a specific day: 

1. From the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab (if it is not currently selected.)

4. Select Custom Mode from the drop-down box.

5. Click New. The New File Name dialog box opens.

6. Enter a new file name for the profile.

The profile file name follows the standard Windows file-naming conventions.

7. Click OK.

8. Select Once Per Month or Once Per Year.

9. Select the date range for the custom schedule.

a.  Set the start date with the Start spinner buttons.

The start date cannot be set later than the end date.

b. If you want the schedule to recur indefinitely, deselect the Finish on End Date check box.

c. Set the end date with the End spinner buttons.

10. On the calendar, click the desired date.

�
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11. Select the recording modes and times for each camera you want to schedule. Refer to Setting Up the Camera Recording Mode for 
instructions.

12. Click Save.

13. Click Apply.

14. Click the Apply button at the bottom of the screen.

Figure 118.  Month View Page: Single-Day Schedule

Copying and Applying Schedule Attributes

To copy the schedule attributes of one day and apply them to a different day:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Right-click the calendar day you want to copy.
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4. Select Copy from the quick-menu.

Figure 119.  Month View Calendar Quick-Menu

5. Right-click on the calendar day to which you want to apply the copied schedule attributes.

6. Select Paste from the quick-menu.

7. Click the Apply button at the bottom of the screen.

To change a custom schedule day to a regular schedule day, right-click and select “Revert to daily schedule” from the quick-menu.

EDITING SCHEDULES

This section describes how to edit a schedule to change its profile or delete a schedule. The following topis are included:

• Changing an Existing Schedule Profile 

• Deleting an Existing Schedule Profile

Changing an Existing Schedule Profile

To change a profile:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. In the drop-down box, select the type of schedule you want to change. Options are as follows:

• All Days
• Weekdays
• Weekends
• Custom Mode

5. Select the schedule profile from the drop-down box.

6. Using your mouse, assign new recording modes and times for each camera you want to schedule. Refer to Setting Up the Camera 
Recording Mode for instructions.

7. Click Save.

8. Click Apply.
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9. Click the Apply button at the bottom of the screen.

Figure 120.  Month View Page

Deleting an Existing Schedule Profile

To delete a schedule profile:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the Month View tab if it is not currently selected.

4. In the drop-down box, select the type of schedule you want to change. Options are as follows:

• All days 
• Weekdays
• Weekends
• Custom Mode

5. In the drop-down box, select a profile that is different from the one you want to delete. (This step is necessary because you cannot delete a 
schedule profile that is currently active.)

6. Click Apply.

7. In the drop-down box, select the profile you want to delete.

8. Click Delete.
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9. Click Apply.

Figure 121.  Month View Page

WORKING WITH CUSTOM CAMERA SETTINGS

This section describes how to configure customized camera settings and includes the following topics:

• Configuring Custom Camera Settings 

• Examples of Custom Camera Settings 

Configuring Custom Camera Settings

Each camera can be configured with custom recording settings. 

To customize camera settings for normal, motion, alarm, or ATM/POS recording:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Schedule page is displayed. 

3. Click the plus (+) sign next to a camera in the Site tree.

4. Select a recording mode from one of the following options:

• Normal
• Motion
• Alarm
• ATM/POS

5. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

6. Adjust the parameters in the camera settings section.

7. Click OK.
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8. Click Apply.

Figure 122.  Custom Camera Settings Panel

Examples of Custom Camera Settings

The DX8100 allows you to configure customized camera settings for the following recording modes:

• Normal

• Motion

• Alarm

• ATM/POS

The following figure shows camera settings for the supported modes.

Figure 123.  Examples of Custom Camera Settings
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The following table describes the settings for the supported modes.

Table AD.  Camera Settings for the Supported Recording Modes

Normal Motion Alarm ATM/POS

Image Resolution* Image Resolution* Image Resolution* Image Resolution*

Frame Rate* Frame Rate During Motion* Frame Rate During Alarm* Frame Rate During ATM/POS*

Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Pre-Motion Frame Rate Pre-Alarm Frame Rate Pre-ATM/POS Frame Rate

Pre-Motion Image 
Quality† (Best, High, 
Normal, Low, Lowest)

Pre-Alarm Image 
Quality† (Best, High, 
Normal, Low, Lowest)

Pre-ATM/POS Image 
Quality† (Best, High, 
Normal, Low, Lowest)

Motion Image Quality† 
(Best, High, Normal, 
Low, 
Lowest)

Alarm Image Quality† 
(Best, High, Normal, Low, 
Lowest)

ATM/POS Image Quality† 
(Best, High, Normal, 
Low, Lowest)

Pre-Motion (1-60 sec) Pre-Alarm (1-60 sec) Pre-Event (1-60 sec)

Post-Motion (1-180 sec) Post-Alarm (1-180 sec) Post-Event (1-180 sec)

*This field appears for information purposes only. To change this setting, refer to Configuring the Frame Rate.
†Image quality is a function of video compression. Higher quality video images require larger file sizes.
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CONFIGURING THE FRAME RATE

The DX8100 can record at frame rates up to 480 ips by National Television System Committee (NTSC) standards and 400 ips by Phase Alternating 
Line (PAL) standards. 

This total frame rate capacity is distributed among 8, 16, 24, or 32 cameras, depending on the configuration of your unit. Resolution and frame 
rate values can be assigned evenly among all cameras, or they can be configured independently for individual cameras. Frame rate values can 
also be customized according to recording mode type (normal, motion, alarm, or ATM/POS). 

Power Users and Administrators can configure recording frame rates on the DX8100. All cameras are optimized to provide 30 ips frame rates at 
320 x 240 resolution for NTSC (352 x 288 resolution for PAL). The DX8100 allows you to change the frame rates available to each camera, while 
resolution values must remain constant or change both frame rate and resolution settings. 

This section describes how to configure the frame rate and includes the following topics:

• Accessing the Frame Rate Configuration Dialog Box 

• Setting the Frame Rate 

• Setting the Resolution and Frame Rate

• Understanding the DX8100 Frame Rate Calculations

Accessing the Frame Rate Configuration Dialog Box

To access the Frame Rate Configuration dialog box:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

Setting the Frame Rate

The DX8100 Series DVR is optimized to provide 8, 16, 24, or 32 cameras of continuous video recording, with a frame rate of 30 ips at a resolution 
of 320 x 240 (NTSC) or 320 x 288 (PAL). The DX8100 allows you to change the frame rate independent of the resolution. For information on 
accessing the Frame Rate Configuration dialog box, refer to Accessing the Frame Rate Configuration Dialog Box.

To set the frame rate values for cameras: 

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens. 

4. Select the button for the recording mode you want to configure. Options are as follows:

• 604 
• 704
• Normal
• Motion
• Alarm
• ATM/POS

5. Do the following:

a. Using the ALL frame rate settings slider, set the frame rate for all channels. 

b. To set the frame rate for an individual channel, use the frame rate slider for that channel to select a frame rate from 1-30 ips 
(according to the available capacity for the channel). The frame rate of an individual channel is limited to the maximum setting of the 
ALL frame rate slider.

The frame rate ranges from 1-30 ips, depending on the DX8100 Series DVR configuration. The 8-camera DVR has 8 sliders, the 16-camera 
DVR has 16 sliders, the 24-camera DVR has 24 sliders, and the 32-camera DVR has 32 sliders.
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6. Repeat step 5b for each camera you want to configure.

7. Click OK.

8. Click Apply at the Schedule page.

Figure 124.  Frame Rate Configuration Dialog Box

Setting the Resolution and Frame Rate

Both resolution and frame rate settings can be adjusted using the Frame Rate Configuration dialog box. For information on accessing the Frame 
Rate Configuration dialog box, refer to Accessing the Frame Rate Configuration Dialog Box.

To set recording resolution and frame rates for each channel: 

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. In the Camera Settings section, click Frame Rate Configuration. The Frame Rate Configuration dialog box opens.

4. Select the button for the recording resolution and mode you want to configure. Options are as follows:

• 640
• 704
• Normal
• Motion
• Alarm
• ATM/POS

The 640 resolution setting is for the standard VGA format. The 704 resolution is for the cropped D1 video (NTSC, PAL).

5. Select resolution values for individual channels from the drop-down boxes. The following table describes the available resolution values.

Setting a resolution value for one recording mode sets the resolution value for all modes. For example, setting resolution to 640 x 480 in 
Motion recording mode will change the resolution to 640 x 480 in Normal and Alarm recording modes as well.

�
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6. Do the following:

a. Using the ALL frame rate settings slider, set the frame rate for all channels. 

b. To set the frame rate for individual channels, use the frame rate slider for each channel to select a frame rate from 1-30 ips (according 
to the available capacity for that channel). The frame rate of an individual channel cannot exceed the maximum setting of the ALL 
frame rate slider.

7. Click OK.

8. Click Apply when you return to the Schedule Setup screen.

Figure 125.  Frame Rate Configuration Screen

Table AE.  Resolution Values

Video Format
NTSC PAL

640 704 640 704

CIF 320 x 240 352 x 240 320 x 288 352 x 288

2CIF 640 x 240 704 x 240 640 x 288 704 x 288

4CIF 640 x 480 704 x 480 640 x 576 704 x 576
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Understanding DX8100 Server Maximum IPS Recording

The DX8100 can record at frame rates up to 480 IPS NTSC and 400 IPS PAL. The total frame rate capacity is distributed among 8/16/24/32 
channels, depending on the configuration of your unit. Resolution and frame rate values can be assigned evenly among all channels, or they can 
be configured independently for individual channel. Frame rate values can also be customized according to recording mode (normal, motion, 
alarm, and ATM/ POS). For information about setting up the DX8100 to record at the maximum rate and resolution, refer to Setting Up DX8100 for 
Maximum IPS Recording.

Setting Up DX8100 for Maximum IPS Recording

The following table describes how the DX8100 organizes cameras (channels) into groups of four cameras per group. To achieve the maximum 
recording rate and resolution: (30 ips at 4CIF [NTSC] or 25 ips at 4CIF [PAL]), enable one camera from each group while the other three cameras in 
the group are disabled. For information about the various recording rates and resolutions, refer to Understanding DX8100 Server Maximum IPS 
Recording.

To set up the DX8100 to record at the maximum rate and resolution:

1. Do one of the following:

• On the DX8100 toolbar, click . The Setup dialog opens to the Camera page.

• If the Setup dialog box is already open, click . The Camera page is displayed.

2. In the Camera Properties section, for Group 1, do the following:

a. Select a camera from the drop-down box. (You can also select a camera from the Site tree by clicking on it.)

Table AF.  DX8100 Server Maximum IPS Recording

Model Format
NTSC IPS PAL IPS

Total Per Camera Total Per Camera

DX8108

CIF 240 30 200 25

2CIF 120 15 100 12

4CIF 60 7 50 6

DX8116

CIF 480 30 400 25

2CIF 240 15 200 12

4CIF 120 7 100 6

DX8124

CIF 360 15 300 12

2CIF 180 6 150 6

4CIF 90 3 75 3

DX8132

CIF 480 15 400 12

2CIF 240 6 200 6

4CIF 120 3 100 3

Table AG.  DX8100 Camera Grouping

Model Group Assigned Camera

DX8108
1 1-4

2 5-8

DX8116

1 1-4

2 5-8

3 9-12

4 13-16
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b. For the camera you want to enable, verify that the Disable check box is not selected.

c. For the remaining cameras in the group, click the Disable check box to disable the respective camera.

3. Repeat step 2 for Groups 2, 3, and 4 (if applicable).

4. Click Apply.

5. Click . The Schedule page is displayed. 

6. Verify that the enabled camera from each group is displayed in the site tree.

Figure 126.  Setting Up DX8100 for Maximum IPS Recording

7. Click the Frame Rate configuration button. The Frame Rate Configuration screen is displayed.

Figure 127.  Frame Rate Configuration Screen
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8. Do the following:

a. Using the ALL frame rate settings slider, set the frame rate to 30 ips. The recording rate for each enabled camera is changed to 30 ips.

b. For the ALL resolution setting, from the drop-down box, select 704 x 480 from the drop-down box. The resolution for each enabled 
camera is set to 704 x 480.

c. Click OK.

9. Click Apply at the Schedule page, and verify that each enabled camera listed in the site tree is configured to record at 30 ips at 4CIF.

Figure 128.  Maximum Rate and Resolution Recording

Understanding the DX8100 Frame Rate Calculations

The DX8100 uses a complex algorithm to calculate the amount of recording resources available for each channel. This calculation takes into 
account factors such as the number of enabled cameras; whether uniform or mixed resolution values are used; recording type (continuous, alarm, 
or motion); and the frame rate settings of enabled channels. The resulting calculations provide the operator with a margin of available frame rate 
capacity to distribute among the recorder’s channels. This margin of frame rate capacity, or “headroom,” is presented to the user as color-filled 
sections of the frame rate sliders. White areas on the slider represent frame rate capacity that is not available to that channel. In certain cases, 
adjusting the available frame rates of one channel or resolution type may free up capacity for other channels. The following figure and table 
illustrates available and unavailable frame rate capacity.

Figure 129.  Example of Frame Rate Capacity

Table AH.  Frame Rate Capacity

Item Description

Available frame rate capacity

Unavailable frame rate capacity

� �
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SETTING UP ADVANCED RELAY OUTPUT

Relays work much like switches. When triggered, relays can activate external devices such as sirens, light fixtures, and door locks. The DX8100 
Series DVR allows Administrators and Power users to link relays to cameras and alarms. Up to 20 seconds of delay can be set from the moment 
an event is triggered to the time when a relay is activated.

Make sure you have linked relays to the appropriate cameras and alarm inputs before attempting to configure them. For instructions on linking 
alarms and relays, refer to Linking Alarm Inputs to a Camera and Linking Relay Outputs to Alarm Inputs.

This section describes how to setup advanced alarm and motion relay output and includes the following topics:

• Configuring Advanced Motion-Activated Relay Output 

• Configuring Advanced Alarm-Activated Relay Output 

• Configuring Advanced ATM/POS-Activated Relay Output 

• Configuring Advanced Video Loss-Activated Relay Output

Configuring Advanced Motion-Activated Relay Output

To configure a motion relay output:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Motion tab.

5. Configure each relay that is linked to a camera:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box. 

6. Click Save.

7. Click Exit.
 

Figure 130.  Linking Relays to Motion Detection

The following table describes the available options.
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Configuring Advanced Alarm-Activated Relay Output

To configure an alarm relay output:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Alarm tab if it is not already selected.

5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box. 

Figure 131.  Linking Relays to Alarms

The following table describes the available options.

Table AI.  Motion-Activated Relay Settings

Option Result

Disable Relay will not activate when motion is detected.

Follow Event Relay will activate at the exact moment that motion is detected.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after motion has been detected.

Table AJ.  Alarm-Activated Relay Settings

Option Result

Disable Relay will not activate when the alarm is triggered.

Follow Event Relay will activate at the exact moment the alarm is triggered.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the alarm has been triggered.

� 5a
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Configuring Advanced ATM/POS-Activated Relay Output

To configure an ATM/POS-activated relay output:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the ATM/POS tab if it is not already selected.

5. Configure each relay that is linked to an ATM/POS:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box.

Figure 132.  Linking Relays to ATM/POS

The following table describes the available options.

Configuring Advanced Video Loss-Activated Relay Output
To configure an advanced video loss-activated relay output:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. In the Setup dialog box, click . The Schedule page is displayed.

3. Click the Configure Relays button. The Configure Relays dialog box opens.

4. Click the Video Loss tab if it is not already selected.

Table AK.  ATM/POS-Activated Relay Settings

Option Result

Disable Relay will not activate when the ATM/POS event occurs.

Follow Event Relay will activate at the exact moment the ATM/POS event occurs.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the ATM/POS event occurs.

� 5a5a
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5. Configure each relay that is linked to an alarm:

a. Click the drop-down box to select a relay.

b. Select a relay time value from the Activation Period drop-down box.

Figure 133.  Linking Relays to Video Loss

The following table describes the available options.

SETTING UP NETWORK PROPERTIES
Network settings cannot be changed from the DX8100 Client application. To change a DVR’s network configuration, you must physically log in to 
a local DX8100 Series DVR as an Administrator or Power User. For more information on configuring the DX8100’s network settings, refer to 
DX8100 DVR Online Help or the Operation and Programming manual that came with your unit.

Table AL.  Video Loss-Activated Relay Settings

Option Result

Disable Relay will not activate when a video loss event occurs.

Follow Event Relay will activate at the exact moment the video loss event happens.

1, 3, 5, 10,15, and 20 Seconds Sets the amount of time the relay will remain active after the video loss event occurs.

� 5a5a
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DATA BACKUP SETUP
The DX8100 Client application allows you to see backup configuration settings, but not change them. To configure and perform backups, you 
must physically log in to a local DX8100 Series DVR as an Administrator or Power User. For more information about configuring a backup 
schedule, refer to the Data Backup Setup section in the DX8100 DVR Operation and Programming manual.

For more information about viewing backed up video, refer to Viewing and Searching backed up Video. 

WORKING WITH BACKED UP VIDEO ON CLIENT
The DX8100 Client application provides Standard Users and higher the ability to view, search, export, and print previously backed up video data. 
Moreover, the DX8100 Client machine does not have to be connected to the DX8100 server to work with backed up video. Archived PDB data 
refers to files stored in the DX8100’s native backup format. PDB is used to represent data stored in Pelco’s engineered Data Base format. 

This section describes how to view, search, export, and print backed up video, and is organized into the following sections:

• Viewing and Searching backed up Video

• Exporting and Printing backed up Video

VIEWING AND SEARCHING BACKED UP VIDEO

To view and search backed up video data:

1. Ensure that you have the correct backup device connected directly to your client PC. Example devices include

• CD-ROM/R/RW drives
• DVD-ROM/R/RW drives
• External drives
• Shared network storage

2. Insert the backup media into the device.

3. On the DX8100 Client toolbar, click .

4. From the DX8100 Client menu bar, choose File > Backup Search. The backup search screen appears.

Figure 134.  Backup Search Screen

5. Click “Update list” or “Browse” to search backup storage devices for DX8100 backup files.

6. Select a file from the list to view.

�

�

�
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7. Click OK. The backup search screen disappears, and the Site tree now displays only the server and cameras that are recorded in the 
selected backup file.

Figure 135.  Viewing Backed Up Data 

8. Search and play back the backed up video just as you would in normal video. Refer to Index Video Search, Thumbnail Video Search, and 
Pixel Video Search. 

9. To exit Backup Search and return to the normal DVR Search mode, go to File > End Backup Search.

EXPORTING AND PRINTING BACKED UP VIDEO

To export and print backed up video:

1. Ensure that you have the correct backup device connected directly to your client PC. Example devices include

• CD-ROM/R/RW drives
• DVD-ROM/R/RW drives
• External drives
• Shared network storage

2. Insert the backup media into the device.

3. On the DX8100 Client toolbar, click .
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4. From the DX8100 Client menu bar, choose File > Backup Search. The Backup data list dialog box opens.

Figure 136.  Backup Search Screen

5. Click “Update list” or “Browse” to search backup storage devices for DX8100 backup files.

6. Select a file from the list to view.

7. Click OK. The backup search screen disappears, and the Site tree now displays only the server and cameras that are recorded in the 
selected backup file.

Figure 137.  Viewing Backed Up Data 

8. To export or print backed up video, do one of the following: 

• To export backed up video, refer to Exporting Video.
• To print backed up video, refer to Printing Images.

9. To exit Backup Search and return to the normal DVR Search mode, go to File > End Backup Search.
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USER SETUP
The User page allows an Administrator (Admin) to add, delete, and change the properties of users. Admin has full permission of the DX8100. 
Users are subdivided into groups and each group is granted a particular level of access. Admin is the level that who can change permissions for 
all lower level users. A lower level user cannot have more permission than a higher level user. 

This section describes how to configure users and includes the following topics:

• Built-in User Accounts 

• Definition of User Access Levels 

• Definition of Camera Security Access 

• Adding New Users 

• Modifying User Properties 

• Changing User Passwords 

• Changing a User’s Group Affiliation 

• Deleting Existing Users

• Setting Login Timeout

• Assigning Automatic Login Permission to a User

ACCESSING THE USER PAGE

To access the User page:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

The following figure shows the User page.

Figure 138.  User Page

	

�
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�
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The following table describes the parts of the User page.

BUILT-IN USER ACCOUNTS

There are two built-in user accounts that come preconfigured with the DX8100, which cannot be deleted or changed.

• Guest: The Guest account provides limited access to the system. The Guest user can view live video but cannot play back recorded video or 
access system configuration functions. The Guest account automatically becomes active when the system is first started and each time a 
user logs out. The Guest user is not a member of any group. However, a Guest retains all of the rights and privileges of the Restricted Users 
group, with the exception of the ability to view low security cameras.

• Admin: The Admin account has full access to the system. The Admin user can view live and playback video, access all configuration 
settings, add and modify users, and can perform searches and backups. The Admin user is a member of the Administrators group and 
cannot be removed.

Table AM.  Parts of the User Page

Item Part Description

User Name 
Table Lists the authorized users.

User Buttons Allows you to do the following:

• Add: Opens the Add New User dialog box, to create a new user account. 

• Remove: Deletes the selected user.

• Properties: Opens the Properties dialog box, to view and modify user details.

• Set Password: Opens the Set Password dialog box, to specify or modify the user’s password.

User Groups Allows you to create user accounts for the following user groups:

• Power 

• Standard 

• Restricted

The DX8100 allows the administrator to configure access rights to any user group for the following 
functions:

• Camera security

• View live video

• Operate PTZ

• Playback video

• Set PTZ

• Access export menu

For more information about user groups, refer to Definition of User Access Levels and Definition of 
Camera Security Access.

User Timeout Allows you to configure the amount of time a user is allowed to remain logged on to the DX8100 system, 
before the system automatically logs out. The time period is from 5-60 minutes (in increments of 
5 minutes). The manual setting allows the user to stay logged on to the DX8100 until the user is 
manually logged off.

Auto Login User Allows you to configure a user to log on to the DX8100 automatically.
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DEFINITION OF USER ACCESS LEVELS

There are four predefined user access levels or groups. User access levels range from the Administrator group to the Restricted group. By default, 
the system starts up with a default Guest account. The Admin user can assign automatic login for a specified user. For information about setting 
up auto login, refer to Assigning Automatic Login Permission to a User.

The Guest account has Restricted user access. The following table describes the default user group access rights.

DEFINITION OF CAMERA SECURITY ACCESS

The administrator can limit the cameras that users are allowed to view. Access to a camera is determined by its security designation. The Admin 
user can configure access rights to any user group, for any of the following functions:

• Camera security

• View live video

• Operate PTZ

• Playback video

• Set PTZ

• Access export menu

Only users with High Security access can view cameras designated as High Security. Medium Security cameras can be viewed by users with 
Medium Security access and higher. All users except Guest can view Low Security cameras. All users can view No Security cameras. 

The following table summarizes default camera security levels and user access.

MODIFYING USER ACCESS RIGHTS

The Admin user can alter default access rights of lower level users. In this case, any permission granted to a lower level user, must first be 
granted to all other higher level users. For example, export rights must first be granted to the Standard user before they can be granted to a 
Restricted user. 

Table AN.  Default User Group Access Rights

User Groups
View 
Live 

Video

View 
Recorded 

Video

Operate 
PTZ

Search 
Video

Backup 
Video

System 
Setup

Shut 
Down 

System

Add/
Remove 

Users

Change User/
Group 

Properties

Exit to 
Windows

Administrators

Power Users

Standard Users

Restricted Users

Guest Users

Table AO.  Default Camera Security Levels

Groups No Security 
Cameras

Low Security 
Cameras

Medium Security 
Cameras

High Security 
Cameras

Administrators

Power Users

Standard Users

Restricted Users

Guest Users
156 Client Application C2631M-A (6/07)



Click the user group buttons to enable/disable the access right for each access category. The access right category is enabled when the button’s 
text is red (permission granted), and it is disabled when the button’s text is white (permission not granted). Click a button to toggle the access 
right, on and off. Repeatedly clicking the Camera Security button cycles through the security levels (none, low, medium, and high). 

To modify a user’s access rights:

1. On the DX8100 toolbar, click (icon). The Setup dialog box opens to the Camera page.

2. Click (icon). The User page is displayed.

3. Do one of the following:

a. To grant an access right to a user, left click on an access right button above the user’s group list. The text will toggle from white to red 
and that permission will be active for that user.

b. To deny an access right to a user, left click on an access right button above the user’s group list. The text will toggle from red to white 
and that permission will be denied for that user.

4. Click Apply.

ADDING NEW USERS

Administrators can create new user accounts and modify existing users; this can be done locally on the DX8100 server or remotely from the 
DX8100 Client Application. 

User names and passwords have the following requirements:

• User names can be between 4 and 20 alphanumeric characters in length. 

• User passwords can be between 4 and 10 alphanumeric characters in length. 

• User names cannot contain spaces and special characters.

• User names and passwords are case sensitive.

To add a new user:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Click Add. The Add New User dialog box opens.

4. Do the following:

a. Enter a login name for the user. 

b. Enter the user’s full name.

c. Enter a brief description for the user. For example, enter Building 6 Security Guard.

d. Enter a password for the user. (Passwords must be between 4 and 10 characters in length and cannot contain spaces and special 
characters.)

e. Re-enter the same password to confirm.

5. Click Next. The user access level options for the New User dialog box are displayed.

6. Select the user’s access level: Restricted, Standard, or Power.

7. Click Finish.
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8. Click Apply.

Figure 139.  Add New User Dialog Box

MODIFYING USER PROPERTIES

Follow the steps below to change user attributes, such as user name and group affiliation. Users with Admin or Power User access can change 
name and description properties of lower level users. However, only Admin level users can change a user’s group affiliation. 

To modify a user’s properties:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Do one of the following:

• In the main user list:
(1) Click a user name.

(2) Click Properties. The Property dialog box opens.

• In one of the group lists:
(1) Click a user name.

(2) Click Properties. The Property dialog box opens.

4. Edit the following user properties:

• User name
• Full name
• Description
• Group

5. Click Apply in the Property dialog box.

6. Click Apply in the User Setup screen.

An Administrator level user can also change the group affiliation of users by dragging user names to different groups.

�
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CHANGING USER PASSWORDS

Administrators and Power Users can change or reset an existing user’s password.

To change a user’s password:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Click a user name in the main user list.

4. Click Set Password. The Set Password dialog box opens.

5. Enter a new password in the “New password” field.

6. Retype the password again in the “Confirm new password” field.

7. Click Apply in the Set Password dialog box. 

8. Click Apply in the User Setup screen. 

CHANGING A USER’S GROUP AFFILIATION

An Administrator level user can also change users' group affiliation of users by dragging user names to different groups.

To change a user's group affiliation:

• In the User name column of the User page, click the user's name and drag it into a group.

DELETING EXISTING USERS

Administrators can delete existing users.

To delete a user’s account:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Click the user name of the user you want to delete from the main user list.

4. Click Remove. The Remove User dialog box opens.

5. Click Yes to confirm the deletion or No to cancel and return to the User Setup screen.

6. Click the Apply button at the bottom of the screen.

SETTING LOGIN TIMEOUT

Administrators can define the amount of time a user’s account can remain idle before having to log in again. This setting applies to all users, 
regardless of access level. 

 To set login timeout:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. Select a time limit from the User Timeout drop-down box.

• Time limits range from five minutes to one hour, in five-minute increments.
• Selecting Manual from the drop-down box will suspend the automatic logout feature. (A user will remain logged in until the user logs 

out or another user logs in.)

4. Click Apply.
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ASSIGNING AUTOMATIC LOGIN PERMISSION TO A USER

The DX8100 allows one user to automatically log in to the DX8100 application. The administrator must assign automatic login permission to the 
user. Once automatic login permission is assigned to the user, the user will be automatically logged in to the DX8100 application. In this case, 
the assigned user does not have to enter the user name and password. 

NOTE: Automatic login user permission makes the DX8100 more vulnerable because a higher level user is logged in every time. 

To assign automatic login permission:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The User page is displayed.

3. In the Auto Login User drop-down selection box, select a user.

4. Click Apply. 

The next time the DX8100 application is started, the assigned user is logged in automatically.

SITE SETUP
The DX8100 Client application does not allow you to access the Site page to configure remote sites. You must physically log in to the local 
DX8100 Series DVR as an Administrator or Power User to configure remote sites. For more information on configuring remote sites, refer to the 
DX8100 DVR server online Help or the Operation and Programming manual that came with your unit.

SYSTEM SETUP
Many of the options presented in the System page cannot be configured from the DX8100 Client application. Administrators and Power Users are 
allowed to import and export system configuration files and view and export system logs. To modify other system setup options, you must 
physically log in to the local DX8100 Series DVR as an Administrator or Power User. For more information, refer to the DX8100 DVR online Help 
or Operation and Programming manual that came with your unit.

This section describes how to configure system options and parameters, including the following topics:

• Accessing the System Page 

• Working with the Export Feature

• Working with the Import Feature

• Using System Logs

ACCESSING THE SYSTEM PAGE

To access the System page:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

WORKING WITH THE EXPORT FEATURE

The DX8100 provides an import and export feature that allows you to save and reload DX8100 configuration settings. You can save your DX8100 
DVR configuration settings by exporting them to a specific storage media and location. You can reload a specific configuration profile by 
importing its configuration file. 

This sections describes how to use the import and export feature, including the following topics:

• Exporting Current DVR Settings 

• Using the Edit Menu to Perform an Export 
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Exporting Current DVR Settings

To save current DVR configuration settings:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. Select the Export button.

4. Select the check boxes of each configuration item you want to back up, or click Select All to export all settings.

5. Do one of the following:

a. To specify the file name to which you want to export, enter the drive, path and file name information into the text box. Setting file 
names follow standard Windows file-naming conventions. For example, C:\DX8100\Jan_2004_config.bak .

or

b. To browse for a location:

(1) Click Browse.

The DX8100 Setup File Export Dialog box opens.

(2) Enter a file name in the “File name” text box.

(3) Navigate to the drive and folder in which you want to save the settings file.

(4) Click the Up button to move up a level in the folder hierarchy.

(5) Click Save.

6. Click Export Now.

Figure 140.  Exporting DVR Settings

Using the Edit Menu to Perform an Export 

To save current DVR settings:

1. From the DX8100 menu bar, choose Edit > Export Setup.

The DX8100 Setup File Export Dialog box opens.

2. Select the folder in which you want to save the settings file.

3. Click the Up button to move up a level in the folder hierarchy.

4. Enter a file name in the space provided.

5. Click Save.

�

�
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WORKING WITH THE IMPORT FEATURE

This sections describes how to import DX8100 DVR settings and includes the following topics:

• Importing DVR Settings 

• Using the Edit Menu to Perform an Import

Importing DVR Settings

To import a saved settings file:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. Select the Import button.

4. Do one of the following:

a. To specify the file name for import, enter the drive, path, and file name information in the text box. Settings file names follow 
standard Windows file-naming conventions. For example, C:\System Settings Backup.bak. 

or

b. To browse for a location:

(1) Click Browse. The DX8100 Setup File Export Dialog box opens.

(2) Navigate to the drive and folder where the settings file is located.

(3) Click the Up button to move up a level in the folder hierarchy.

(4) Select the settings file you want to open.

(5) Click Open.

5. Click Import Now.

6. Click Apply.

Figure 141.  Import DX8100 Configuration

Using the Edit Menu to Perform an Import 

To import a settings file from a specific drive or folder:

1. From the DX8100 menu bar, choose Edit > Import Setup.

The DX8100 Setup File Import Dialog box opens.

2. Select the folder location of the file you want to import.

3. Click the Up button to move up a level in the folder hierarchy.

4. Click the settings file you want to open.

5. Click Open.

�
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USING SYSTEM LOGS

The DX8100 automatically stores system information in a number of log files. Users with Power User access and higher can use these files to 
track system statistics and monitor security. The DX8100 allows you to view its activity log files.

This section describes how to use the system logs and includes the following topics:

• Viewing a Log File 

• Exporting Log Information

Viewing a Log File

To view a log file:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Log Information section, select a log file from the Choose drop-down box. 

4. Click View. The Log View dialog box opens.

Figure 142.  Viewing a Log File

The following figure shows the Log View dialog box. 

Figure 143.  Log View Dialog Box

Exporting Log Information

To export a system log file:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The System page is displayed.

3. In the Choose drop-down box, select a log file. 

4. Click Save As.

5. Select the drive and folder in which you want to store the log file.

��
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6. Enter a filename for the log information in the space provided.

Log file names follow standard Windows file-naming conventions. Alternatively, you can view log files by clicking View > Log and then 
selecting the desired log file. Log files can be opened and printed using a text editing program, such as Windows Notepad.

7. Click Save.

Figure 144.  Exporting a Log File

EXTERNAL MONITOR SETUP
The Capture Card’s external monitor settings of a remote DVR cannot be changed from the DX8100 Client application. To change a DVR’s analog 
monitor configuration, you must physically log in to a local DX8100 Series DVR as an Administrator or Power User. For more information on 
configuring the Capture Card’s optional analog monitor outputs, refer to the DX8100 DVR online Help or Operation and Programming manual that 
came with your unit.

EMERGENCY NOTIFICATION SETUP
The Emergency Agent Notification alerts selected clients to motion, alarm, and video loss events detected by DX8100 server sites. When a 
motion, alarm, or video loss event is triggered, a pop-up window opens on the monitor of the remote site client. The window displays one or 
more still images taken during the event. 

Users with Power User access and higher can configure the emergency agent notification system. The first step in the setup process requires 
that clients be added to the emergency agent notification list. To complete this step, you must provide a valid name and the IP address of each 
client PC. After clients have been added they can be linked to one or more cameras. Finally, the amount of time a server sends images after an 
event occurs and the interval between sending each image must be set. 

NOTE: Before configuring the Emergency Agent Notification, make sure the Emergency Agent Client utility is installed on one or more client 
PCs. For information on installing the Emergency Agent Client utility, refer to Installing the Client Emergency Agent Application in this manual. 

This section describes how to setup emergency notification and includes the following topics:

• Accessing the Emergency Agent Notification Setup 

• Adding Client Emergency Agents to be Notified

• Changing Client Emergency Agent Properties

• Deleting Clients from the Notification List

• Linking Cameras to Client Emergency Agents 

• Setting Server Event Transmission Time

ACCESSING THE EMERGENCY AGENT NOTIFICATION SETUP

To access the Emergency Agent Notification setup:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

�

�
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ADDING CLIENT EMERGENCY AGENTS TO BE NOTIFIED

After clients have been added, cameras must be configured to notify individual clients of an event. A single camera can be linked to one or more 
client emergency agents. For information on linking cameras to client emergency agents, refer to Linking Cameras to Client Emergency Agents.

To add clients to the Emergency Agent Notification list:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click Add. The Agent Setup dialog box opens.

4. Do the following:

a. Enter a name for the client. (Client names can be up to 63 characters and can include spaces, but not special characters.

b. Enter the client’s IP address.

c. If necessary, enter a port number in the Agent Port text box. (The default port number is 9004.)

Unless there is a conflict on your network, you should not change the Emergency Agent port number from its default of 9004. Make 
sure any changes to port numbers are made consistently across all DX8100 servers and clients on a network. Client and server ports 
must be identical.

5. Click OK.

6. Click the Apply button at the bottom of the screen.

CHANGING CLIENT EMERGENCY AGENT PROPERTIES

To change an existing client’s information in the emergency notification list:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Do the following:

a. In the Emergency Agent Setup section, select a client from the list.

b. Click Edit. The Agent Setup dialog box opens.

c. Enter a new name for the client. (Client names can be up to 63 characters long and can include spaces, but not special characters.)

d. Enter a new IP address for the client.

e. If necessary, enter a port number in the Agent Port text box. (The default port number is 9004.)

Unless there is a conflict on your network, you should not change the Emergency Agent port number from its default of 9004. Make 
sure any changes to port numbers are made consistently across all DX8100 servers and clients on a network. Client and server ports 
must be identical.

4. Click OK.

5. Click the Apply button at the bottom of the screen.

DELETING CLIENTS FROM THE NOTIFICATION LIST

To delete a client from the emergency notification list:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.
C2631M-A (6/07) Client Application 165



3. Do the following:

a. In the Emergency Agent Setup section, select a client from the list.

b. Click Delete. The selected client is deleted.

4. Click Apply.

LINKING CAMERAS TO CLIENT EMERGENCY AGENTS

After clients have been added, cameras must be configured to notify individual clients about an event. A single camera can be linked to one or 
more client emergency agents.

Up to 32 IP addresses can be assigned to each camera. The DX8100 can transmit up to 10 IP addresses simultaneously. 

To link a camera to one or more clients:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. In the Camera Setup section, click a camera button (Camera 1-32). The Emergency Agent Selection dialog box opens.

4. Click the check box to select the name of the client site you want to notify when a motion, alarm, or video loss event is detected by this 
camera.

5. Repeat steps 1 and 2, for up to 32 cameras on the current site.

6. Click the Apply button at the bottom of the screen.

7. Configure the server event transmission time. For information on setting the duration and transmission interval, refer to Setting Server 
Event Transmission Time.

SETTING SERVER EVENT TRANSMISSION TIME

After clients have been added and linked to cameras, you must set the amount of time a server sends images after an event occurs and the 
interval between sending each image (for one of more clients). For information on adding clients, refer to Adding Client Emergency Agents to be 
Notified. For information on linking cameras, refer to Linking Cameras to Client Emergency Agents.

To set the duration for sending images and the transmission interval:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. In the Option section of the Emergency Agent page, enter the amount of time (in seconds) that you want the DX8100 to continue sending 
still images after an alarm, motion, or video loss event has been detected.

4. Enter the time interval (in seconds) that you want the DX8100 to wait between sending each still image.

5. Click Apply.

EMERGENCY E-MAIL NOTIFICATION SETUP
The DX8100 can be configured to send e-mail notifications alerting users of motion, alarm, and video loss events. Users with Power User access 
and higher can configure the notification function. Notifications can be sent to a single e-mail address or a group of addresses, either 
immediately after an event occurs or periodically according to a predefined schedule. You can configure up to 32 e-mail groups, and up to 32 
members can be assigned to each e-mail group. 

Before sending notifications, you must provide information about your e-mail server and establish the events (motion, alarm, and video loss) that 
you want to include in the e-mail message. Timing and frequency of the e-mail notifications must also be set. You should test the e-mail 
notification function immediately after configuration to ensure your system is set up correctly.
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NOTES: 

• To use emergency e-mail notification, the DX8100 Series DVR must be connected to a LAN) that maintains an SMTP mail server. The 
network must also be connected to either an intranet or the Internet depending on the location of the e-mail accounts to which you want to 
send notifications. Consult your network administrator for information on configuring e-mail notification on your local network.

• DX8100 does not support Google™ Gmail. 

This section describes how to set up emergency e-mail notification and includes the following topics:

• Accessing the Emergency E-mail Notification Setup

• Configuring Emergency E-mail Notification 

• Setting Up the Time Period

• Sending E-mail Notifications 

ACCESSING THE EMERGENCY E-MAIL NOTIFICATION SETUP

To access the emergency e-mail notification setup:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

CONFIGURING EMERGENCY E-MAIL NOTIFICATION

This section describes how to set up emergency e-mail notification and includes the following topics:

• Enabling or Disabling E-mail Notification

• Setting Up the E-mail Server 

• Testing E-mail Notification

Enabling or Disabling E-mail Notification

To enable or disable emergency e-mail notification:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. In the Emergency E-mail Notification page, do one of the following:

• Click the Enable Notification button to enable e-mail notification.
• Click the Disable Notification button to disable e-mail notification.

Setting Up the E-mail Server

Set up the e-mail server in the Emergency E-Mail Notification page. For information on accessing the Emergency E-Mail Notification page, refer 
Accessing the Emergency E-mail Notification Setup.

To set up the e-mail server:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. Enter a name in the Full Name text box. You should enter a name that reflects the DX8100 server sending the notification (for example, 
DX8100 First Floor Lobby). Names can be up to 31 characters long and can include spaces. but not special characters.

5. Enter your e-mail address in the E-mail Address text box.
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6. Enter the address of your local SMTP mail server. Obtain this information from your network administrator.

7. If your e-mail server requires you to log in, do the following:

a. Select the check box labeled My E-mail Server Requires Authentication.

b. Enter your e-mail server address.

c. Enter your user name. (User names can be up to 31 characters in length and cannot include spaces or special characters.)

d. Enter your password. (Passwords can be up to 19 characters in length and cannot include spaces or special characters.)

8. Click Apply. 

Figure 145.  Basic E-mail Notification Setup

Testing E-mail Notification

You test the e-mail notification configuration in the Emergency E-mail Notification page. For information on accessing the Emergency E-mail 
Notification page, refer Accessing the Emergency E-mail Notification Setup.

To test e-mail notification:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab.

4. Select the My E-mail Server Requires Authentication check box (if it is not already selected).

5. Enter your personal e-mail address or the address of someone who can verify the receipt of the test e-mail in the To text box.

6. Type DX8100 E-mail Notification Test in the Subject text box.

�

�

�
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7. Enter the following server settings if necessary: 

• Server address (This address should be the same as the SMTP server address you entered above.)
• User name
• Password

8. Click Test E-mail Notification.

Figure 146.  E-Mail Test

SETTING UP THE TIME PERIOD

The DX8100 can be configured to send e-mail notifications on a periodic basis, such as once every ten minutes. This sections describes how to 
set up the time period and includes the following topics:

• Configuring E-Mail Notification Frequency 

• Setting the Time of Day 

• Sending E-mail Notifications in Response to Motion Events 

• Sending E-mail Notifications in Response to Alarm Events 

• Sending E-mail Notifications in Response to Video Loss Events

Configuring E-Mail Notification Frequency

Depending on the volume of motion, alarm, or video loss events detected by the DX8100, the number of e-mail notifications can be far too many 
to manage effectively. To keep the number of e-mails sent by the DX8100 at a manageable level, the e-mail notification frequency can be 
adjusted. When events have been detected, e-mail notifications can be sent out in intervals from once per minute up to once every six hours. If 
no events have been detected during the specified frequency interval, no notification will be sent. Each e-mail notification will include 
information about the first event detected during the interval, the last event detected during the interval, and a still image (in JPEG format) of the 
last event.

To configure notification frequency:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

�
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�
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�
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4. In the Frequency section, select the frequency interval from the drop-down box. Options for sending an e-mail notification include once 
every

• 1 minute
• 10 minutes
• 30 minutes
• 1 hour
• 3 hours
• 6 hours

Setting the Time of Day

To set the time of day during which e-mail notifications will be sent:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Frequency section, do the following:

a. Click the Start check box to use the spinner buttons, or type the earliest time of day you want e-mail notifications to be sent (for 
example, 7:30 a.m.). 

b. Click the End check box to use the spinner buttons, or type the latest time of day you want e-mail notifications to be sent (for example, 
6:00 p.m.). 

5. Click Apply.

Sending E-mail Notifications in Response to Motion Events

E-mail notifications can be sent whenever a camera attached to a DX8100 detects motion.

To cause e-mail notifications to be sent in response to motion events:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Motion check box.

b. In the Selected Channels field, click once to the right of the word Motion. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box for each channel you want to monitor for motion detection events.
• Click Select All to monitor all channels for motion detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

Sending E-mail Notifications in Response to Alarm Events

E-mail notifications can be sent whenever an alarm input is activated. 

To initiate e-mail notifications to be sent in response activated alarm inputs:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 
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4. In the Notification Items section, do the following:

a. Click the Alarm check box.

b. In the Selected Channels field, click once to the right of the word Alarm. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box for each channel you want to monitor for alarm detection events.
• Click Select All to monitor all channels for alarm detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

Sending E-mail Notifications in Response to Video Loss Events

E-mail notifications can be sent whenever a camera attached to a DX8100 experiences a video loss event.

To cause e-mail notifications to be sent in response to video loss events:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is display.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Notification Items section, do the following:

a. Click the Video Loss check box.

b. In the Selected Channels field, click once to the right of the words Video Loss. The Selected Channels dialog box opens.

c. Do one of the following:

• Click the check box for each channel you want to monitor for video loss detection events.
• Click Select All to monitor all channels for video loss detection. 
• Click Deselect All to deselect all channels.

5. Click OK.

6. Click Apply.

SETTING UP E-MAIL NOTIFICATION GROUPS

The DX8100 allows you to set up groups to send an emergency notification to multiple users. The DX8100 supports the following:

• You can create up to 32 e-mail notification groups. 

• Up to 32 members can be assigned to each e-mail group. 

• A group can be notified in response to an alarm or motion detection event.

This section describes how to set up e-mail notification groups and includes the following topics:

• Adding an E-mail Notification Group 

• Modifying an E-mail Group Name 

• Deleting an E-mail Group 

• Adding Members to an E-mail Group 

• Deleting Members from an E-mail Group

• Modifying E-mail Group Member Attributes 
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Adding an E-mail Notification Group

To add an e-mail notification group:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. Click Add Group. The Manage Groups dialog box opens.

c. Enter the name of the group. (Group names can be up to 32 characters in length and can include spaces, but not special characters.)

5. Click OK.

6. Click Close.

7. Click Apply.

Modifying an E-mail Group Name

To modify a group name:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. In the Group Name table, select a group.

c. Click Edit Group. The Manage Groups dialog box opens.

d. Edit the existing name or enter a new name for the group.

5. Click OK.

6. Click Close.

7. Click Apply.

Deleting an E-mail Group

To delete a group:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. In the Mail Group area, do the following:

a. Click Manage Groups. The Group Management dialog box opens.

b. In the Group Name table, select a group.

c. Click Delete. 

5. Click Close.

6. Click Apply.
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Adding Members to an E-mail Group

Up to 32 members can be assigned to each e-mail group. 

To add e-mail addresses to a group:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Ensure that the group check boxes under To and CC are deselected.

c. Enter an e-mail address in the To or CC text boxes.

d. Click Add to Group.

5. Click Apply.

Figure 147.  Add User to E-mail Group
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Deleting Members from an E-mail Group

To delete a user from a group:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Select the user you want to delete from the list.

c. Click Delete.

5. Click Apply.

Figure 148.  Remove User from E-mail Group
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Modifying E-mail Group Member Attributes

To modify a user’s e-mail address or group affiliation:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the Mail Group section, select a group name from the drop-down box.

b. Click the e-mail address of the user you want to edit. 

c. Click Edit. The E-mail Settings dialog box opens.

d. In the Group drop-down box, select a different group for the user.

e. If necessary, enter a new e-mail address for the user in the E-mail Address text box.

5. Click OK.

6. Click Apply.

Figure 149.  Modify Member Attributes
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SENDING E-MAIL NOTIFICATIONS

This section describes how to send e-mail notifications and includes the following topics:

• Sending E-mail Notifications to Individuals 

• Sending E-mail Notifications to Groups 

Sending E-mail Notifications to Individuals

To configure e-mail notifications to send alerts to an individual:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. In the To text box, enter the e-mail address of the individual to whom you would like to send e-mail notifications.

b. (Optional) In the CC text box, enter a second e-mail address of a person to whom you would like to send a copy of the notification to.

c. In the Subject text box, enter text in the subject line as you would like it to appear in e-mail notifications. (The default subject line is 
DX8100 Emergency Email Notification.)

5. Click Apply.

Figure 150.  Sending E-mails to Individuals
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Sending E-mail Notifications to Groups

To configure e-mail notification to send e-mail alerts to a group of individuals:

1. On the DX8100 toolbar, click . The Setup dialog box opens to the Camera page.

2. Click . The Notification page is displayed.

3. Click the Emergency E-mail Notification Setup tab. 

4. Do the following:

a. Click the To check box.

b. In the drop-down box, select the group to which you want to send event notifications. 

c. (Optional) If you want to e-mail a copy of the event notification to another group of users, click the CC: check box.

d. In the drop-down box, select the group you want to copy. 

5. Click Apply.

Figure 151.  Sending E-mails to Groups
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DX8100 Client Emergency Agent

Welcome to the DX8100 Client Emergency Agent application. The DX8100 Client Emergency Agent works with networked DVRs to alert users 
when one or more particular channels detect a motion, alarm, or video loss event. The Emergency Agent runs on a networked client PC.

This section describes how to install, set up, and use the DX8100 Client Emergency Agent and includes the following topics:

• Setting Up and Using the Client Emergency Agent

• Recommended System Requirements

• Installing the Client Emergency Agent Application

• Enabling IPSec Security Services 

• Disabling IPSec Security Services 

Setting Up and Using the Client Emergency Agent
The following steps must be completed in sequence before the Emergency Agent can receive event notifications:

1. You must install the Client Emergency Agent software on your client PC before you can use it. Refer to the installation manual for 
instructions on installing the Client Emergency Agent utility.

2. The DX8100 server must be turned on and operating.

3. Both the DX8100 server and client must be connected to the same network.

4. The Emergency Agent Notification system must be operating on the DX8100 server. 

5. The client PC must be listed in the emergency agent notification list of the DX8100 server, and at least one camera must be linked to the 
client. For more information, refer to Emergency Notification Setup.

6. The Client Emergency Agent must be configured and activated on the client PC.

RECOMMENDED SYSTEM REQUIREMENTS
The DX8100 Emergency Agent recommended minimum system requirements include the following: 

• Processor: Intel Pentium III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB of video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX 8.1 or later hardware 
acceleration

• 2.5 MB of free disk space for the full application and additional space to store images

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows 2000 (SP4) or Windows XP only

POWER HDD

USB

POWER SWITCH
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INSTALLING THE CLIENT EMERGENCY AGENT APPLICATION
To install the Client Emergency Agent application:

1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8100 Resource CD into the DVD drive of your PC and wait for the DX8100 Resource CD screen to appear.

Figure 152.  DX8100 Resource CD Screen

4. Click Software. The Software menu is displayed.

Figure 153.  Resource CD Installation Options
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5. Click DX8100 Viewer. The DX8100 Emergency Agent Setup dialog box appears.

Figure 154.  DX8100 Emergency Agent Setup Dialog Box

6. Click Next. The Software License Agreement dialog box appears.

Figure 155.  Emergency Agent Software License Agreement Dialog Box 

7. Read the license agreement, and then select the “I accept this License Agreement” check box.

8. Click Next. The Select Installation Folder dialog box appears.

Figure 156.  DX8100 Emergency Agent Installation Folder Dialog Box
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9.  Click Next to accept the default installation folder. The Emergency Agent software is installed.

10. Click Finish to complete the installation process.

Figure 157.   Emergency Agent Installation Finalization Dialog Box

ENABLING IPSEC SECURITY SERVICES
In order to communicate with a networked DX8100 Series DVR, IPSec security must be enabled on your computer. To see the Manage IPSec 
Settings menu option from the Start menu, the Start menu has to be changed to Classic View. 

To enable IPSec security services:

1.  Do one of the following:

• Verify that the Start menu is in Classic View.
• Set the Start menu to Classic View.

2. Go to Start > Manage IPSec Settings. The DX8100 IPSec Policy dialog box opens.

Figure 158.  Enabling IPSec Security for the Emergency Agent Application

3. Select the Enable DX8100 IPSec Policy check box (if it is not already selected).

4. (If applicable) Set the Start menu to its previous view.
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DISABLING IPSEC SECURITY SERVICES
To disable IPSec security services:

1.  Do one of the following:

• Verify that the Start menu is in Classic View.
• Set the Start menu to Classic View.

2. Go to Start > Manage IPSec Settings. The DX8100 IPSec Policy dialog box opens.

Figure 159.  Disabling IPSec Security for the Emergency Agent Application

3. Deselect the Enable DX8100 IPSec Policy check box.

4. (If applicable) Set the Start menu to its previous view.

NOTE: Disabling IPSec security services will prevent your PC from communicating with DX8100 servers. Consult your system administrator 
before disabling IPSec security.
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Before You Begin
Ensure that the following requirements have been met before starting the Emergency Agent application:

1. Make sure there is at least one active DX8100 Series DVR available on your network and your computer is set up to access it. Consult your 
network administrator for more information.

2. Install the DX8100 Emergency Agent application on your computer, if you have not done so already. Refer to Installing the Client Emergency 
Agent Application for instructions.

3. Make sure that Emergency Agent notification is set up on one or more DX8100 Series DVRs, and that your PC has been selected to receive 
emergency notifications. For information about setting up Emergency Agent notification, refer to the Emergency Notification Setup section 
of the Operation and Programming manual.

4. Make sure IPSec security services are installed and enabled on your PC. For more information, refer to Installing the Client Emergency 
Agent Application and Enabling IPSec Security Services.

STARTING THE CLIENT EMERGENCY AGENT
To start the emergency agent software on a client PC:

1. Turn on your PC and wait while Windows loads.

2. Double-click the Emergency Agent icon on the client computer’s desktop.

Figure 160.  Emergency Agent Icon

The Emergency Agent dialog box opens.

Figure 161.  Client Emergency Agent Dialog Box
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REAL-TIME EVENT MONITORING
Once the Client Emergency Agent has been activated, a motion or alarm event detected by a linked camera on a DX8100 server will cause a 
pop-up window to display a still image of the event. In addition to real-time monitoring of events, all event notifications sent to the client will be 
logged for future viewing.

Figure 162.  Client Emergency Agent Pop-up Window

SETTING THE CLIENT EMERGENCY AGENT LISTEN PORT
If necessary, you can change the network port used by the Client Emergency Agent.

To change the port:

1. Click the Port Setting button. The Emergency Agent Listen Port dialog box opens.

Figure 163.  Emergency Agent Listen Port Dialog Box

2. If necessary enter a new port number (default port number is 9004).

NOTE: The port number must be an integer between 5000 and 6535. You should keep the default port setting unless there is a conflict on 
your network. Consult your network administrator before changing network port settings.

3. Click OK.

VIEWING PREVIOUSLY LOGGED EVENTS
Over time, the Client Emergency Agent will accumulate event information in a list. This list can be searched, and still images of previously logged 
events can be viewed.

To view previously logged events:

1. Select a DX8100 Series DVR from the Server list.

2. Select a start date to mark the first date to begin searching logged events.

Setting the start time earlier than the first time you began using the Client Emergency Agent will result in no events appearing in the list.

3. Select an end date to mark the last date to search for logged events.

4. Select the type of event (motion, alarm, or video) to search.

5. Select one or more cameras.
184 DX8100 Client Emergency Agent C2631M-A (6/07)



6. Double-click each event in the event list you want to view. A pop-up window containing a still image of the logged event will open.

Figure 164.  Client Emergency Agent Server List and Log

SHUTTING DOWN THE CLIENT EMERGENCY AGENT
To shut down the Client Emergency Agent:
• Click Quit.
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DX8100 Viewer

Welcome to the DX8100 Viewer application. The DX8100 Viewer is capable of playing back a variety of video, still image, and audio media 
formats. It is designed to recognize and verify the digital watermark that is embedded in DX8100 native video. Watermarking is used to 
authenticate the originality of a video file and to alert users of possible image tampering. The viewer application runs automatically each time a 
CD or DVD created by the DX8100’s export feature is inserted into a Windows-based PC. The software can also be installed on a PC and opened 
independently when necessary.

This section describes how to install, set up, and use the DX8100 Client Viewer, and includes the following topics:

• Setting Up and Using the DX8100 Viewer

• Working with the Playlist

• Working with Viewer Configuration Tools

• Exiting the DX8100 Viewer Application

Setting Up and Using the DX8100 Viewer
This section describes how to use the DX8100 Viewer application and includes the following topics:

• Recommended System Requirements 

• DX8100 Viewer Software Installation 

• Starting the DX8100 Viewer 

• Viewing Media files 

• Playing Video 

• Saving Snapshots 

• Printing Images 

• Working with the Playlist

RECOMMENDED SYSTEM REQUIREMENTS
The DX8100 Viewer recommended minimum system requirements include the following:

• Processor: Intel Pentium III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB of video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX 8.1 or later hardware 
acceleration

• 4.5 MB of free disk space

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows 2000 (SP4) or Windows XP only
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DX8100 VIEWER SOFTWARE INSTALLATION
To install the DX8100 Viewer software:

1. Start the Windows operating system. 

2. Close all programs, including any antivirus software.

3. Insert the DX8100 Resource CD into the CD-ROM drive of your PC and wait for the DX8100 Resource CD screen to appear.

Figure 165.  Resource CD Screen

4. Click Software. The Software menu is displayed.

Figure 166.  Resource CD Screen Installation Options
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5. Click DX8100 Viewer. The DX8100 Viewer Setup dialog box opens.

Figure 167.  DX8100 Viewer Dialog Box

6. Click Next. The Software License Agreement dialog box opens.

Figure 168.  Emergency Agent Software License Agreement Dialog Box

7. Click Next. 

Figure 169.  DX8100 Viewer Installation Folder Dialog Box
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8. Click Next to accept the default installation folder. 

9. Click Finish to complete the installation process.

Figure 170.   DX8100 Viewer Finalization Dialog Box
C2631M-A (6/07) DX8100 Viewer 189



STARTING THE DX8100 VIEWER
The Playback speed cannot be changed in the DX8100 Viewer. After opening up a saved file, the program will not allow you to move the slider to 
speed up or slow down the video. 

To start the DX8100 Viewer software on a client PC:

1. Turn on the client computer and wait while Windows loads.

2. Double-click the DX8100 Viewer icon on the client computer’s desktop.

Figure 171.  DX8100 Viewer Icon

The DX8100 Viewer application window opens.

Figure 172.  DX8100 Viewer Main Screen
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The following table describes the parts of the DX8100 Viewer window.

The following table describes the DX8100 Viewer toolbar buttons.

VIEWING MEDIA FILES
To open a file for viewing: 

1. On the DX8100 Viewer toolbar, click . The Open dialog box appears.

Figure 173.  Open Dialog Box

Table AP.  Parts of the DX8100 Mobile Client Window

Item Part

Toolbar

View panel

Playback controls

Playback slider

Volume controls (click speaker icon to toggle audio mute)

Watermark verification message area

Play speed control for video captured in the DX8100 Native format.

Table AQ.  DX8100 Viewer Toolbar Buttons

Button Name Description

Folder Browse drives and open media files.

Save Save a snapshot of the current screen image.

Print Print the current screen image.

Playlist Expand window to reveal playlist.

Configuration Expand the window to reveal configuration tools.

Watermark Verify a valid watermark is embedded.

�
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2. Click the “Look in” drop-down box to select the drive and folder location where the media file(s) resides.

3. Select the file(s) you want to play.

4. Click Open. The file opens in the DX8100 Viewer window in the Play mode.

Figure 174.  View Panel Image

PLAYING VIDEO
You can play video files in the DX8100 Viewer after they have been opened. The DX8100 Viewer provides a speed control that allows you to 
speed up playback of video exported in the Native format.

To begin playback of a an exported DX8100 video file:

1. On the DX8100 Viewer toolbar, click .

2. Use the playback controls and playback slider to move through a video file.

3. Do the following:

a. Use the audio controls to increase, decrease, or mute playback volume.

b. Use the speed control to increase or decrease the playback of video exported in the Native format.

SAVING SNAPSHOTS
You can take snapshots of still images that appear in the view panel. Use the playback controls to pause a video file on a specific still image. 
Snapshots are stored in a folder for later retrieval or viewing. For information on changing the location of the snapshot folder, refer to Working 
with Viewer Configuration Tools. 

To save a snapshot of a still image appearing:

• On the DX8100 Viewer toolbar, click Save.

For example, click .
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PRINTING IMAGES
You can print still images that appear in the view panel. Use the playback controls to pause a video file on a specific still image.

To print a still image:

• On the DX8100 Viewer toolbar, click Print.

For example, click .
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Working with the Playlist
The DX8100 viewer application allows you to create, load, and save playlists of media files. This section describes how to work with the playlist 
and includes the following topics:

• Accessing the Playlist 

• Adding Files to the Current List 

• Removing Media Files from the Current List 

• Playing a File from the Playlist

• Loading a Previously Saved Playlist 

• Saving the Current Playlist

ACCESSING THE PLAYLIST
To access the playlist:

• On the DX8100 Viewer toolbar, click Playlist.

For example, click . The following figure shows the playlist.

Figure 175.  Viewer Playlist
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ADDING FILES TO THE CURRENT LIST
To add media files to the current list:

1. In the Playlist dialog box, click .The Open dialog box opens.

Figure 176.  Adding Files to a Play List

2. Click the “Look in” drop-down box to select the drive and folder location where the media file(s) resides.

3. Select the file(s) you want to play.

Use the Ctrl key to simultaneously select multiple files to add to the playlist.

4. Click Open.

REMOVING MEDIA FILES FROM THE CURRENT LIST
To remove media files from the current list:

1. In the Playlist dialog box, select a file from the list. 

2. Click  to remove the file.

PLAYING A FILE FROM THE PLAYLIST
If there are multiple files in the playlist, each file will play in the order in which they in the list.

To play a file from the playlist,

• In the Playlist dialog box, double-click a file name.

LOADING A PREVIOUSLY SAVED PLAYLIST
To load a previously saved playlist:

1. In the Playlist dialog box, click .

2. Select a saved playlist file.

SAVING THE CURRENT PLAYLIST
Depending on the amount of data stored and the type of media used, it may take several minutes to load playlists.

To save the current playlist to disk,

• In the Playlist dialog box, click .

�

�

�

Load

Save
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Working with Viewer Configuration Tools
This section describes how to use the DX8100 Viewer configuration tools and includes the following topics:

• Accessing Viewer Configuration Tools

• Adjusting Picture Quality

• Changing the Snapshot Directory

• Changing the Language 

• Enabling/Disabling Filtered Image Display

ACCESSING VIEWER CONFIGURATION TOOLS
To access the Viewer Setup dialog box:

• On the DX8100 Viewer toolbar, click Configuration.

The Configuration Tools dialog box is displayed in the Viewer window pane.

Figure 177.  Viewer Configuration Tools

ADJUSTING PICTURE QUALITY
The DX8100 Viewer Configuration Tools dialog box provides the following controls to adjust picture quality:

• Brightness

• Contrast

• Hue

• Saturation

To adjust the picture quality in the view panel:

• In the Configuration Tools dialog box, use the sliders to adjust the picture.

CHANGING THE SNAPSHOT DIRECTORY
To change the default directory where snapshots are stored:

• In the Configuration Tools dialog box, click Browse and navigate to a directory.

For example, click .Browse
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CHANGING THE LANGUAGE
To change the language:

1. On the DX8100 Viewer toolbar, click Tools. The menu is displayed.

2. In the Language section, select a language.

3. Close the DX8100 Viewer application.

4. Restart the DX8100 Viewer application. 

ENABLING/DISABLING FILTERED IMAGE DISPLAY
To enable/disable filtered image display:

1. On the DX8100 Viewer toolbar, click Tools. The menu is displayed.

2. Do one of the following:

• To enable filtered image display, click the check box in the Language section to select the Filtered Image display box.
• To disable filtered image display, click the check box in the Language section to deselect the Filtered Image display box.

VERIFYING THE WATERMARK
Watermarking is used to authenticate the originality of a video file and to alert users of possible image tampering. 

To verify the watermark:

1. Open an exported video image.

1. On the DX8100 Viewer toolbar, click . The Watermark Viewer dialog box opens.

2. Click Watermark Check. The DX8100 Viewer performs a check to verify if the watermark is authentic, and then displays the result and video 
image in the Watermark Viewer dialog box. 

EXITING THE DX8100 VIEWER APPLICATION
To exit the DX8100 viewer application:

• Click the Close button in the top-right corner of the viewer window.

For example, click .X
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DX8100 Mobile Client

Welcome to the DX8100 Mobile Client application. The DX8100 Mobile Client allows you to view live video remotely from multiple cameras and 
sites. Networking capabilities include local connection using wire-bound or wireless LAN technologies or remote connection using the Internet. 
The DX8100 Mobile Client software runs on a standard pocket PC-based PDA, and it can display a single channel of real-time video from any 
camera attached to any DX8100 DVR on the network. Features include hierarchical organization of multiple sites, built-in security through 
password protection, and an adjustable viewing area, with full-screen view.

Setting Up and Using the DX8100 Mobile Client
This section describes how to install, set up, and use the DX8100 Mobile Client. The following topics are included:

• Mobile (PDA) Client Recommended System Requirements 

• Mobile (PDA) Client Software Installation 

• Connecting Mobile Clients to a DX8100 Series DVR 

• Starting the DX8100 Mobile Client

• Exiting the DX8100 Mobile Client

• Setting Up User Security

• Logging in to the Mobile Client application

• Working with Sites and Groups 

• Connecting to a DX8100 Site 

• Disconnecting From a Server Site 

• Viewing Live Video 

• Customizing the View Screen 

MOBILE (PDA) CLIENT RECOMMENDED SYSTEM REQUIREMENTS
The DX8100 Mobile Client PDA recommended minimum system requirements includes the following:

• PDA Hardware: A pocket PC-compatible handheld device. 

• Processor: Intel XScale® compatible with a minimum processor speed of 400 MHz

• Memory: 64 MB of RAM

• Video: TFT liquid crystal display with minimum 240 x 320 display resolution, 64K colors

• Operating System: Microsoft pocket PC 2002 or later

• PC with Windows operating system and Microsoft ActiveSync® version 3.5 or later installed

• Wired or wireless networking capability

MOBILE (PDA) CLIENT SOFTWARE INSTALLATION
To install the DX8100 Mobile Client:

1. Install ActiveSync on your Windows PC (if it is not already installed).

2. Connect the hand held device to your PC.

Figure 178.  PDA-to-PC Connection

PCPDA
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3. Turn on your handheld device (if it is not already running).

4. Insert the DX8100 Resource CD into your PC’s DVD drive and wait for the DX8100 Resource CD screen to appear.

Figure 179.  Resource CD Screen

5. Click Software. The Software menu is displayed.

Figure 180.  Resource CD Screen Installation Options
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6. Click Mobile Client. The Mobile Client Setup dialog box opens.

Figure 181.  DX8100 Viewer Dialog Box

7. Click Next. The Software License Agreement dialog box opens.

Figure 182.  Mobile Client Software License Agreement Dialog Box

8. Click Next. The Installing Application dialog box opens.

Figure 183.  Installing Application Dialog Box

9. Click Yes to accept the default installation folder. 

10. Wait while ActiveSync copies the DX8100 Mobile Client program files to your handheld device, and then click OK in the Application 
Downloading Complete dialog box.

Figure 184.  Application Downloading Complete Dialog Box
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CONNECTING MOBILE CLIENTS TO A DX8100 SERIES DVR
Using a wired or wireless network connection, the DX8100 Mobile Client application can monitor live video from a number of geographically 
dispersed DVRs. The following figure illustrates a simplified wireless network connecting a pocket PC-compatible PDA device to a single DX8100 
DVR. 

Detailed instructions, describing how to configure your particular PDA device for wireless networking, are beyond the scope of this manual. 
Consult your network administrator and the documentation that came with your device for instructions on connecting your PDA to a network. 

Figure 185.  PDA-to-DVR Wireless Networking Example

The following table describes the components of a DX8100 Mobile Client network.
 

When using wireless networking to connect a mobile device to the DX8100, Pelco recommends using enterprise class access points, 
transceivers, and switches. Wired networking infrastructure should comply with IEEE 802.3 Fast Ethernet standards. Wireless networking 
infrastructure should comply with IEEE 802.11a, b, or g networking standards.

Table AR.  Components of a DX8100 Mobile Client Network

Item Component

Ethernet switch

DX8100 server DVR

Mobile client

Wireless access point

�

�
�

�

C2631M-A (6/07) DX8100 Mobile Client 201



STARTING THE DX8100 MOBILE CLIENT
Before attempting to start the DX8100 Mobile Client application, make sure you have installed the Mobile Client software on your pocket 
PC-compatible handheld device and you have an active network connection to a DX8100 DVR server.

To start the DX8100 Mobile Client application:

• From the Windows Start menu, choose Start > Programs > DX8100.

The DX8100 Mobile Client application starts.

The following figure shows the DX8100 Mobile Client application window.

Figure 186.  Main Screen

The following table describes the parts of the DX8100 Mobile Client window.

Table AS.  Parts of the DX8100 Mobile Client Window

Item Part Item Part

View window Live menu

Camera selection buttons Connect

Currently viewed camera Disconnect

Data rate Resume live view

Mobile Client frame rate Pause live view

DX8100 menu Switch to full-screen view

�

�

� �
	


 ��
�
��

�
�

�
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EXITING THE DX8100 MOBILE CLIENT
To exit the DX8100 Mobile Client application:

1. On the DX8100 Mobile Client toolbar, tap DX8100.

2. Tap Exit.

You can also Tap the  icon on the title bar to exit. 

Figure 187.  Exiting the Program

SETTING UP USER SECURITY
This section describes how to set up security and includes the following topics:

• Setting Up an Initial Password

• Changing an Existing Password

SETTING UP AN INITIAL PASSWORD

To set up an initial password:

1. Tap DX8100 > Options > Security.

Figure 188.  DX8100 Menu Security Option

2. Leave the Current text box blank.

3. Enter a password in the New text box. (Passwords must be 4-10 characters long and can include spaces and special characters.)

4.  Re-enter the new password in the Confirm text box.
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5. Tap OK.

Figure 189.  Entering a New Password

CHANGING AN EXISTING PASSWORD

To change an existing password:

1. Tap DX8100 > Options > Security.

Figure 190.  Security Menu Option

2. Enter your password in the Current text box.

3. Enter a different password in the New text box. (Passwords must be 4-10 characters long and can include spaces and special characters.)

4. Re-enter the new password in the Confirm text box.

5. Tap OK.

Figure 191.  Changing a Password
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LOGGING IN TO THE MOBILE CLIENT APPLICATION
After the security password has been assigned, you must log in to the Mobile Client application each time it is launched.

To log in to the Mobile Client application, enter a password in the field provided and then click OK.

Figure 192.  Mobile Client Log In Prompt

WORKING WITH SITES AND GROUPS
This section describes how to work with sites and groups and includes the following topics:

• Creating Site Groups 

• Editing an Existing Group 

• Deleting a Group 

• Adding a DX8100 Site to a Group 

• Editing a DX8100 Site 

• Deleting a DX8100 Site 

CREATING SITE GROUPS

To create site groups:

1. Tap  on the toolbar to take you directly to the Connect screen.

You can also tap DX8100 > Connect to go to the Connect screen.

Figure 193.  Connect Menu Option
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2. Tap Add.

Figure 194.  Connect Screen 

3. Tap New Group.

Figure 195.  Creating a New Group

4. Enter a name for the new group. (Group names can be a maximum of 15 characters long and can include spaces and special characters.)

5. Tap OK.

Figure 196.  Entering a Name
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6. Tap Cancel to return to the Connect screen.

Figure 197.  Finalizing New Group Creation

EDITING AN EXISTING GROUP

To edit an existing group:

1. Tap .

2. Select the group you wish to edit.

3. Tap Edit.

Figure 198.  Editing a Group

4. Enter a new group name.

5. Tap OK.

Figure 199.  Editing Group Information

6. Tap Close to return to the main screen.
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DELETING A GROUP

To delete a group:

1. Tap the  icon on the toolbar.

2. Select the group you wish to delete.

You cannot delete the Remote Site group.

3. Tap Del.

Figure 200.  Deleting a Group

4. Select an option to either delete or retain sites within the group to be deleted.

• Select “MOVED into default group” to move any sites to the Remote Site group.
• Select DELETED to delete the group and any sites contained within it.

5. Tap OK to complete the deletion process for the group.

Figure 201.  Finalizing Group Deletion

6. Tap Close to return to the main screen.
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ADDING A DX8100 SITE TO A GROUP

To add a DX8100 site to a group:

1. Tap .

2. Tap Add.

Figure 202.  Adding a New DX8100 Site

3. Select a Group from the drop-down box.

Figure 203.  Site Setup Screen

4. Enter a name for the new DX8100 site. (Site names can be a maximum of 15 characters; spaces and special characters are allowed.)

5. Enter the IP address of the new site. 

6. If necessary enter a new base port number (9002 is the default).

Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, but are 
protected from external threats by a firewall. Mobile client and server ports must be identical.
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7. Tap OK.

Figure 204.  Entering New Site Information

8. Tap Connect to connect to the newly created site, or tap Close to go back to the main screen.

Figure 205.  New Site in Connect Window

EDITING A DX8100 SITE

To edit a DX8100 site:

1. Tap the  icon on the toolbar.

2. If necessary, tap the plus (+) sign next to the group name to expand it.

3. Select the DX8100 DVR you want to edit.

4. Tap Edit.

Figure 206.  Selecting a Site to Edit
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5. Enter a new name for the site.

6. Enter a new IP address for the site.

7. If necessary enter a new base port number (9002 is the default).

Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, but are 
protected from external threats by a firewall. Web client and server ports must be identical.

8. Tap OK.

Figure 207.  Changing a Site’s Name and IP Address

9. Tap Close to return to the main screen.

DELETING A DX8100 SITE

To delete a DX8100 site:

1. Tap the  icon on the toolbar.

2. If necessary, tap the plus (+) sign next to the group name to expand it.

3. Select the DX8100 DVR Site you wish to delete.

4. Tap Del.

Figure 208.  Deleting a Site

5. Tap Close to return to the main screen.
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CONNECTING TO A DX8100 SITE
To connect to a DX8100 site:

1. Tap the  icon on the toolbar.

2. If necessary, tap the plus (+) sign next to the group name to expand it.

3. Select the DX8100 DVR you wish to connect to.

4. Tap Connect to connect to the remote site and return to the main screen.

Figure 209.  Connecting to a DVR Site

DISCONNECTING FROM A SERVER SITE
To disconnect from a server site:

1. Tap DX8100 on the toolbar.

2. Tap Close.

Also, tapping the  icon on the title bar will disconnect the site.

Figure 210.  Disconnecting from a Site
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VIEWING LIVE VIDEO
To view live video:

Once you have connected to a DX8100 site, the main screen displays a live image of the connected site from Camera 1. Figure 211 illustrates live 
view from the main screen.

1. Tap one of the camera selection buttons to view live video from a different camera.

2. Tap the  to pause the image.

3. Tap the  to resume live view.

Figure 211.  Viewing Live Video from the Main Screen

You can pause an image and resume live view by choosing menu commands. Tap Live > Stop to pause and Live > Start to resume live viewing.

Figure 212.  Live Menu with Start and Stop Options
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CUSTOMIZING THE VIEW SCREEN
This section describes how to customize the view screen and includes the following topics:

• Changing Screen Size 

• Full-Screen Mode

CHANGING SCREEN SIZE

To change the size of the main screen viewing area:

1. Tap DX8100 > Options > View Size.

Figure 213.  DX8100 Menu and View Size Option

2. Deselect the Auto Fit check box.

3. Move the slider to the desired position. (Screen size ranges from 120 x 90 to 240 x 180 pixels).

4. Tap OK.

.

Figure 214.  Minimum Screen Size Figure 215.  Medium Screen Size Figure 216.  Maximum Screen Size

�
�

�
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FULL-SCREEN MODE

To change to full-screen view:

1. Tap .

Figure 217.  Full-Screen View

2. Tap anywhere on the screen to exit full-screen view.

You can also tap Live > Full Screen to change to full-screen view.

Figure 218.  Live Menu and Full-Screen Option
C2631M-A (6/07) DX8100 Mobile Client 215



DX8100 Web Client

Welcome to the DX8100 Web Client application. This section describes how to use the DX8100 Web Client application and includes the 
following topics:

• Using the DX8100 Web Client

• Web Client Configuration

• Viewing Live Video

Using the DX8100 Web Client
DESCRIPTION

The DX8100 Web Client allows you to view live video and operate the PTZ features of cameras attached to DX8100 Series DVRs. Using a 
standard Web browser, you can remotely monitor up to 16 cameras for up to 16 DX8100 servers simultaneously. 

Using the multicast feature, the DX8100 DVR can support an unlimited number of Web Client connections, allowing you to view only live video. 
In this case, the PTZ functionality is not available. For information about enabling the DX8100 DVR multicast feature, refer to the DX8100 
Operation/Programming manual.

Features:

• Live viewing of up to 16 cameras simultaneously

• Ability to monitor cameras from multiple DX8100 sites

• Multiple screen division options including single, quad, and sixteen panel views

• Full PTZ control (not available if using the multicast feature)

• Runs on multiple platforms using a standard Web browser 

SYSTEM REQUIREMENTS
The DX8100 Web Client recommended minimum system requirements include the following:

• Processor: Intel Pentium III, or Pentium 4 with 800 MHz minimum processor speed

• Memory: 128 MB of RAM

• Video: AGP VGA card with minimum of 64 MB of video RAM, 1024 x 768 display resolution, 32-bit color, and DirectX 8.1 or later hardware 
acceleration

• 4.5 MB of free disk space 

• Monitor: SVGA or XGA with 1024 x 768 resolution, 32-bit color

• Operating system: Windows 2000 (SP4) or Windows XP only

NOTE: The DX8100 Web Client is only compatible with Internet Explorer®.
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INSTALLATION
The first time you use a Web browser to connect to a DVR server, an ActiveX® control application is downloaded and installed on your local 
computer. This control facilitates usage of the Web client’s interactive features.

1. To install and enable IPSec security services, refer to either Installing the Client Application or Installing the Client Emergency Agent 
Application. Refer to Enabling IPSec Security Services for instructions on how to enable IPSec security services.

You must install either the PC Client application or the Client Emergency Agent application to install IPSec security services.

2. Start Microsoft Internet Explorer.

NOTE: The DX8100 Web Client is only compatible with Internet Explorer.

3. Enter the IP address of one of the DX8100 servers you want to connect to.

4. Click Go. The ActiveX installation dialog box appears.

Figure 219.  ActiveX Control Installation Dialog Box

5. Do the following:

a. Click the check box to select “Always trust content from Pelco.”

b. Click Yes. 

6. Wait while the ActiveX controls are downloaded to your PC and your browser software is updated.
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STARTING THE DX8100 WEB CLIENT
Your Web browser must have cookies enabled. Refer to Microsoft Internet Explorer Help for instructions on enabling cookies. User names and 
passwords are case sensitive, type them exactly as shown.

NOTES: To avoid potential problems and conflicts within your computer’s video subsystem, run only one instance of the Client application or 
Web Client at a time. You must have IPSec security services enabled to use the DX8100 Web Client. 

To activate the DX8100 Web Client application:

1. Start Microsoft Internet Explorer.

2. Enter the IP address of one of the DX8100 servers you wish to connect to. The Digital Video Recorder dialog box opens.

Figure 220.  Entering a DX8100 Server User Name and Password

3. Enter a DX8100 server user name.

4. Enter the DX8100 server password.

5. Click Log In. The DX8100 Web Client screen appears.
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EXITING THE DX8100 WEB CLIENT
To exit the Web Client application, select File > Close from the browser window.

Figure 221.  Web Browser File Menu

SCREEN LAYOUT
Cameras can be assigned to view panels, live video can be displayed, and PTZ features can be controlled from a single screen. Figure 222 shows 
the available features of the DX8100 Web Client application.

Figure 222.  Web Client Screen Layout

�




�

�
�

�

� 	
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The following table describes the Web Client application window.

Table AT.  Web Client Application Window Parts

Item Description

Site tree

Screen division buttons

Remote site connection 
button

PTZ zoom control

PTZ focus control

PTZ iris control

PTZ keypad

View pane or view panel
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Web Client Configuration

WORKING WITH THE CONNECTION LIST
Before live video can be viewed from the Web Client’s view panels, at least one connection to a remote DX8100 server must be established. 
Up to one hundred DX8100 server sites can be added to the Connection List. Using the multicast feature, the DX8100 DVR can support an 
unlimited number of Web client connections. For information about enabling the DX8100 DVR multicast feature, refer to the DX8100 Operation/
Programming manual.

This section describes how to work with the connection list and includes the following topics:

ADDING SITES TO THE CONNECTION LIST

This section describes how to add a site to the connection list using a known or unknown IP address. The following topics are included:

• Adding a DX8100 Site with a Known IP Address

• Adding a DX8100 Site with a Unknown IP Address

Adding a DX8100 Site with a Known IP Address

To add a site to the Connection List when you know the site’s IP address:

1. Click . The Connection List dialog box opens.

Figure 223.  Connection List Dialog Box

2. Click Add. The Server Information dialog box appears.

Figure 224.  Server Information Dialog Box

3. Enter the name of the DX8100 Series DVR to which you want to connect.

4. Enter the IP address of the DVR.
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5. If necessary enter a new base port number (9002 is the default).

Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, but are 
protected from external threats by a firewall. Web client and server ports must be identical.

6. If necessary, enter a software upgrade port number (9003 is the default).

7. If necessary, enter a new information port in the Information Port box (9005 is the default).

8. Click OK. The site appears in the Connection List.

Adding a DX8100 Site with a Unknown IP Address

To add a remote DVR site to the Connection List when you do not know the IP address:

NOTES: To be successful, the following stipulations must be satisfied:

• Each DVR must be attached to the same subnet.

• The first three octets of the IP address of the subnet must be known.

• The range of addresses used in the last octet of the subnet must be known.

1. Click . The Connection List dialog box opens.

Figure 225.  Connection List Dialog Box

2. Click DX8100 Scan. The DX8100 Scan dialog box appears.

Figure 226.  DX8100 Scan Dialog Box
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3. If your server is on Network Address Translation (NAT), click the Server on NAT check box.

4. Enter an IP address range to search for DVR sites.

a. Enter the first three octets of the IP range you wish to search, for example 10.10.1.

b. Enter the beginning value for the search range in the fourth octet, for example 001.

c. Enter the final value for the search range in the text box provided, for example 254.

NOTE: Each octet of the IP address must be an integer from 1-255.

5. Click Find.

6. Select one or more DX8100 servers to add to the Site tree.

7. Click Add. The site appears in the Connection List.

8. Click OK to return to the Connection List dialog box.

GROUPING DX8100 SERVERS IN THE CONNECTION LIST

The DX8100 Web Client allows you to group DX8100 servers in the connection list. This section describes how to group DX8100 servers in the 
connection list, and add a DX8100 server with a known/unknown IP address to a group. The following topics are included:

• Adding a Group to the Connection List

• Adding a DX8100 Server to a Group with a Known IP Address

• Adding a DX8100 Server to a Group with an Unknown IP Address

Adding a Group to the Connection List

To add a group to the connection list:

1. Click . The Connection List dialog box opens.

Figure 227.  Connection List Dialog Box

2. Click Add Group. The Add Group dialog box appears.

3. Enter the name of the group you want to create.

4. Click OK. The group name is added to the connection list.
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Adding a DX8100 Server to a Group with a Known IP Address

To add a DX8100 server to a group with a known IP address:

1. Click . The Connection List dialog box opens.

Figure 228.  Connection List Dialog Box

2. Do the following:

a. Select a group.

b. Click Add. The Server Information dialog box opens.

Figure 229.  Server Information Dialog Box

3. Enter the name of the DX8100 Series DVR you wish to add to the group.

4. Enter the IP address of the DVR.

5. If necessary enter a new base port number (9002 is the default).

Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, but are 
protected from external threats by a firewall. Web client and server ports must be identical.

6. If necessary, enter a software upgrade port number (9003 is the default).

7. If necessary, enter a new information port in the Information Port box,(9005 is the default).

8. Click OK. The site appears in the Connection List under the group name.
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Adding a DX8100 Server to a Group with an Unknown IP Address

To add a remote DVR site to a group in the Connection List when you do not know the IP address:

NOTES: To be successful, the following stipulations must be satisfied:

• Each DVR must be attached to the same subnet.

• The first three octets of the IP address of the subnet must be known.

• The range of addresses used in the last octet of the subnet must be known.

1. Click . The Connection List dialog box opens.

Figure 230.  Connection List Dialog Box

2. Do the following:

a. Select a group.

b. Click DX8100 Scan. The DX8100 Scan dialog box opens.

Figure 231.  DX8100 Scan Dialog Box

3. If your server is on Network Address Translation (NAT), click the Server on NAT check box.
C2631M-A (6/07) DX8100 Web Client 225



4. Enter an IP address range to search for DVR sites.

a. Enter the first three octets of the IP range you wish to search, for example 10.10.1.

b. Enter the beginning value for the search range in the fourth octet, for example 001.

c. Enter the final value for the search range in the text box provided, for example 254.

NOTE: Each octet of the IP address must be an integer from 1-255.

5. Click Find.

6. Select one or more DX8100 servers to add to the Site tree.

7. Click Add. The site appears under the group name in the Connection List.

8. Click OK to return to the Connection List dialog box.

MODIFYING A CONNECTION LIST

This section describes how to modify the connection list and includes the following topics:

• Deleting a DX8100 DVR Server from the Connection List

• Editing a DX8100 Server’s Information in the Connection list

Deleting a DX8100 DVR Server from the Connection List

1. Click . The Connection List dialog box opens.

Figure 232.  Deleting a Site from the Connection List

2. Select the DX8100 Series DVR you wish to delete.

3. Click Delete. The site disappears from the Connection List.

4. Click OK.
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Editing a DX8100 Server’s Information in the Connection list

1. Click . The Connection List dialog box opens.

Figure 233.  Editing a Site from the Connection List

2. Select the DX8100 Series DVR you wish to edit.

3. Click Edit. The Server Information dialog box appears.

Figure 234.  Editing Server Information

4. Enter a new name for the server.

5. Enter a new IP address for the server.

6. If necessary enter a new base port number (9002 is the default).

Consult your network administrator before assigning or changing port numbers. Make sure that the ports are not blocked internally, but are 
protected from external threats by a firewall. Web client and server ports must be identical.

7. If necessary enter a software upgrade port number (9003 is the default).

8. If necessary enter the information port number (9005 is the default).

9. Click OK. The site appears in the Connection List.

10. Click OK to return to the Connection List dialog box.
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WORKING WITH REMOTE SITES
This section describes how to work with remote sites and includes the following topics:

• Connecting to a Remote Site 

• Logging In to a Remote Site 

• Logging Out of a Remote Site 

• Disconnecting from a Remote Site 

CONNECTING TO A REMOTE SITE

To connect to an active DX8100 server on the network:

1. Right-click the remote site name from the Site tree.

2. Select Connect from the quick-menu.

Figure 235.  Remote Site Connection Quick-Menu

LOGGING IN TO A REMOTE SITE

After a connection to a remote site has been established, you must log in with a valid user name and password for that site. 

To log in to a remote site:

1. Select a remote DX8100 Series DVR site from the Site tree.

Figure 236.  Selecting a Site

2. Right-click the site name and then select User Log-in from the quick-menu.

3. Enter a user name and password for the remote site.

Figure 237.  User Log-in Dialog Box
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LOGGING OUT OF A REMOTE SITE

To log out of a remote DVR site, right-click the site name from the Site tree, and then select User Log-Out from the quick-menu. 

DISCONNECTING FROM A REMOTE SITE

To terminate a connection with a remote DX8100 server:

1. Right-click the name of the remote site from the Site tree.

2. Select Disconnect from the quick-menu.

Figure 238.  Quick-Menu Disconnect Option

VIEWING LIVE VIDEO
The DX8100 Web Client allows you to view live video from up to 16 cameras, by dragging one or more cameras from the Site tree onto the view 
panels. For information about selecting cameras for viewing video, refer to Assigning Cameras to View Panes for instructions.

This section describes how to use the Web Client to view live video, and includes the following topics:

• Configuring View Panels 

• Assigning Cameras to View Panels 

• Operating the On-Screen PTZ Controls
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CONFIGURING VIEW PANELS

The DX8100 Web Client can display up to 16 cameras simultaneously, on a single screen.

To establish the arrangement of view panels on the Web Client screen, select a screen division button from the toolbar. The following table 
describes the division buttons.

ASSIGNING CAMERAS TO VIEW PANELS

The DX8100 Web Client includes up to 16 view panels. Each view panel can display a single camera channel from any connected server.

To assign a camera to a view panel:

1. Click the plus sign (+) beside Camera for the site you wish to view. This expands the Site tree. 

2. Drag a camera from the Site tree onto a view panel.

Figure 239.  Dragging a Camera to a Web Client View Panel

Table AU.  Web Client Division Buttons

Button Description

Displays 1 camera.

Displays 4 cameras simultaneously (quad display).

Displays 9 cameras simultaneously.

Displays 16 cameras simultaneously.

6-panel display. Divides screen into 1 large and 5 small view panels.

10-panel display. Divides screen into 2 large and 8 small view panels.

13-panel display. Divides screen into 1 large and 12 small view panels.

�

�
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3. Repeat the process in steps 1-2 for up to 16 cameras from various DVR sites.

When changing from one screen division to another you must reassign cameras to view panels.

OPERATING THE ON-SCREEN PTZ CONTROLS

The on-screen PTZ control allows users to manipulate the positioning and lens features of cameras using a mouse. This section describes how to 
use the PTZ controls and includes the following topics:

• Operating PTZ Controls

• PTZ Presets

• Programming a Preset 

• Activating a Preset 

• Clearing a Preset 

Operating PTZ Controls

To operate the on-screen PTZ controls:

1. Place the mouse pointer in the middle of a camera view panel.

Figure 240.  Web Client On-Screen PTZ

2. Click the left mouse button, and then drag the mouse pointer in the direction you wish to move the camera. Figure 241 illustrates the range 
of motion possibilities for the on-screen PTZ control.

Figure 241.  On-Screen PTZ Movement
C2631M-A (6/07) DX8100 Web Client 231



3. Release the mouse button when you have moved the camera to the desired position.

4. To adjust camera lens features, click the plus (+) or minus (-) buttons next to each function on the keypad. Refer to the following figure.

Figure 242.  Web Client PTZ Lens Controls

PTZ Presets

A preset is a user-defined camera position using PTZ, and focus commands. A DX8100 Series DVR can address up to 128 PTZ presets (1-32). 
Preset 95 is reserved for remote camera setup, and preset 99 is reserved for camera autoscan mode.

Only cameras that support positioning and programming using Pelco D, P, or Coaxitron protocols can use this feature.

NOTES: Observe the use of the  icon for presets, preset tours, and patterns as follows:

• To program or clear presets, preset tours, and patterns, the Set icon must be engaged.

• To activate presets, tours, and patterns, the Set icon must be disengaged.

Programming a Preset

Clicking the  icon places DX8100 in PTZ programming mode. While in PTZ programming mode, multiple presets can be programmed until 

the  icon is pressed again.

�
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To program a PTZ preset:

1. Drag a camera from the Site tree onto a view panel.

2. Click .

Figure 243.  Web View and PTZ Control Panel

3. Using the on-screen PTZ controls and PTZ keypad, move the camera to the desired position and adjust zoom and iris settings.

Figure 244.  Moving to a Preset Using Web Client

EXIT
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4. Using the PTZ keypad, select a number for the new preset (for example, select 1).

Figure 245.  Programming a Preset Using Web Client

5. Click  to store the preset in the selected memory location.

6. Repeat steps 4-6 for each preset you want to program.

7. Click  again to exit programming mode.

Activating a Preset

To activate a preset:

1. Click a preset number (1-32) on the keypad.

2. Click  to activate preset. The camera repositions to the new preset.

Double-digit presets can be set or activated by pressing the first digit and then the second digit sequentially. For example, preset 20 can be 
selected by clicking the number 2 and then the 0 (zero) on the PTZ keypad.

Figure 246.  Activating a Preset Using Web Client

�

�

�
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Clearing a Preset

To clear a preset:

1. Click  to enter programming mode.

2. Click the number of the preset you want to clear from the PTZ keypad.

3. Click .

4. Repeat steps 2 and 3 to clear multiple presets.

5. Click  to exit programming mode.

Figure 247.  Clearing a Preset Using Web Client

PTZ PATTERNS

A pattern is a user-defined, viewable camera path with a definite beginning and end. Patterns are made up of a sequence of standard pan/tilt, 
and lens commands. Patterns are stored in the internal memory of the PTZ device, such as a Spectra dome, that is connected to the DX8100. 
Depending on the type and configuration of the PTZ device, the DX8100 can address up to four unique PTZ patterns. Once defined, a pattern can 
be activated with a series of on-screen commands. A pattern will run continuously until it is deactivated.

Only PTZ-enabled cameras that support pattern programming through Pelco D, P, or Coaxitron protocols can use this feature.

This section describes how to work with patterns and includes the following topics:

• Programming a Pattern 

• Activating a Pattern 

• Clearing a Pattern 

• Accessing Programming Features of Remote Cameras

�

�

�
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Programming a Pattern

To program a pattern:

1. Drag a camera from the Site tree onto a view panel.

2. Click  to enter programming mode.

3. Using the PTZ keypad, select a number for the pattern (1-4).

4. Click .

5. Navigate the camera through a series of movements using the on-screen PTZ, and focus controls.

Certain PTZ devices, like Pelco’s Spectra Series domes, will display an on-screen message with the amount of remaining memory available 
for pattern programming.

Figure 248.  Programming a Pattern Using Web Client

To stop programming a pattern:

1. Click .

2. Click .

Activating a Pattern

To activate a pattern:

1. Click a pattern number (1-4) on the keypad.

2. Click .

A pattern will repeat indefinitely until it is cleared, another pattern is set, or the on-screen PTZ control is moved.

Figure 249.  Activating a Pattern Using Web Client

�
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Clearing a Pattern

To clear a pattern:

1. Click  to enter programming mode.

2. Select a pattern number (1-4) on the keypad.

3. Click .

4. Click .

5. Click  again.

6. Click  again to exit programming mode.

Figure 250.  Clearing a Pattern Using Web Client

Accessing Programming Features of Remote Cameras

You can use the PTZ function to program features of remote cameras, such as Pelco’s Spectra III. Only cameras that support remote programming 
through Pelco D, P, or Coaxitron protocols can use this feature.

To access a programming menu for a remote camera:

1. Drag a camera from the Site tree onto a view panel.

Figure 251.  Web Client View Panels

�

�
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2. Click  to access remote camera setup mode.

For certain camera models, you can also select preset number 95 from the keypad to access remote setup mode. To access preset number 
95, click , 9, 5, and  from the PTZ keypad.

Figure 252.  PTZ Control Panel Using Web Client

3. Use the on-screen PTZ controls or the focus (+) and focus (-) buttons to navigate up and through down camera menu choices.

Figure 253.  Camera Setup Menu

4. Click the iris (+) button to select an option from the camera’s on-screen menu.

5. Click the iris (-) button to cancel an option or exit a menu.

You can also use the on-screen PTZ controls with your mouse to navigate through camera menus. Click and drag the mouse up or down to move 
between menu options, and then select the option using the iris (+) button.
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PTZ test 112
video loss events, linking to 127

relay output
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advanced motion-activated, configuring 147
advanced video loss-activated, configuring 149
alarm event (external), linking to 121
ATM/POS event (external), linking to 121
motion event (external), linking to 120
See also relays
video loss event (external), linking to 122

relay properties, setting up 119
See also relays

schedule setup
frame rate, basic, configuring 141
frame rate, configuring 141
record mode 128, 130

system setup 160
user access 154
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overview 41
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port 24
standard audio

inputs 16, 114
status bar 31
synchronization, loss of 117
system setup

accessing the System page 160
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T
third-party
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title bar 31
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U
upgrade port 24
user security level 154
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Administrator 109, 156
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DX8000, accessing 109
pan, tilt, and zoom control, operating 52
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Restricted User 40, 155, 156
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user access levels 156
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adding new users 157
existing users, deleting 159
log-in timeout, setting 159
modifying 158
password, changing 159
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V
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video, low level 117
view

cycle view setup 33
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216
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PRODUCT WARRANTY AND RETURN INFORMATION

WARRANTY

Pelco will repair or replace, without charge, any merchandise proved defective in material or
workmanship for a period of one year after the date of shipment. 

Exceptions to this warranty are as noted below:

• Five years on fiber optic products and TW3000 Series unshielded twisted pair transmission
products.

• Three years on Spectra® IV products.
• Three years on Genex® Series products (multiplexers, server, and keyboard).
• Three years on Camclosure® and fixed camera models, except the CC3701H-2,

CC3701H-2X, CC3751H-2, CC3651H-2X, MC3651H-2, and MC3651H-2X camera models,
which have a five-year warranty.

• Three years on PMCL200/300/400 Series LCD monitors.
• Two years on standard motorized or fixed focal length lenses.
• Two years on Legacy®, CM6700/CM6800/CM9700 Series matrix, and DF5/DF8 Series

fixed dome products.
• Two years on Spectra III™, Esprit®, ExSite™, and PS20 scanners, including when used in

continuous motion applications.
• Two years on Esprit and WW5700 Series window wiper (excluding wiper blades).
• Two years (except lamp and color wheel) on Digital Light Processing (DLP®) displays.

The lamp and color wheel will be covered for a period of 90 days. The air filter is not
covered under warranty.

• Eighteen months on DX Series digital video recorders, NVR300 Series network video
recorders, and Endura™ Series distributed network-based video products.

• One year (except video heads) on video cassette recorders (VCRs). Video heads will be
covered for a period of six months.

• Six months on all pan and tilts, scanners or preset lenses used in continuous motion
applications (that is, preset scan, tour and auto scan modes).

Pelco will warrant all replacement parts and repairs for 90 days from the date of Pelco
shipment. All goods requiring warranty repair shall be sent freight prepaid to Pelco, Clovis,
California. Repairs made necessary by reason of misuse, alteration, normal wear, or accident
are not covered under this warranty.

Pelco assumes no risk and shall be subject to no liability for damages or loss resulting from
the specific use or application made of the Products. Pelco’s liability for any claim, whether
based on breach of contract, negligence, infringement of any rights of any party or product lia-
bility, relating to the Products shall not exceed the price paid by the Dealer to Pelco for such
Products. In no event will Pelco be liable for any special, incidental or consequential damages
(including loss of use, loss of profit and claims of third parties) however caused, whether by
the negligence of Pelco or otherwise.

The above warranty provides the Dealer with specific legal rights. The Dealer may also have
additional rights, which are subject to variation from state to state.

If a warranty repair is required, the Dealer must contact Pelco at (800) 289-9100 or
(559) 292-1981 to obtain a Repair Authorization number (RA), and provide the following
information:

1. Model and serial number
2. Date of shipment, P.O. number, Sales Order number, or Pelco invoice number
3. Details of the defect or problem

If there is a dispute regarding the warranty of a product which does not fall under the
warranty conditions stated above, please include a written explanation with the product when
returned.

Method of return shipment shall be the same or equal to the method by which the item was
received by Pelco.

RETURNS

In order to expedite parts returned to the factory for repair or credit, please call the factory at
(800) 289-9100 or (559) 292-1981 to obtain an authorization number (CA number if returned for
credit, and RA number if returned for repair).

All merchandise returned for credit may be subject to a 20% restocking and refurbishing
charge.

Goods returned for repair or credit should be clearly identified with the assigned CA or RA
number and freight should be prepaid. Ship to the appropriate address below.

If you are located within the continental U.S., Alaska, Hawaii or Puerto Rico, send goods to:
Service Department
Pelco
3500 Pelco Way
Clovis, CA 93612-5699

If you are located outside the continental U.S., Alaska, Hawaii or Puerto Rico and are instructed
to return goods to the USA, you may do one of the following:

If the goods are to be sent by a COURIER SERVICE, send the goods to:
Pelco
3500 Pelco Way
Clovis, CA 93612-5699 USA

If the goods are to be sent by a FREIGHT FORWARDER, send the goods to:
Pelco c/o Expeditors
473 Eccles Avenue
South San Francisco, CA 94080 USA
Phone: 650-737-1700
Fax: 650-737-0933

The materials used in the manufacture of this document and its components are compliant to the requirements of Directive 2002/95/EC.

This equipment contains electrical or electronic components that must be recycled properly to comply with Directive 2002/96/EC of the European Union 
regarding the disposal of waste electrical and electronic equipment (WEEE). Contact your local dealer for procedures for recycling this equipment.

The materials used in the manufacture of this document and its components are compliant to the requirements of Directive 2002/95/EC.

This equipment contains electrical or electronic components that must be recycled properly to comply with Directive 2002/96/EC of the European Union 
regarding the disposal of waste electrical and electronic equipment (WEEE). Contact your local dealer for procedures for recycling this equipment.

REVISION HISTORY
Manual # Date Comments
C2631M 9/06 Original version.
C2631M-A 6/07 Documents new features: full screen button,  unlimited number of Web client connections using multicasting, and exporting and prining backed up video.

Pelco, the Pelco logo, Camclosure, Coaxitron, Esprit, Genex, Legacy, and Spectra are registered trademarks of Pelco. ©Copyright 2007, Pelco. All rights reserved.
Endura, ExSite, and Spectra III are trademarks of Pelco.
Microsoft, Windows, DirectDraw, DirectX, ActiveSync, and ActiveX are registered trademarks of Microsoft Corporation. 
Intel, Pentium, and XScale are registered trademarks of Intel Corporation.
Nero is a registered trademark of Nero AG.
DLP is a registered trademark of Texas Instruments, Inc.
Samsung is a trademark of Samsung in the United States or other countries
Panasonic is a registered trademark of Matsushita Electric Industrial Co., Ltd.
Kalatel is an trademark of GE Interlogix.
American Dynamics is a trademark of Sensormatic Electronics Corp.
Philips is a registered trademark of Koninklijke Philips Electronics N.V.
LG is a registered trademark of LG.



Worldwide Headquarters
3500 Pelco Way

Clovis, California 93612 USA

USA & Canada
Tel: 800/289-9100
Fax: 800/289-9150

International
Tel: 1-559/292-1981
Fax: 1-559/348-1120

www.pelco.com

ISO9001

Australia | Canada | Finland | France | Germany | Italy | Macau | The Netherlands | Russia | Singapore

South Africa | Spain | Sweden | United Arab Emirates | United Kingdom | United States

Australia | Canada | Finland | France | Germany | Italy | Macau | The Netherlands | Russia | Singapore

South Africa | Spain | Sweden | United Arab Emirates | United Kingdom | United States


	Contents
	Client Application
	Welcome to DX8100 Client Application
	DX8100 Client Emergency Agent
	DX8100 Viewer
	DX8100 Mobile Client
	DX8100 Web Client
	New DX8100 Features

	Getting Started with DX8100 Client Software
	Description of DX8100 Client Software
	Recommended System Requirements
	Windows XP Display Properties Configuration Requirements
	Installing the Client Application
	Setting Up Security Services
	Enabling IPSec Security Services
	Disabling IPSec Security Services

	Starting the DX8100 Client Application
	Before You Start DX8100 Client Software
	Starting DX8100 Client Software
	Automatic System Upgrade


	Logging In to the Client Application
	Changing the DX8100 Client Application Login Password
	Enabling DirectDraw Video Hardware Acceleration

	Connecting to DX8100 DVR Server Sites
	Adding a DX8100 DVR Server to the Connection List
	Adding a Site with a Known IP Address
	Adding a Site with an Unknown IP Address

	Deleting a DX8100 DVR Server
	Editing DX8100 Server Information from Connection List
	Working with Remote Sites
	Connecting to a Remote Site
	Automatically Connecting to a Remote Site
	Logging In to a Remote Site
	Logging Out of a Remote Site
	Disconnecting from a Remote Site

	Exiting the DX8100 Client Application

	Understanding the DX8100 Application Window
	Description of the DX8100 Main Window
	DX8100 Menu Bar
	DX8100 Toolbar
	Displaying the DX8100 Window from a Page
	Description of Operating Modes
	Displaying Video in full screen View

	Understanding View Panes and Panels
	Working with View Panes and Panels
	Configuring View Panels
	Navigating View Panels

	Working with the Site tree
	Assigning Cameras to View Panes
	Setting Up Links
	Removing Links


	Working in Live View Mode
	Assigning and Removing Cameras from View Panes
	Setting Up Favorites
	Adding a Camera View to Favorites
	Organizing Favorites in Folders

	Live View On-Screen Display (OSD)
	Customizing the On-Screen Display (OSD)
	Instant Recording
	Enabling and Disabling Instant Recording
	Adding Instant Recording to OSD
	Starting and Stopping Instant Recording

	Operating the On-Screen PTZ Controls
	Operating the PTZ Controls
	Adjusting the Camera Lens
	Adjusting the Camera Zoom
	Using PC Keyboard Shortcuts to Operate PTZ and Lens Functions

	PTZ Presets
	Programming a Preset
	Activating a Preset
	Clearing a Preset

	PTZ Patterns
	Programming a Pattern
	Activating a Pattern
	Clearing a Pattern
	Accessing Programming Features of Remote Cameras

	Sending Auxiliary Commands to a Device
	Configuring Preset Tours
	Programming a Preset Tour
	Activating a Preset Tour
	Deactivating a Preset Tour


	Working in Playback Mode
	Accessing Playback Mode
	Assigning Cameras to View Panels
	Playback On-Screen Display (OSD)
	Playback Controls
	Playback Timeline
	Playing Back Video by Time
	Starting Playback from a Specific Point in Time
	Understanding Instant Playback

	Playing Back Video by Event
	Operating Playback Digital Zoom
	Zoom Using the Digital Zoom Control
	Zoom Using the Mouse
	Panning a Zoomed Image


	Working in Search Mode
	Search Window
	Displaying a Deinterlaced Image in the Search Mode
	Reusing the Search Time Range
	Index Video Search
	Thumbnail Video Search
	POS Search
	Understanding the POS Search View
	Searching and Displaying POS Data by Device Name
	Searching by POS Transaction Number
	Searching for All Transactions with Exceptions
	Searching for Transactions That Satisfy Specific Exceptions
	Searching for Transactions by Line Item
	Searching for Transactions by Action Code

	Pixel Video Search
	Searching Video Based on Changes in Screen Pixels
	Viewing a Video Thumbnail

	Working with Special View and Search Methods
	Viewing Video in the Deinterlaced Mode
	Viewing Live and Playback Video Simultaneously


	Exporting Video
	Exporting Bookmarked Video Regions
	Creating Bookmarks
	Clearing Bookmarks
	BookMarking and Exporting Multiple Channels

	Inserting and Removing a USB Flash Drive
	Installing a USB Flash Drive
	Removing a USB Flash Drive

	Enabling the Deinterlacing Filter
	Mapping and Disconnecting a Network Drive
	Mapping a Network Drive
	Disconnecting a Network Drive

	Performing the Export
	Starting an Export Process
	Changing a Bookmarked Time Range
	Assigning a Custom Export Video File Name
	Selecting the Export Format
	Exporting a Sequence of Still Images
	Finalizing an Export Process
	Stopping an Export While in Process
	Working with DX8100 backed up Video


	Printing Images
	Printing Images in the Deinterlaced Mode

	Setting Up the DX8100
	Accessing the Setup Mode
	Understanding the Setup Dialog Box
	Camera Setup
	Basic Camera Setup
	Motion Detection Setup
	Audio Setup
	Listening to Live Audio
	Configuring Video Loss Detection
	Applying Settings to all Cameras

	Link Setup
	Configuring Basic Relay and Alarm Settings
	Linking Relay Outputs to External Events
	Linking Cameras to Record in Response to External Events
	Linking PTZ Presets and Patterns to External Events

	Schedule Setup
	Accessing the Schedule
	Setting Up the Camera Recording Mode
	Creating Yearly Recording Schedules
	Creating Monthly or Multiple-Day Recording Schedules
	Editing Schedules
	Working with Custom Camera Settings
	Configuring the Frame Rate
	Setting Up Advanced Relay Output

	Setting Up Network Properties
	Data Backup Setup
	Working With Backed Up Video On Client
	Viewing and Searching backed up Video
	Exporting and Printing backed up Video

	User Setup
	Accessing the User Page
	Built-in User Accounts
	Definition of User Access Levels
	Definition of Camera Security Access
	Modifying User Access Rights
	Adding New Users
	Modifying User Properties
	Changing User Passwords
	Changing a User’s Group Affiliation
	Deleting Existing Users
	Setting Login Timeout
	Assigning Automatic Login Permission to a User

	Site Setup
	System Setup
	Accessing the System Page
	Working with the Export Feature
	Working with the Import Feature
	Using System Logs

	External Monitor Setup
	Emergency Notification Setup
	Accessing the Emergency Agent Notification Setup
	Adding Client Emergency Agents to be Notified
	Changing Client Emergency Agent Properties
	Deleting Clients from the Notification List
	Linking Cameras to Client Emergency Agents
	Setting Server Event Transmission Time

	Emergency E-Mail Notification Setup
	Accessing the Emergency E-mail Notification Setup
	Configuring Emergency E-mail Notification
	Setting Up the Time Period
	Setting Up E-Mail Notification Groups
	Sending E-mail Notifications


	DX8100 Client Emergency Agent
	Setting Up and Using the Client Emergency Agent
	Recommended System Requirements
	Installing the Client Emergency Agent Application
	Enabling IPSec Security Services
	Disabling IPSec Security Services

	Before You Begin
	Starting the Client Emergency Agent
	Real-Time Event Monitoring
	Setting the Client Emergency Agent Listen Port
	Viewing Previously Logged Events
	Shutting Down the Client Emergency Agent

	DX8100 Viewer
	Setting Up and Using the DX8100 Viewer
	Recommended System Requirements
	DX8100 Viewer Software Installation
	Starting the DX8100 Viewer
	Viewing Media files
	Playing Video
	Saving Snapshots
	Printing Images

	Working with the Playlist
	Accessing the Playlist
	Adding Files to the Current List
	Removing Media Files from the Current List
	Playing a File from the Playlist
	Loading a Previously Saved Playlist
	Saving the Current Playlist

	Working with Viewer Configuration Tools
	Accessing Viewer Configuration Tools
	Adjusting Picture Quality
	Changing the Snapshot Directory
	Changing the Language
	Enabling/Disabling Filtered Image Display
	Verifying the Watermark
	Exiting the DX8100 Viewer Application

	DX8100 Mobile Client
	Setting Up and Using the DX8100 Mobile Client
	Mobile (PDA) Client Recommended System Requirements
	Mobile (PDA) Client Software Installation
	Connecting Mobile Clients to a DX8100 Series DVR
	Starting the DX8100 Mobile Client
	Exiting the DX8100 Mobile Client
	Setting Up User Security
	Setting Up an Initial Password
	Changing an Existing Password

	Logging in to the Mobile Client application
	Working with Sites and Groups
	Creating Site Groups
	Editing an Existing Group
	Deleting a Group
	Adding a DX8100 Site to a Group
	Editing a DX8100 Site
	Deleting a DX8100 Site

	Connecting to a DX8100 Site
	Disconnecting From a Server Site
	Viewing Live Video
	Customizing the View Screen
	Changing Screen Size
	Full-Screen Mode


	DX8100 Web Client
	Using the DX8100 Web Client
	Description
	System Requirements
	Installation
	Starting the DX8100 Web Client
	Exiting the DX8100 Web Client
	Screen Layout

	Web Client Configuration
	Working with the Connection List
	Adding Sites to the Connection List
	Grouping DX8100 Servers in the Connection List
	Modifying a Connection List

	Working with Remote Sites
	Connecting to a Remote Site
	Logging In to a Remote Site
	Logging Out of a Remote Site
	Disconnecting from a Remote Site

	Viewing Live Video
	Configuring View Panels
	Assigning Cameras to View Panels
	Operating the On-Screen PTZ Controls
	PTZ Patterns



	List of Illustrations
	List of Tables
	Index

